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Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-
frequency energy. If it is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such interference in a residential
installation. However, there is no guarantee that the interference will not occur in a
particular installation.

You can determine whether your computer system is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of the
peripheral devices.

If your computer system does cause interference to radio or television reception, try to
correct the interference by using one or more of the following measures:

= Turn the television or radio antenna until the interference stops.

= Move the computer to one side or the other of the television or radio.

= Move the computer farther away from the television or radio.

»  Plug the computer into an outlet that is on a different circuit from the television or

radio. (That is, make certain the computer and the television or radio are on circuits
controlled by different circuit breakers or fuses.)

If necessary, consult your authorized Apple dealer or an experienced radio/television
technician for additional suggestions. You may find helpful the following booklet,
prepared by the Federal Communications Commission: Interference Handbook (stock
number 004-000-00345-4). This booklet is available from the U.S. Government Printing
Office, Washington, DC 20402.

/\ Important: Changes or modifications to this product not authorized by Apple
Computer, Inc., could void the FCC Certification and negate your authority to
operate the product.

This product was tested for FCC compliance under conditions that included the use
of shielded cables and connectors between system components. It is important that
you use shielded cables and connectors to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. For Apple
peripheral devices, you can obtain the proper shielded cables from your authorized
Apple dealer. For non-Apple peripheral devices, contact the manufacturer or dealer
for assistance. A

Xiv

Important

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. See
instructions if interference to radio or television reception is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits
for radio noise emissions from digital apparatus set out in the radio interference
regulations of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n'émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de la
Classe B prescrites dans les reglements sur le brouillage radioélectrique édictés par le
Ministere des Communications du Canada.
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How to Use This Book

This book has several parts.

Chapter 1 explains how to set up your computer and learn
how to use it.

Chapters 2—5 are a tutorial designed for people who have not
used a Macintosh computer before. If you are new to the
Macintosh, you should read this section of the book before
you start your own work.

Chapters 6—14 contain reference information that will help
you as you become more proficient with your computer.
You can turn to these chapters for information about a
particular topic.

At the back of the book you'll find a troubleshooting section
and an index.

Certain kinds of information are not included in this book.

Information about modems. If your computer has a built-in
modem, or if you purchase one later, you receive a separate
modem manual with instructions for its use.

Information about application programs. Your best source of
information about a particular program is the set of books and
disks that came with that program.

Technical specifications for your PowerBook model. These are
on a separate sheet in the box with your computer.

Turn now to Chapter 1 to set up your new PowerBook computer.

Welcome to Macintosh.






Chapter 1

Se t ti n g U p YOU r » New Macintosh uvsers: If you have never used a Macintosh

computer before, read this entire chapter. It explains how

MaCin tOSh POWGrB()()k ;(r)] Seéfgp your computer, learn how to use it, and turn it on

= New PowerBook users: If you have used other Macintosh
In this chapter computers but are new to the PowerBook, follow the setup
instructions that begin on the next page and then go to the

Setting up your computer . . ; .
- gUpY P section on backing up your computer’s hard disk.

Backing up your computer’s hard disk . ,
- supY P » Experienced PowerBook users: Read the section on
» Learning how to use your computer backing up your computer’s hard disk. Skim this chapter for

. information that applies to your computer.

» Turning the computer on and off PP ¥ P
» Important care and safety instructions /\ Important: No matter what your level of experience, please
read the safety information in this chapter before beginning
your own work. This information can help protect you and
your computer equipment from possible harm. A

= Being comfortable while you work




Setting up the computer » Plug the power adapter into a standard electrical outlet
or power strip. Then plug the power adapter cable into

) the power adapter port (marked with the icon =) on
Step 1: Plug in the power adapter the back panel of the computer.

Plugging in the power adapter recharges the computer’s battery
while you work. You should plug it in now in case the battery has
drained during shipping and storage.

A Warning: Use only the power adapter that came with your
PowerBook computer. Adapters for other electronic devices
(including other portable computers) may look similar, but
they may damage your computer. A

Power adapter port

2 Chapter 1: Setting Up Your Macintosh PowerBook



Step 2: Open the display Position the display at a comfortable viewing angle. You can
adjust the angle of the display at any time.

n Slide the latch to the right and lift up the display.

Chapter 1: Setting Up Your Macintosh PowerBook 3



Step 3: Turn on the computer n Press the power button to turn the computer on. The
power button has this icon: ©

= Open the door to the back panel of your computer.

You hear a tone when you turn on the computer. It takes the
computer a moment to start up.

4 Chapter 1: Setting Up Your Macintosh PowerBook



You see the Macintosh desktop on your screen. The computer is Trouble?

ready to use. Continue with the section “What to Do Next.” ,
n The computer made a sound, but you can'’t see anything on
the screen.

Adjust the brightness control (marked with the icon %) and
the contrast control () until an image appears and the
screen is easy to read.

Contrast control

Brightness control

n Nothing happened when you pressed the power button.

Make sure the power adapter is firmly connected to both
the computer and a power source. If the power adapter is
plugged into a power strip, make sure the power strip is
plugged in and turned on. Then try pressing the power
button again.

Chapter 1: Setting Up Your Macintosh PowerBook 5



What to do next

If you have never used a Macintosh computer before,
continue with the section “Learning the Basics.”

Otherwise, continue with the section “Backing Up Your Hard
Disk.” This section contains important information about
protecting your software. Then go to “Turning the PowerBook
On and Off.” This section contains information that can help
you use your computer efficiently.

Be sure to read the safety instructions and the section on
health concerns before beginning to use your PowerBook.

6 Chapter 1: Setting Up Your Macintosh PowerBook

A\ Important: Even if you already know how to use Macintosh
computers, be sure to read the section “Backing Up Your Hard
Disk.” This section explains how to back up your software
using the PowerBook 145B Backup application program. It is
extremely important that you make a backup copy of your
software on floppy disks in case something happens to your
system. A



Your computer at a glance

£l Printer port
& Modem port

@ Power button

== Power adapter port
<& SCSI port (HDI-30) ¥ Sound in port

I Apple Desktop Bus (ADB) port Microphone (optional)
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Backing up your hard disk

This section describes how to protect the software on your
computer’s hard disk.

Why back up?

Your computer’s hard disk comes with valuable information
stored on it, including the system software (which operates the
computer) and some programs. You should make a copy of the
information on your hard disk for safekeeping, using the
PowerBook 145B Backup program supplied on your hard disk.
(The extra copy is called a backup, and the process of making the
copy is called backing up.)

8 Chapter 1: Setting Up Your Macintosh PowerBook

You should also make a copy of your System Folder. If the System
Folder on the hard disk becomes damaged, you can quickly
restore it from your backup copy.

To restore information to your hard disk, you can use the
PowerBook 145B Restore program that came with your
Macintosh. See “Restoring the Information on Your Hard Disk” in
Chapter 8.



What you need

Just as you'd need paper to make copies of important documents,
you need floppy disks to copy the information on your hard disk.
You can probably buy the floppy disks at the same place you
bought the computer.

Floppy disks come in a variety of sizes and capacities. The ones
you need for this chapter are called high-density 3.5-inch disks.
You can recognize the disks by the way they look:

High density disks
have two holes.

High-density disks
have this symbol.

Even though these disks are called “floppy disks,” they aren’t
actually floppy.

Depending on exactly what was installed on your computer at the
factory, the information will fill between 10 and 20 high-density
disks. Since disks usually come in boxes of ten, you should have
two boxes of disks before starting the instructions.

If you don’t have enough disks, you can skip this section for the
moment. But the sooner you make the backup copy, the better.

Buy the disks as soon as possible, then follow the instructions in
this chapter.

Chapter 1: Setting Up Your Macintosh PowerBook 9




Make the copy

To start the PowerBook 145B Backup program, follow these
instructions:

1. Turn on your computer.

2. Open the PowerBook 145B Backup program by double-
clicking its icon.

%

FowerBook 145E Backup

10 Chapter 1: Setting Up Your Macintosh PowerBook

After a moment, the PowerBook 145B Backup program opens.

PowerBook 145B Backup H
[0 T]

It’s important to make a copy of what's on your hard
disk, in case items are accidentally lost or damaged.

This program requires high-density floppy disks.

You can safely stop the backup at any time, without
affecting your hard disk.

. Make sure your disks are high-density floppy disks.

Then click the Continue button.

A message appears, telling you how many floppy disks you
need to make your backup copy and about how long it will
take.



Although it is important to back up the entire hard
disk, it is especially important to back up at least the
System Folder.

Youw’'ll need 6 high-density floppy disks to copy all the
files on your hard disk. Copying will take about 19
minutes.

Youw’'ll need 4 high-density floppy disks to copy the
System Folder only. Copying will take about 12
minutes.

(

Quit | [ Copy System Folder | | Copy all Files ||

4. Click the appropriate choice, as follows:

The first time through these instructions, click the Copy
System Folder button.

The second time through these instructions, click the
Copy all Files button.

If you don’t have enough floppy disks for your choice,
click Quit. Skip the rest of this section for now, and
continue with “Turning the PowerBook On and Off.” Buy
floppy disks as soon as you can, then follow the

instructions in this section to back up your important files.

Make sure you have enough time and floppy disks to
complete the copying. If you stop the copying before it’s
finished, you'll have to start over again from the beginning.

Insert a high-density floppy disk into the disk drive.

Do not use the Disk Tools floppy disk that came with your
computer.

continues »
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6. Follow the instructions on the screen until a message
tells you that you’re finished. Remember to label each
disk with the name displayed on the screen. The name
will disappear as soon as the disk is ejected.

Be sure to follow the labeling instructions so you can find the
floppy disks again later.

7. Follow steps 2-6 again, but this time click the Copy all
Files button.

8. When you're finished, be sure the floppy disks are
properly labeled and locked, then store them in a safe,
cool place.

12 Chapter 1: Setting Up Your Macintosh PowerBook

As time goes by, you will store more information on your
computer. You should back up your hard disk at least once a
month. If you wish, you can purchase a backup program with
additional features that make copying faster. (For example, some
programs have a feature that lets you copy only the new and
changed information on your hard disk.)

If something happens to your hard disk

If something does happen to your hard disk, you can get all the
original information back from your backup floppy disks. To do
this, you use the PowerBook 145B Restore program that came
with your Macintosh. See the chapter on disks in the reference
section.



Turning the PowerBook on and off

Your Macintosh PowerBook can be in one of three power states:
off, sleep, or on.

Off

When the PowerBook is off, the computer is not using any power
or doing any work. The terms shut down and off both refer to this
state.

You should turn the computer off to
= attach other equipment to it
» replace its battery

= conserve power when you won't be using it for several hours

To turn the PowerBook off

» If the computer is on, choose the Shut Down command from
the Special menu. (The Macintosh Basics tour teaches how to
choose a menu command.)

Spe-::i-al
Clean Up Window
Penple Trash.

Eject Disk SEE
Fraus fHiek .,

Restart

| Shutoown. |

Sleep

» If the computer is in sleep, wake it by pressing any key on the
keyboard (except Caps Lock), and then choose Shut Down.

A\ Important: Don't shut down with the power button on
the back panel of the computer unless a problem prevents
you from choosing Shut Down. You will lose any work you

did not save, and you may experience problems with your
hard disk. A

Chapter 1: Setting Up Your Macintosh PowerBook 13



Sleep

When the PowerBook is in sleep, it draws enough power to
maintain the information in its memory (including any open
programs and documents). The computer is on, but almost
completely inactive.

You should put the computer to sleep to conserve power when
you take a work break.

To put the PowerBook to sleep

» If the computer is on, choose the Sleep command from the
Special menu.

Spec:ial
Clean Up Window
Pmpiy frash..

Pient fisk s
Erase Disk...

Restart
Shut Down

14 Chapter 1: Setting Up Your Macintosh PowerBook

» If the computer is off, you need to turn it on before you can
put it to sleep.

Automatic sleep

If you don’t use the computer for several minutes, it goes to sleep
automatically. This conserves battery power. You will notice that if
you spend several minutes reading without using the computer,
or if you take a break, the screen may be dark when you're ready
to resume working.

To wake the computer, press any key on the keyboard (except
Caps Lock). The desktop reappears looking just the way it did
before the computer went to sleep.



On

When the PowerBook is on, you can do your work.

To turn the PowerBook on

» If the computer is off, press the power button (marked with
the icon @).

Power button

» If the computer is in sleep, press any key on the keyboard
(except Caps Lock).

On/off summary

If the And you want it to be

power

state is off Sleep On

Off — — Press power button

Sleep Press any key — Press any key except
to wake, and then Caps Lock (pressing
choose Shut Down the power button

also works)
On Choose Shut Down Choose Sleep  —

See the chapter on power management for more information
about managing your computer’s power consumption.

Chapter 1: Setting Up Your Macintosh PowerBook 15



When you turn on your computer

When you turn on your PowerBook, the computer looks on the
hard disk inside the computer for the system software it uses to
start itself up. (A disk that contains the system software is called
a startup disk.) When the computer finds the system software, it
displays the icon shown and proceeds to start itself up.

When the startup process is complete, the Macintosh desktop
appears on the screen. The desktop is a gray pattern with

= amenu bar across the top (containing the names and icons
of menus)

= an icon near the upper-right corner representing the startup
disk

= anicon near the lower-right corner representing the Trash

16 Chapter 1: Setting Up Your Macintosh PowerBook

@ @)— Menu bar

€ File Edit iew Label Special

Startup
disk icon

Trash icon

When you “wake” your computer from sleep, it does not go
through the startup process because it is already on (at a
reduced power level). The Macintosh desktop reappears on the
screen immediately, looking just the way it did before the
computer went to sleep.



Restarting a computer that’s already on

You need to restart your computer—turn it off and back on again
immediately—when you want to make certain changes to your
control panels, use a newly installed system software file, or start
up the computer from a different disk.

» Choose Restart from the Special menu.

Spec:ial
Clean Up Window
Pmply frash..

Pient fisk s
Erase Disk...

Shut Down

Sleep

When you choose Restart, the computer prompts you to save
your work, closes all open programs, and restarts itself.

Choosing Restart does not affect your RAM disk (if you
created one) or its contents.

You also need to restart if you see a “system error” message on
the screen (indicating a temporary software problem). In this
case, use the trackball to click the Restart button that appears.

Restarting a computer that can’t
be turned on normally

If your system crashes (a rare event resulting from temporary
software problems), or if a computer with a properly installed and
charged battery does not respond when you try to turn it on, you
should be able to restart it using one of the methods described in
this section. Try them in the order given. All these methods will
cause you to lose any work you have not saved.

m Press and release the reset button.

You can press the button with a pen, a paper clip, or a similar
object.

Restarting the computer with the reset button does not affect
your RAM disk (if you created one) or its contents.

Interrupt button  Reset button

continues »
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= Hold down the power button for 5 seconds.

When you let go, the computer turns itself off. Turning the
computer off with the power button erases the contents of a
RAM disk.
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Restart from a floppy disk.
1. Insert the Disk Tools disk into the floppy disk drive.
2. Press the power button.

If the computer turns on, there may be a problem with your
hard disk. You may be able to fix the problem yourself (using
the Disk First Aid program or another disk repair program;
see the chapter on disks in the reference section). Or you can
take the computer to your authorized Apple service provider.



Learning the basics

The PowerBook comes with a tour and a tutorial to help you start
using your computer as quickly as possible.

» The Macintosh Basics tour teaches the most basic skills you
need to master before you can use your computer.

» The tutorial section of this book (Chapters 2—5) reviews the
basic skills taught in the tour, and teaches a few additional
skills you'll find helpful as you become more proficient.

Take the Macintosh Basics tour first.

Before you begin

Make sure your computer is turned on. If the screen is dark, try
the following steps in order until you see the Macintosh desktop
on your screen.

1. Adjust the screen brightness and contrast controls.
If you see the Macintosh desktop, skip to “Finding the Tour.”
2. Press any key on the keyboard (except Caps Lock).

Pressing a key wakes the computer if it was in sleep (a power-
conserving state described later in this chapter). If you see the
Macintosh desktop, skip to “Finding the Tour.”

3. Press the power button on the computer’s back panel.

Pressing the power button turns the computer on if it was off.
Continue with “Finding the Tour.”
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Finding the tour

Your Macintosh Basics tour may be on a floppy disk, or it may be
on the computer’s hard disk.

» If the Macintosh desktop appeared on the screen when you
first turned on your computer, then the system software
and the Macintosh Basics tour were installed on your
computer’s hard disk at the factory. Continue with the section
“Starting the Tour From the Hard Disk.”

» Ifyou needed to install system software when you set up your
computer then the Macintosh Basics tour is on a floppy disk
in the box with your computer. Locate the disk and continue
with the section “Starting the Tour From a Floppy Disk.”
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Starting the tour from the hard disk

1. Roll the trackball to move the arrow over the picture
labeled “Macintosh HD.”

Make sure the tip of the arrow is over the picture, not over
the words “Macintosh HD.”

E e Label Spec




2. Being careful not to roll the trackball, press the 3. Roll the trackball to move the arrow over the picture of

trackball button twice in quick succession. the folder labeled “Macintosh Basics.”
Now your screen should look like the picture following step 3. Make sure the tip of the arrow is over the picture, not over
If it doesn't, try steps 1 and 2 again, paying special attention to the words “Macintosh Basics.”
the following: . . . .
Wing The items in the illustration below may not exactly match
m  Make sure the tip of the arrow is touching the picture, not those on your screen. The only item you need right now is the
the words beneath it. Macintosh Basics folder.

= Be sure to press the trackball button twice.

(& File Edit liew Label Special [kd]

n Try pressing twice more quickly and be careful not to roll = e
the trackball while you press. —
o Oy

System Folder

continues »
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4. Being careful not to roll the trackball, press the 5. Roll the trackball to move the arrow over the picture of

trackball button twice in quick succession. the man labeled “Macintosh Basics.”
Now your screen should look like the following illustration: Make sure the tip of the arrow is over the picture of the man,

not over the words “Macintosh Basics.”

Macintosh HD

ECI==———~= Marinlosh Basics =—=—————| i El Macintosh® Basics HIE]
2.5 1B in disk 4.2 ME available [ 14 items 3.9 MBindisk  34.2 MB available

]

.

Macintosh Basics MEsTRem Basha 5

@l B
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6. Press the trackball button twice in quick succession.

Now your screen should look like the following picture:

Macintosh

Basics

Welcome to Macintosh Basics! I'll be your host throughout this
tour of the Macintosh. As you wotk through Macintosh Basics,
you'll learn whatyou need to get started using your Macintosh.

Press the Return key to continue

If you don't see this screen, try again, paying special attention
to the following:

Make sure the tip of the arrow is touching the picture, not
the words beneath it.

Be sure to press the trackball button twice.

Try pressing twice more quickly and be careful not to roll
the trackball while you press.

7. Follow the instructions on the screen and work through
the tour.

When you finish the tour, continue with “Turning the PowerBook
On and Off” and read the rest of this chapter for information that
can help you use your computer safely and efficiently. Then turn
to Chapter 2 and begin the tutorial.
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Starting the tour from a floppy disk After a moment, your screen should look like this:

1. Insert the Macintosh Basics disk into the floppy disk
drive (metal end first, label side up).

% File Edit UDiew Label Special

Macintosh® Basics

14 items 995K in disk 421K available
3]
Y ) n
Macintosh Basics 3]
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2. Roll the trackball to move the arrow over the picture of
the man labeled “Macintosh Basics.”

Make sure the tip of the arrow is over the picture of the man,
not over the words “Macintosh Basics.”

El Macintosh® Basics e
14 items 995K in disk 421K available

i

I

Macintosh Basics Iy

@] [

3. Press the trackball button twice in quick succession.

Now your screen should look like the following picture:

Macintosh

Basics

Welcome to Macintosh Basics! I'll be your host throughout this
tour of the Macintosh. As youwotk through Macintosh Basics,
you'll learn whatyou need to get started using yout Macintosh.

Press the Return key to continue

If you don'’t see this screen, try again, paying special attention
to the following:

= Make sure the tip of the arrow is touching the picture, not
the words beneath it.

= Be sure to press the trackball button twice.

n Try pressing twice more quickly and be careful not to roll
the trackball while you press.

4. Follow the instructions on the screen and work through
the tour.

When you finish the tour, read the rest of this chapter for
information that can help you use your computer safely and
efficiently. Then turn to Chapter 2 and begin the tutorial.
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Important care and safety instructions

For your own safety and that of your equipment, read and follow
all the instructions in this section. Keep these instructions
available for reference by you and others.

A Warning

Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be
supervised by an adult. Do not allow children access to the
interior of any electrical product and do not permit them to
handle any cables.

Do not use the computer in or near water.

Do not use cables that are frayed or otherwise damaged. Hold
a cable by its connector (the plug, not the cord) when
connecting or disconnecting it.
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Always handle batteries carefully.

Do not drop, puncture, disassemble, mutilate, or incinerate
the battery.

Recharge batteries only as described in this manual and only
in ventilated areas.

Transport batteries either inside the computer or in the
protective case provided with each battery. Do not transport
unprotected batteries.

Do not short-circuit the battery terminals (that is, do not
allow a metal object such as a paper clip or key chain to touch
the terminals). Doing so may cause an explosion or a fire.



A Caution

If you have a problem with your computer and nothing
presented in the manuals that came with the computer solves
the problem, take the computer to your authorized Apple
dealer or service provider. Attempting to repair the computer
yourself may void the limited warranty. Contact your
authorized Apple dealer or service provider for additional
information about this or any other warranty question.

Do not attempt to open the computer’s case. There are no
user-serviceable parts inside. Take the computer to an
authorized Apple service provider if necessary.

Do not drop or jar the computer.

Do not move the computer when you can hear its hard disk
spinning. When you put the computer to sleep, wait until the
screen is blank before moving the computer.

Use only the power adapter supplied with your computer.
Adapters designed for other electronic devices may look
similar, but they may not work with your equipment and may
damage the computer.

Never force a connector into a port. Make sure that the
connector matches the port and that it’s right side up. If the
connector and port do not join easily, they do not match.
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Do not use the computer in wet or dusty environments.

Keep dirt and liquids away from the ports on the back panel,
the keyboard, and the trackball. If you spill any food or liquid
onto the computer, shut it down immediately and unplug it
before cleaning up the spill. Depending on what you spilled
and how much got into the computer, you may have to bring
the computer to an authorized Apple service provider for
cleaning.

Do not touch the screen with any sharp or pointed objects.

Use only the battery supplied with your computer. Batteries
designed for other portable computers may look similar, but
they may not work with your computer and may damage it.

When recharging the battery, use only the power adapter
supplied with your computer. Adapters designed for other
electronic devices may not work with your equipment and
may damage the computer or the recharger.

Do not leave batteries in hot locations (such as the trunk of a
car).
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A\ Important

If the computer has been in a cold place for several hours, let
it warm up to room temperature before you use it.

Use the computer only in environments where the
temperature range is between 50°F/10°C and 104°F/40°C.

Do not expose the computer to very low (less than
—13°F/=25°C) or very high (more than 140°F/60°C)
temperatures.

If necessary, clean the outside surfaces of your computer
equipment with a damp (not wet) cloth or paper towel.

Clean the screen with soft, lint-free paper or cloth and a mild
glass cleaner. Do not spray the glass cleaner (or any other
liquid) directly onto the screen.



Health concerns associated with
computer use

Muscle soreness, eye fatigue, and other discomforts and injuries
sometimes associated with computer use can result from
performing any number of activities. Misuse of the same muscles
during multiple activities can create a problem that might not
otherwise exist. For example, if you engage in nonwork activities
that involve repetitive stress on the wrist—such as bicycling—and
also use your computer’s keyboard improperly, you may increase
your likelihood of developing wrist problems. Preventing health
problems requires careful attention to the way you use your body
at all times.

The most common health effects associated with using a
computer are musculoskeletal discomfort and eye fatigue. Any
activity that involves sitting for long periods of time, including
using a computer, can make your muscles sore and stiff.

To prevent discomfort and fatigue:

»  Arrange your work space so the furniture is properly adjusted
for you and doesn’t contribute to an awkward, inappropriate
working posture.

» Take frequent short breaks to give your muscles and eyes a
chance to rest and refresh.
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Repetitive stress injuries

Repetitive stress injuries (RSIs) can occur when a certain muscle
or tendon is repeatedly overused and forced into an unnatural
position. The exact causes of RSIs are not understood, but it is
thought that awkward posture, the amount of repetition, the
force used in the activity, and your physiology and lifestyle may all
contribute to their occurrence.

One RS often discussed in connection with computer use is a
wrist problem called carpal tunnel syndrome, which may be
aggravated by improper use of computer keyboards. This nerve
disorder results from excessive pressure on the median nerve as it
passes through the wrist to the hand. The information on the next
few pages can help you recognize hand positions that may cause
discomfort.
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Since the effects of repetitive movement associated with
computer use can be compounded by those of other work and
leisure activities to produce or aggravate physical problems,
proper use of your computer system must be considered just one
element of a healthy lifestyle. No one can guarantee that you
won't have problems even when you follow the most expert
advice on using computer equipment. You should always check
with a qualified health specialist if muscle, joint, or eye problems
occur.



Arranging your work space and equipment

The suggestions in this section can help you work more
comfortably with your computer.

Chair

Whenever possible, use an adjustable chair that provides firm,
comfortable support.

»  Adjust the height of the chair so your thighs are horizontal,
your feet flat on the floor, and the backs of your knees slightly
higher than the seat of your chair.

» The chair should support your lower back. Follow the
manufacturer’s instructions for adjusting the backrest.

Keyboard and trackball

»  When you use the keyboard and trackball, your shoulders
should be relaxed. Your upper arm and forearm should
form a right angle, with your wrist and hand in roughly a
straight line.

[T TTTITITITT
LI UL LTI LT 1T
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/ Not this

»  Use a soft touch on the keyboard and keep your hands
and fingers relaxed. Avoid rolling your thumbs under
your palms.

[TTTTT T T] [TTTT T ITTTT]

This Not this

= Change hand positions often to avoid fatigue.
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» Ifyou prefer, you can adjust the angle of the keyboard by
rotating the elevation feet at both ends of the back panel until
they snap into position.

The back of the keyboard is slightly elevated when the feet are
in use. Otherwise, the keyboard is level.

Mouse

If you use a mouse, position it at the same height as your
keyboard. When you slide the mouse, move your entire arm.
Avoid resting your arm on the desk and bending your wrist as you
move the mouse.
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Built-in display

Adjust the angle of the display to minimize glare and
reflections from lights and windows. Make sure there is
enough light to read the screen easily.

You may need to adjust the brightness and contrast of the
screen when you take the computer from one work location
to another, or if the lighting in your work area changes.

Contrast control

Brightness control

Clean the screen regularly (see “Important Care and Safety
Instructions”).



General suggestions

Wherever you're working, take a moment to think about
whether you feel comfortable, and change position if
necessary.

Occasionally rest your eyes. From time to time focus your eyes
on a distant object, and blink often while you work.

Some computer users may develop discomfort in their arms,
wrists, or hands if they do intensive work without breaks. If
you begin to develop chronic pain or discomfort in your arms,
wrists, or hands, consult your health specialist.
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Chapter 2

Working on the Desktop

In this chapter

Review basic trackball skills:

= Moving the pointer

» Choosing a command

m  Opening an icon

» Looking at the contents of a window
And learn:

m  How to close a window

= How to move a window

»  What the icons on your desktop represent

Before you begin
You should have already

= set up your computer according to the instructions in
Chapter 1

» gone through the Macintosh Basics tour supplied with your
computer

Make sure your computer is on.
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Use the trackball

Your computer has a two-button trackball. You use the ball itself to
control the movements of a pointer on the screen. The pointer
you'll see most often is an arrow ().

G N O - — - BE

You use the buttons to initiate actions that you want the computer
to perform. Both trackball buttons do the same thing. You can
always use whichever one you prefer.

Much of the work you do on the Macintosh uses four trackball
actions: pointing, clicking, pressing, and dragging.

(If you want to return to the Macintosh Basics tour for more
practice with the trackball, see Chapter 1 for instructions.)
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Point

You point to an object on the screen by rolling the trackball so the
pointer is positioned over that object. When the pointer is an
arrow, the #ip of the arrow must be exactly over the object.

I
|

A

- —— -

Practice pointing to different objects on the Macintosh desktop,
such as the startup hard disk icon near the upper-right corner, the
Trash icon near the lower-right corner, and the Help menu icon
near the right end of the menu bar.



Practice clicking different objects on the Macintosh desktop, such
as the startup hard disk icon near the upper-right corner and the
Trash icon near the lower-right corner.

=2 Macintosh HD o

ENE

Click

You click an object on the screen by pressing and quickly releasing
a trackball button while the pointer is over that object.

When you click an icon, it becomes highlighted (the icon is
darkened). A highlighted icon is said to be selected. A selected
x icon is the object of whatever action you choose next.

¢ o e .. D 8
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Press

You press by holding down a trackball button without moving the
trackball.
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Practice pressing the menu names and icons in the menu bar—
start with the Apple (@) menu icon at the left side, through the
menu names, and across to the Help and Application menu icons
at the right side. Pressing a menu name or icon “pulls down” the
menu. Read the items in each menu you pull down.

About This Macintosh...

@ Alarm Clock

fl Battery
Calculator

iZ Chooser
Control Panels




Drag

You drag an object on the screen by pointing to that object and
holding down a trackball button while you roll the trackball.

Practice dragging the startup hard disk icon and the Trash icon
around the Macintosh desktop. When you drag an icon, an outline
of the icon follows the pointer on the screen. When you release
the trackball button, the icon itself moves.

When you're finished practicing, drag the icons back to their
original positions. Then click once in the middle of the desktop.
(Clicking anywhere outside a selected icon returns that icon to its
original “unselected” state.)
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Choose a command

Choosing a command involves using a combination of the
trackball actions you've reviewed.

1. Point to the Special menu title in the menu bar.
2. Press to pull down the Special menu.

3. Drag to the first item in the menu (the Clean Up
Desktop command) so it becomes highlighted,
and then release the trackball button.

Special
Clean Up Desktop
Pmpighirash..,

Eject Disk #¥E
Erase Disk...

Restart
Shut Down

Sleep

When you choose Clean Up Desktop, the hard disk icon and the
Trash return to their original positions (as long as they're already
close).
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Giving orders to your computer
Telling the Macintosh to do something involves two steps:
1. selecting an object on the screen, and

2. choosing the action you want to perform on that
object.

When you select an object, you're telling the Macintosh to act
upon that object.

The objects you can select include an icon on the Macintosh
desktop, a sentence in a word-processing program, and a
picture in a graphics program—to give just three examples.

Most of the actions you can perform on the selected object
are listed in the menus at the top of the screen. The items, or
actions, in the menus are called commands. When you
choose a command, you are telling the computer to take

the action you've chosen on the selected object.

So—you tell your Macintosh what to do by using a very simple
“language” with only two kinds of words:

= nouns (the objects), and
» verbs (the actions)
and with only one rule:

= First the noun, then the verb (to this object, do that
action). In Macintosh terms: select an object, then choose
a command.



Open an icon

File
Open S 1!
Frint HE

{fsrna BiMnadane RIS

Opening an icon is your first exercise in telling the computer
what you want it to do.

1. Click the startup hard disk icon to select it.
Get Info #1
The icon is in the upper-right corner of the screen. Buptinate s

Unless someone has changed its name, the icon is called

“Macintosh HD.” Make sure that the icon is highlighted
(darkened), which means that it’s selected. When you choose the Open command, the selected icon

opens into a window (in this case, the Macintosh HD
window). The icon becomes filled in with a pattern

EE of dots, indicating that it has been opened.

E[[E=———-— Macintosh I =—F——
3 items 6.9 MB in disk 314 MB available
2. Point to the File menu title in the menu bar. _ [
3' Pl.ess to pull down the File menu. Read Me  System Folder TeachText
4. Drag to the Open command (the second item in the
File menu) so it becomes highlighted, and then release ]
the trackball button. E [l

« Different icons? The Macintosh HD window on your screen
may contain items not shown above. The differences are not
important; you can still do the exercises in this chapter and
the next. «
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Look at the contents of a window

Every window has several features that help you view the
window’s contents. But before you can work with the contents of
a window, you need to make that window the active window.

Make a window the active window

You can have several windows open on your screen at one

time, but only one window can be the active window. An active
window is one in which you can select objects and choose actions
to perform on those objects.

The Macintosh HD window is currently on your Macintosh
desktop. (The window appeared when you opened the Macintosh
HD icon.) You're going to open another window now.
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1. Click the Trash icon near the lower-right corner of the
screen to select it.

Make sure that the icon is highlighted, which means that
it’s selected to be the object you'll act upon next.

2. Point to the File menu title in the menu bar.

3. Press to pull down the File menu.



4. Drag to the Open command so it becomes highlighted, Active window
and then release the trackball button.

Macintosh HD
3 items &.9 ME in dizk 31.4 MB available

Read Me  System Folder TeachTest

Open
Prind
{ipge iindan SR _ _
S[lEE—————————— hash =—————""—""1TJ11=
‘ | E 0 items
Get Info 1 w
]
When you choose the Open command, the Trash icon opens 2 oo

into a window (the Trash window). The Trash icon becomes

filled in with a pattern of dots, indicating that it has been
opened. You should now have two windows on your Macintosh

desktop: the Macintosh HD window and the Trash window.
The Trash window is the active window. An active window has
a series of solid lines at the top of the window.

continues »
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5. Click anywhere in the Macintosh HD window to make
it the active window.

Notice that the solid lines now appear at the top of the
Macintosh HD window. (The area containing the window title
and the solid lines is called the title bar.) When windows
overlap, the active window is the one that’s on top.

Active window

E[[&———-= Macintosh Hl ==——1=
3 items 6.9 MEB in dizk 1.4 ME available
it
Fora| — |
s
Read Me  Systern Folder TeachText
T 0 ite

] ]

<] B
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Make a window larger or smaller

Sometimes you want to make a window larger, so you can see
more of its contents, or smaller, so it takes up less space on your
screen. You can change a window’s size by dragging its size box

or by clicking its zoom box.

1. Point to the size box in the lower-right corner of the
(active) Macintosh HD window.

S[1=——— Macintosh HD HIE
3 items £.9 ME in disk Z1.4 ME available
~ ki
Read Me  Systern Folder TeachTest
k
<l [

Size box



2.

Drag the size box in any direction, and then release the
trackball button.

While you drag, an outline follows the pointer to indicate the
window’s new size. The new size takes effect when you
release the trackball button.

= Macintpsh H EBie0F"———=0F
6.9 MB in disk 21 .4 MB available
(5]
%
]
<] B

3. Click the zoom box near the right end of the title bar.

E[[=——— Macintosh HD

mE—— Zoom box

S

items 5.9 ME in dizk

31.4 ME available

Read Me  System Folder TeachText

=]

eIl

The window “zooms” to a size that shows all the items in

the window.

Click the zoom box again.

The window zooms back to its previous size (the size that you

chose in step 2).
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Move the hidden contents of a window into view 2. Point to the File menu title in the menu bar.

As you work with your computer, you'll encounter windows 3. Press to pull down the File menu.
containing more than you can view on the screen at one time. You
can view contents that are out of sight, as described in the
following steps.

4. Drag to the Open command so it becomes highlighted,
and then release the trackball button.

When you choose the Open command, the System Folder

1. Check that the Macintosh HD window is active, then icon opens into a window (the System Folder window).

click the System Folder to select it.
You should now have three windows on your Macintosh

desktop: the Macintosh HD window, the Trash window, and

SESS Ll the System Folder window. (One or more of these windows
3 items €.9 ME in disk 21.4 ME available . .
w may be covered by the others.) The System Folder window is
i ? the active window because you opened the System Folder
Rea Sy I TeachText
most recently.
5. Point to the size box in the lower-right corner of the
o] System Folder window.
] BB

Make sure that the icon is highlighted, which means that
it’s selected.
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6. Drag the size box diagonally (up and to the left) to
make the window about half its current size, and then
release the trackball button.

E[[=——=—= System Folder HIE
9 items &.9 MB in disk 3t .4 MB available
(3}
) [a=
Apple Menu [terns Extenzions Systern  Control Panel
— o=
Finder Preferences Scrapbook File
B L
[ (=] ]
Startup [temns Printtonitor Docurnents -+
&l [=E
E——F"FFF=— System Folder E———— =I5
9 iterns 5.9 ME in disk Z1.4 MB available
(5] (8]
Apple Menu terns Extensions Systern  Control P
Verca
Finder Freferences Ser apbook File SC['OH bar

Horizontal scroll bar

The bars across the bottom and along the right side of the
System Folder window should now be gray, indicating that the
window has contents that are not currently visible. The gray
bars are called scroll bars.

7. Press the scroll arrow at the right end of the horizontal

scroll bar.
E——F"FFF=— System Folder E———— =I5
9 itemns 5.9 MEB in dizk Z1.4 MB available
Apple Menu terns Extensions Systern  Control Pal

Finder Preferences Scrapboak File

Scroll arrow

The contents of the window scroll past, bringing into view the
icons that were out of sight on the right.

Press the scroll arrow at the left end of the horizontal
scroll bar.

The contents of the window scroll past, bringing back into
view the icons that were out of sight on the left.

continues »
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9. Drag the scroll box toward the middle of the horizontal
scroll bar, and then release the trackball button.

E——F"FFF=— System Folder E———— =I5
9 itemns 5.9 MEB in disk Z1.4 MB available
=il 1}_ Scroll box
le Menu Htemns Extensions Systern  Control Panel
=
G——
Findet Preferences Scrapbook File

Now you see the icons near the middle of the window.

The vertical scroll bar, scroll box, and scroll arrows work the same
way. Try them.
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Close a window

When you no longer need to see the contents of a window,
you can close it by clicking the close box.

1. In the (active) System Folder window, point to the close
box near the left end of the title bar.

Close box
E[[=—— system Folder ——=0F
9 itermns &.2 ME in disk Z1 .4 ME available
% Lr o]

Te Menu tems Extensions Sysztern  Control Panel

—  |[o-—

Finder Preferences  Scrapbook File

2. Click the close box.

The window closes, and the System Folder icon no longer has
a pattern of dots in it.

There are now two windows on the desktop: the Macintosh
HD window and the Trash window. (One may be hidden by
the other.)



Move a window Notice how the Macintosh HD window, because it is the active

window, stays on top of the Trash window if and when the two
You can move a window anywhere on the screen by dragging its windows overlap.

title bar. By changing the position and size of windows, you can
arrange your Macintosh desktop in whatever way is best for you.

& e Edil Ulew Lobel Spec

1. Point to the title bar of the (active) Macintosh HD Macintosh §

. 6.9 ME in disk Z1.4 ME available
window.

[L=H|
e Systemn Folder TeachText

Position the pointer anywhere on the title bar except over the
close box or the zoom box.

Title bar
: E[IE———- Matcintosh H =——0L !
3 items 6.9 ME in disk Z1.4 MB available
= [
ReadMe  System Folder TeachText 3. Close the Macintosh HD window by clicking the close
box near the left end of the window’s title bar.
o If you can’t see the close box, drag the window until you can.
<] B2
EQE Macintosh H
2. Drag in any direction, and then release the trackball 2 teme S
button. _
When you drag, an outline of the window follows the pointer
on the screen. When you release the trackball button, the
window moves to the position you've chosen. continues »
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The window closes, and the Macintosh HD icon reappears in
its previous form.

The Trash window (the remaining window on the Macintosh
desktop) becomes the active window.

4. Close the Trash window by choosing Close Window
from the File menu.

Rigaer ¥ anigfery
Open
fFripd
Close Window

Get Info

You choose Close Window by pointing to the File menu
title, pressing to pull down the menu, dragging to the Close
Window command, and, with the command highlighted,
releasing the trackball button.

Of course, you can also close the window by clicking its
close box.
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What's on the desktop?

Just as a desk’s large flat surface is its work space, the Macintosh
“desktop” is the work space on your computer. The desktop
metaphor gives you a familiar way of thinking about how to use
the Macintosh.

Aside from the field of gray that represents the “surface” of your
work space, the Macintosh desktop has icons, windows, and
menus.

m [cons represent containers.
»  Windows let you view what's inside the containers.

m  Menus list actions that you can apply to selected containers
or their contents.

Icons represent containers
Icons can contain other icons, or they can contain information.

For example, the startup hard disk icon contains the System
Folder icon. The System Folder icon contains the programs (also
represented by icons) that in turn contain the information the
Macintosh needs to start itself up and work properly.



Different types of icons represent different types of containers.

Hard disks and floppy disks are like filing cabinets. You use disks
to store files—your programs and the documents you create

with them.
E
||

Floppy [risk

L]

Hard Disk

Shared disks are like filing cabinets containing office supplies or
information that you share with others in your work group. Your
Macintosh needs to be connected to a network before you can
use shared disks.

=

Metkart

1
—i

Shared Disk

Folders are like folders in a file drawer. You use folders to
organize your files.

=

Systern Folder ailing List=

Programs are files containing instructions to the computer that

let you do certain types of work.

Mermoflaker BeanCounter

TeachText SketchPad
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Documents are files containing words, pictures, numbers,
sounds—whatever you create with your programs.

= @ -
zz= L

Taiko Report Sketch Office Design

2

Concert Merno Budget  Studio Layout

The Trash is a container for files that you no longer want.

—

|

Traszsh
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Windows let you see what'’s inside containers

Windows let you see what's inside all these containers.

When you open a disk icon, the window that appears shows you
what's on the disk. When you open the document icon
representing a memo, the window that appears shows you

the memo.

Changing the size of a window or viewing its contents does
not change the contents. The contents remain the same; only
your view changes.

Menus offer you choices

Like the menus in a restaurant, Macintosh menus let you
choose. You choose among different actions that the computer
can perform on containers (icons), or on their contents (such as
words in a memo).



Using the keyboard

You use the keyboard to type text and numbers, just as you
would on a typewriter. (For touch typists, your keyboard has
raised dots in the middle of the D key and the K key to help
position your fingers on the home row.)

Depending on the program you're using, you can use special
keys on the keyboard to give commands to the computer and to
modify certain things that you do with the trackball. Macintosh
PowerBook computer keyboards have two types of special keys:
modifier keys and arrow keys.

Modifier keys

All Macintosh keyboards have four modifier keys: Shift,
8 (Command), Option, and Control.

Pressed by itself, a modifier key does nothing. You need to press

it in combination with another key (or while using the trackball).

The modifier key causes the other key or trackball to give a
different (“modified”) result.

You type a capital letter, for example, by pressing the Shift key
with a letter key. Most programs let you choose commands by
pressing the 88 key with certain letter keys.

Arrow keys

All Macintosh keyboards have four arrow keys: Up Arrow, Down
Arrow, Left Arrow, and Right Arrow.

Many programs let you use the arrow keys as well as the
trackball to move the pointer on the screen.

[ ) ) 1 A
(T ) 1 T
e U e
BEE T L

_—

= Modifier keys [ Arrow keys
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Chapter 3

»  What “keyboard shortcuts” are and how to use them

Creating and Changing .
a DOCument = How to make a copy of a document

»  How to change the name of a document
In this chapter

= How to open a program

s How to use a program to create a document Before you begin

m  How to use the Trash

»  Whyit’s important to save your work, and how to save it Make sure that your computer is on.
= How to switch between programs

»  How programs and system software differ from each other
= How to close a document

= How to open a document

= How to change a document
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Open a program

Your computer comes with a simple word-processing program
called TeachText. You're going to use this program to create a
document.

1. Open the Macintosh HD icon.

(Click the icon to select it, and then choose Open from the
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program.

2. Open the TeachText icon.

If you can’t find the TeachText icon, use the scroll bars to bring
it into view.

TeachText

To open the icon, click the icon to select it, and then choose
Open from the File menu.

56 Chapter 3: Creating and Changing a Document

When you open the TeachText program, there is one dramatic
change on your desktop:

= Awindow called “Untitled” appears.
There are also two subtle changes:

s The menu bar shows the menu names for the TeachText
program.

» The Application menu icon in the right corner of the menu
bar becomes the TeachText icon.

TeachText menus TeachText icon

'& File Edit' @ @

Untitled

The untitled window is empty because you haven’t put anything
in it. In the next few sections, you're going to write a short
document, save it, and give it a name.



Create a document Save your work

The untitled window is like a blank sheet of paper. In the Work that you do in a program exists only in the computer’s
upper-left corner of the empty document is a blinking vertical memory until you save it onto a disk. Since work that exists only
line (|). This line is called the insertion point, because it marks in memory is lost when you shut down the computer, you need
the place where the text you type will be inserted. to save your work so you can come back to it later. If you don’t

save your work, it disappears—like thoughts that are lost unless

As you type, use your computer keyboard as you would a you write them down.,

typewriter keyboard, except:

= Ifyou make a mistake, press the Delete key to backspace 1. Choose Save from the File menu.

over it.

m  Don't press the Return key when you get to the end of a line. m __
Keep typing, and words will move to the next line ;;}:f; ;
automatically.

) Close #L

Type the following text: S

Save fis...
All people are born free and equal.
Endowed with reason and conscience, they Page Setup...
should act towards each other in a spirit Print... %P
of togetherness. :

Quit %0

You will be changing this text later in this chapter.

The box that appears (called a dialog box) lets you name the
document and save it on your hard disk.

continues »
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2. Type “Opening Lines”.

e Macintosh HD¥ © Macintosh HD
0 Reayg Me 1|
0 System Folder .
& Teaehient Desktop
o
Save this document as: N
Opening Lines| | O @)

Because the word “Untitled” is selected (highlighted) when
the dialog box appears, all you have to do to name your
document is start typing. Whatever you type replaces the
selected text.

3. Click Save.

== Openinglines==x"15

All people are born free and equal. Endowed with reason and ﬁ

conscience, they should act towards each other in a spirit of
togetherness|

The window is now titled “Opening Lines” and the document
has been stored on your hard disk.
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Switch programs

You can have several programs open on your Macintosh desktop
at one time (how many depends on how much memory your
computer has and how much memory the programs use). But
only one program at a time can be the active program. The active

program is the one that’s “on top of” other open programs—in
the same way that the active window is on top of other windows.

The Opening Lines window is now the active window, and
TeachText is the active program. But TeachText is not the only
program that’s open.

Since you turned on your computer, you've been working with
the Finder program. The Finder displays the Macintosh desktop.
The Finder is always open when your Macintosh is on, so right
now it is open but not active.

1. If the Opening Lines window covers most of your
screen, make the window smaller by dragging its size
box up and to the left, and then release the trackball
button.

After you resize the window, you should be able to see your
hard disk icon in the upper-right corner of the desktop.



2. Make the Finder the active program by clicking the 3. Make the Opening Lines window active by clicking
Macintosh HD icon, or clicking anywhere on the anywhere inside it.

desktop outside the Opening Lines window. (Part of the window may be hidden by the Macintosh HD

The Finder becomes the active program. Notice: window.)
»  The Macintosh HD window appears on top of the When you click, the Opening Lines window comes back to the
Opening Lines window. top. It’s now the active window again, and TeachText is the

' , . active program.
s The menu bar shows the Finder’s menu titles. prog

You make a window active by clicking any visible part of it.
The program that “owns” the window becomes active when
the window becomes active.

» The Application menu icon at the right end of the
menu bar becomes the Finder icon.

Here is another way to make a program active:

Opening Lines

A1l people are born free and equal. Endowed with reason and 4 Make the Finder the active program by choosing Finder
conscience, they should act towards each other in a spirit of
togetherness. from the Application menu at the right end of the
ES[[=————= Macintosh HD ==——=—=[15 menu bar
4 items 3.7 MB in disk 34.4 MB available o

= N [}

System Folder TeachText Opening Lines

Hide TeachText
Hide Others
Sho fii

El Finder |
v 48 TeachTent

=[]

l [2)

You may also notice the Opening Lines icon in the
Macintosh HD window, representing the document you
just created and saved.

continues »
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You choose Finder by pointing to the Application menu icon,
pressing to pull down the menu, dragging to highlight the
name Finder, and then releasing the trackball button.

The Finder becomes the active program, and the
Macintosh HD window becomes the active window.

5. Make TeachText the active program by choosing
TeachText from the Application menu.

Hide Finder
Hide Others
Shaws $i

v B Finder
TeachText

TeachText becomes the active program, and the Opening
Lines window becomes the active window.

All open programs are listed in the Application menu. You can
use the Application menu to choose which program to make
active. The icon in the menu bar is always the icon of the
currently active program.
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Close a document

When you close a document, you do not close the program that
you used to create it. (Closing a program is called quitting.) The
program remains open and active until you quit the program or
make another program active.

1. If the Opening Lines window is not the active window,
click anywhere inside it to make it active.

2. Close the Opening Lines window.

You can either click the close box near the left end of the title
bar, or choose Close from the File menu.

The Opening Lines window closes but TeachText is still the active
program. Notice:

s The menu bar still shows the TeachText menu titles.

» The Application menu icon at the right end of the menu bar
is still the TeachText icon.



Two types of programs

Programs that you use to do your work on the computer are
called application programs, or applications, because they're
ways of applying computer technology to the work that you do.

Word-processing programs, for example, are applications that
enable you to write memos, novels, or whatever you need to
write. And if your work involves creating illustrations,
designing buildings, composing music, or keeping track of
large amounts of data, there are application programs for
those kinds of work, too.

Because most Macintosh programs work in similar ways,
you can transfer much of what you learn in one application to
other applications.

Programs that the computer uses to do its work (in contrast to
your work) are called system software, or sometimes the
operating system.

Between you and the system software is a program called the
Finder, which displays the Macintosh desktop. It’s called the
Finder because, like the viewfinder in a camera, it gives you a
view of all the objects— disks, programs, folders, and
documents—on your desktop.

You use the Finder to tell the system software what you want it
to do for you: which disks you want to use, which documents
and programs you want to open, and where you want files to be
stored.

Open a document

When you open a document, the program you used to create that
document becomes the active program.

1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.

(Click the icon to select it, and then choose Open from the
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and the TeachText document you created
called Opening Lines.

The next step describes a different way to open an icon.

continues »
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2. Open the Opening Lines icon by double-clicking it.

Opening Lines

To double-click an icon, you click it twice in rapid succession
without moving the pointer. (Use the trackball to position the
pointer over the icon, and then click one of the trackball
buttons twice.) Double-clicking an icon has the same effect as
selecting the icon and then choosing the Open command.

Change a document

The Opening Lines window shows you the text you typed. In this
section you'll make some changes to the text using techniques
that work in most Macintosh programs.

Keep two things in mind:

The insertion point—the blinking vertical line—marks the
place where text will appear.

A pointer called an I-beam (it looks like this: T) replaces the
arrow pointer (%) when you're working with text. You control
the I-beam pointer with the trackball in the same way that you
control the arrow pointer.

When you open Opening Lines, TeachText becomes the active 1.
program. Notice that:

Locate the insertion point. It should be in the upper-
left corner of the document.

Locate the I-beam pointer (I). If you don’t see it, roll
the trackball slightly. The pointer moves as the
trackball moves.

» the Opening Lines window appears 2.
m the menu bar shows the TeachText menu titles

» the Application icon at the right end of the menu bar is the

i Now you’re ready to change the text.
TeachText icon ¥ y 8

EDE Opening Lines
All people are born free and equal. Endowed with reason and
conscience, they should act towards each other in a spirit of
togetherness|

Bl
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3. Move the I-beam pointer to the immediate left of the
word “people” (after “All”).

4. Drag horizontally, selecting the word “people”, and
then release the trackball button.

Opening Lines
are born free and equal. Endowed with reason and
conscience, they should act towards each other in a spirit of
togetherness.

S im)

To drag, hold the trackball button down while you roll the
trackball. The selected word is highlighted (surrounded by
black).

If you select more or less than you intended to, go back to
step 3 and try again.

5. With “people” selected, type the words “human beings”.

The words you type replace the word you selected. (Press the
Delete key to backspace over any typing errors.)

|§D% Opening Lines a5
A1l human beingsl are born free and equal. Endowed with reason and |1}
conscience, they should act towards each other in a spirit of
togetherness.

6. Move the I-beam pointer between the word “equal” and
the period (to the immediate left of the period).

L=

EO==———— opening liness=———11¢
ATl human beingd are born free and equal[ Endowed with reason and [£¥
conscience, they should act towards each other in a spirit of

togetherness.

7. Click the trackball button once.

Clicking moves the insertion point to the spot where you
positioned the I-beam. Whatever you type next is inserted
at that point.

8. Press the space bar once, and then type the words “in
dignity and rights”.

L=
i

== openinglnes=—————
A1l human beings are born free and equal in dignity and rightsI,
Endowed with reason and conscience, they should act towards each
other in a spirit of togetherness.

B

continues »
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Now you'll rearrange some text.

9. Move the I-beam pointer to the immediate left of the
word “they” (after “conscience,”).

10. Drag horizontally, selecting the word “they”, and then
release the trackball button.

|§D§ Opening Lines §E§|
All human beings are born free and equal in dignity and rights. 43
Endowed with reason and conscience, should act towards each
other in a spirit of togetherness.

11. With “they” selected, choose Cut from the Edit menu.

Choosing Cut removes the selected material from the
document and stores it in a temporary file called the
Clipboard.

Edit I

s L
Copy I 8C
Paste 1)
Clear

Select All %A

Show Clipboard
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12. Move the I-beam pointer to the immediate left of the
word “Endowed”.

IEDE Opening Lines &=————— |
All human beings are born free and equal in dignity and rights. 43
IEndowed with reason and conscience, should act towards each
other in a spirit of togetherness.

13. Click to place the insertion point.
14. Choose Paste from the Edit menu.

Ecit I

oo S

ful
fopy

{{pay

Select All %A

Show Clipboard

When you choose Paste, your computer takes whatever’s in
the Clipboard and puts it into the document at the location of
the insertion point.



15. Press the space bar once, type “are”, and then press the
space bar once again.

EO=————— opening Lines =115
A1l human beings are born free and equal in dignity and rights. they[<
are Endowed with reason and conscience, should act towards each
other in a spirit of togetherness.

16. Move the I-beam pointer between the letters ¢ and b in
the word “they”.

|§D§ Opening Lines §E§|
All human beings are born free and equal in dignity and rights. %eg{}
are |Endowed with reason and conscience, should act towards each
other in a spirit of togetherness.

17. Click the trackball button to place the insertion point.
18. Press the Delete key once and then type a capital T.

Save your work so far

The changes you've made so far are not part of Opening Lines
until you save them. You save them by telling the computer to

record them in the Opening Lines document that’s stored on your
hard disk.

It's important to remember that no change is “official” until
you save it onto a disk. Your work could be lost if power to

the computer were interrupted or if a problem caused the

computer to stop working properly.

Choose Save from the File menu.
Save regularly, and save often.
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Taking a shortcut

You can choose some menu commands by using the
keyboard instead of the trackball. A keyboard shortcut is a
combination of keys that you press at the same time to get
the same result as choosing a command from a menu. One of
the keys you press is always the 88 key or another modifier
key.

For example, instead of choosing Save from the File menu,
you can hold down the 8 (Command) key on the keyboard
while you press the S key. Pressing $8-S is a keyboard shortcut
equivalent to choosing Save from the File menu.

You can see the available keyboard shortcuts by pressing a
menu title and looking at the commands in the menu. The
keyboard shortcuts are listed next to the commands.
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Make more changes

The changes you've made so far are now part of the document
that’s stored on your hard disk.

1. Move the I-beam pointer (1) between the letters E and n
in the word “Endowed”.

IEDE Opening Lines &==———— 5
All human beings are born free and equal in dignity and rights. 43
Tlheg are E[ndowed with reason and conscience, should act towards
each other in a spirit of togetherness.

2. Click once to place the insertion point.
3. Press the Delete key once and then type a lowercase e.

4. Move the I-beam pointer to the immediate right of the
comma after the word “conscience”.

L=
i

EOeV——"———=— Ty ties
All human beings are born free and equal in dignity and rights.
They are dndowed with reason and conscience] should act towards
each other in a spirit of togetherness.

]



5. Press the Delete key once, press the space bar once, 8. Move the I-beam pointer to the immediate right of the

and then type “and”. “each other”. Do not drag. Do not click the trackball
button yet.
EO=——— openinglines==o—— 11| 9. Hold down the Shift key on your keyboard and click to
All human beings are born free and equal in dignity and rights. 43 SClCCt the WOl'dS “each Othel'”
They are endowed with reason and conscience and should act :
towards each other in a spirit of togetherness.
fO=—————— openingLines = 15|
All human beings are born free and equal in dignity and rights. 43

They are endowed with reason and conscience and should act
6. Move the I-beam pointer to the immediate left of “each I RARRE T e e

other”.

EC=———— opening Lines HOldlng down the Shlft key while you click selects the text
All human beings are born free and equal in dignity and rights.

They are endowed with reason and conscience and should act bC[WCCH the Insertion pOlﬂ[ and wherever YOU Cth'
towards Bach other in a spirit of togetherness.

o im)

10. With “each other” selected, type “one another”.

. [EO============= opening Lines
7. Click the trackball button once.

A1l human beings are born free and equal in dignity and rights.
They are endowed with reason and conscience and should act
Clicking moves the insertion point to the place where you OISR O C GRS

positioned the I-beam.

continues »
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11. Select the word “togetherness” by double-clicking it.

|§DE Opening Lines
All human beings are born free and equal in dignity and rights.
They are endowed with reason and conscience and should act
towards one another in a spirit of |unf=Rgl=lael=Rs.

o im|

To select a word by double-clicking it, position the I-beam
pointer over the word and then click twice in rapid
succession, without moving the pointer.

12. With “togetherness” selected, type “brotherhood”.

You may now have extra spaces or no spaces between words.
If so, position the I-beam pointer where you need to delete or
add a space, click to place the insertion point, and press the
Delete key or the Space bar as necessary.

EOE=—— openinglines=———————
All human beings are born free and equal in dignity and rights.
They are endowed with reason and conscience and should act
towards one another in a spirit of brotherhood.

o im)

13. Choose Save from the File menu.
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Quit a program

Quitting a program closes the program as well as any open
documents that were created using that program. (Simply closing
a document leaves the program open and active.)

1. Make sure that the Opening Lines window is active.
2. Quit the TeachText program.

You can either choose Quit from the File menu, or press
the 88 key and the Q key together.

NG

fpen.., G
Close BW
Sapa HE
Save fs...
Page Setup...
Print... XP

If 2 message asks whether you want to save any changes, click
Save.

The Opening Lines document and the TeachText program are
closed, and the Finder becomes the active program.



Opening and closing documents and programs

Doing this Also causes this

Opening a document Opens the program that created
that document

Making a document Makes the program that “owns”

window active that document active

Closing a document Simply closes that document; does
not close the program that created
that document (the program continues
tO use memory)

Quitting a program Prompts you to save your work,

then closes the program that created
the active document (memory becomes
available for other programs)

Make a copy of a document

You'll often want to make a copy of a document so you can
preserve the original and modify the copy. To practice making a
copy of a document, you'll use the “Opening Lines” document
you created.

1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.

(Click the icon to select it, and then choose Open from the
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and the TeachText document you created
called Opening Lines.

2. Click the Opening Lines icon to select it.

Clpo=rirey Lirp==

continues »
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3. Choose Duplicate from the File menu.

New Folder 8N
Open $0
Print ®BP
Close Window W
Get Info 81
Duplicate #
Make RAlias

Put Rusay ¥
Find... 8F
Find Again %86
Page Setup...
Print Window..

A new icon, labeled “Opening Lines copy”, appears in the hard
disk window. Notice that the icon is selected.

Other ways to make a copy of a file are outlined in the summary
chapter in the reference section of this book.
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Change the name of an icon

You can change the name of any icon, using any characters except
a colon (:). If you change an icon’s name and then open it, you'll
see that the name of its window has also changed.

1. Drag the “Opening Lines copy” icon away from the
original icon so that the two icons do not overlap.

2. Click the name (not the icon) “Opening Lines copy.”
Do this even if the icon is already selected.

When the name is selected, it is highlighted and a box appears
around it. Notice that when you point to the selected name,
the arrow pointer becomes an I-beam.

[Cpering Lines|sopu|



3. With the name selected, type “Article 1”.
Whatever you type replaces the selected text.
4. Press the Return key.

Pressing Return saves the new name.

Opening Lines  [xImADALH

Now you have two identical documents with different names.

You can revise one without changing the other.

Use the Trash

When you no longer need a file or a folder, you can throw it away
by dragging its icon to the Trash. Practice using the Trash by
throwing away the “Article 1”7 document, which you created when
you made a copy of the “Opening Lines” document.

1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.

(Click the icon to select it, and then choose Open from the
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and two documents, one called Opening
Lines and the other called Article 1 (you may have to use the
window’s scroll bars to see them).

continues »
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2. Drag the Article 1 icon to the Trash icon until both
icons are highlighted, and then release the trackball
button.

If the Macintosh HD window is blocking the Trash icon, move
the window by dragging its title bar.

Both icons are highlighted when the tip of the arrow pointer
reaches the Trash icon.

When you release the trackball button, the Article 1 icon
“disappears” into the Trash. When you put an object in the
Trash, the Trash icon bulges to indicate that it is no longer
empty.
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. Open the Trash icon.

(Click to select the icon, and then choose Open from the File
menu, or click the Trash twice in quick succession.)

The Trash window appears. Anything you drag to the Trash
stays there until you empty the Trash.

You can retrieve items from the Trash by clicking to select
them and then choosing Put Away from the File menu.
(Or you can drag the items back to where they were.)

. Choose Empty Trash from the Special menu.

A message appears asking you to confirm that you want to
permanently remove the contents of the Trash.

. Click OK.

Clicking OK empties the Trash—in other words, its contents
are erased from the disk.

Notice that the Trash icon no longer bulges, indicating that
it is empty.

. Close the Trash window by clicking its close box.



Chapter 4

Working With Disks

In this chapter

m  What hard disks and floppy disks are for, and how they differ
= How to insert and remove a floppy disk

»  How to prepare a disk for use

= How to copy the contents of a disk

»  How to protect a floppy disk and its contents

= How to put programs onto your computer

Before you begin

You need a new floppy disk to follow the steps in this chapter.
You should be able to get floppy disks from wherever you got
your computer.

Make sure that your computer is on.
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Insert a floppy disk

Your computer’s floppy disk drive can accommodate 3.5-inch
(89-millimeter) floppy disks of two types:

» high-density disks, which can hold up to 1.4 megabytes (MB)

of information

» double-sided disks, which can hold up to 800 kilobytes (K)

of information
(The next page explains kilobytes and megabytes.)
Double-sided (800K) disk High-density (1.4 MB) disk

Second hole

High-density
disk symbol
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Follow these steps to insert your new disk into the disk drive.

1.
2.

Write “Practice” on a blank disk label.
Attach the label to your new floppy disk.

The molding of the disk’s plastic case indicates where the
label goes. Do not affix the label over the metal shutter.

Hold the disk with your thumb on the label and the
metal shutter pointing away from you.

Push the disk into the floppy disk drive, label side up
and metal shutter first.

The next section, “Initialize a Disk,” explains what to do about
the message that appears on your screen.



Floppy disks and hard disks
10,000 pages
Both floppy disks and hard disks function like filing cabinets:
you use them to store information. You can store much more on
a hard disk than on a floppy disk, however, and the computer
can retrieve information from a hard disk much faster. 5,000 pages

Floppy disks and hard disks are represented by different icons.

300 pages
200 pages
L 1 page = >
=0
] J:J . = =
Hard Disk  Floppy Disk 4K 800K  14MB  20MB

\—'—1 \—'—1
Floppy disks Hard disks

The disk whose icon is closest to the upper-right corner of your
desktop is the startup disk, which contains the information the

) Even the smallest hard disks can hold the equivalent of a few
Macintosh uses to operate.

thousand pages of information. High-density floppy disks can

Your hard disk is sealed into the hard disk drive inside your hold 1.4 megabytes (MB) of information—about 300 typewritten
computer. Floppy disks, in contrast, can be taken in and out of pages. Double-sided floppy disks can hold 800 kilobytes (K) of
floppy disk drives so you can easily transfer information from information—about 200 typewritten pages. (A megabyte is about
one computer to another. 1,000 kilobytes.)

A floppy disk is made of thin, flexible material with a magnetic
coating. To protect it and make it easier to handle, the floppy
disk itself is enclosed in a rigid plastic case, which gives the
floppy disk its “non-floppy” character. Floppy disks are
sometimes called diskettes.
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Initialize a disk

Every new disk needs to be prepared for use. Preparing a new
disk is called initializing it. In the same way that lines are drawn on
a newly paved parking lot to mark off parking spaces, the
initializing process creates organized areas on the disk where the
computer can store information. Your computer’s hard disk was
initialized at the factory, but you need to initialize any new floppy
disks you want to use.

1. Read the message on your screen.

The computer requests information from you or warns you
about the consequences of an action by presenting a message
in the form of a dialog box.

If you inserted a high-density disk, this dialog box appears:

This disk is unreadable:
Do you want to initialize it?
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If you inserted a double-sided disk, this dialog box appears:

This disk is unreadable:

3=

——= Do you want to initialize it?

[ Eject || [one-sided] [Two-sided]

If you inserted a high-density disk, click Initialize.
If you inserted a double-sided disk, click Two-Sided.

Another dialog box appears:

This process will erase all
information on this disk.

Cancel Erase

This dialog box appears because you can initialize old disks as
well as new ones—and the computer doesn’'t know whether
the disk in the drive is old or new. Initializing erases all
information on a disk. In this case, because the floppy disk is
new, there is no information on it to erase.



3. Click Erase. 5. Click OK.

A third dialog box appears: The computer takes about a minute to initialize the disk.
Messages appear on the screen to let you know how the
process is going.

Please name this disk When initialization is finished, the disk’s icon appears directly

below the Macintosh HD icon (the startup hard disk icon)
near the upper-right corner of the desktop.

4. Type “Practice”.

If you make any typing errors, press the Delete key to
backspace over them.
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Copy the contents of a disk

Most programs you'll use with your Macintosh are supplied on
floppy disks. You can use a program more efficiently if you first
install it on your hard disk. You install most programs by copying
them from the floppy disk to your hard disk.

To practice copying the contents of a floppy disk to your hard
disk, use your practice disk (even though there’s nothing on it).

1. Drag the Practice floppy disk icon to the Macintosh HD
icon until both icons are highlighted, and then release
the trackball button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Macintosh HD icon.

TE
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When you release the trackball button, the Macintosh copies
the contents of the Practice disk onto Macintosh HD (your
hard disk). Because there is nothing on the Practice disk, the
copying happens very quickly.

Now, find the copy of Practice you just created.

. Open the Macintosh HD icon.

To open the icon, click the icon to select it and then choose
Open from the File menu. (You choose Open by pointing to
the File menu title, pressing to pull down the menu, dragging
to the Open command, and then releasing the trackball
button.)

The Macintosh HD window appears, showing you the
contents of the hard disk. The contents should include a new
folder called Practice, which the computer created when it
copied the contents of the Practice disk to Macintosh HD.

You may have to make the window larger or use the scroll bars
to see the Practice folder.



3. Open the Practice folder icon. ) )
Taking care of floppy disks
To open the icon, click the icon to select it and then choose
Open from the File menu. Follow the care instructions that came with your disks, and

remember three key points:
The folder holds the contents of the floppy disk you've

copied. In this case, the folder is empty because there’s = Keep floppy disks away from magnets. Because
nothing on the Practice disk. information is stored on the disk in the form of magnetic
signals, a magnetic field can destroy that information.

4. Close all the windows on the Macintosh desktop. Televisions and monitors, telephones, loudspeakers, and
You close a window (when it’s the active window) by either certain kinds of lighting fixtures all contain magnets.
clicking its close box or choosing Close Window from the m  Protect disks from extremes of temperature and humidity.
File menu.

= Do not open the disk’s metal shutter. Touching the disk
inside the shutter could damage it.
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Take a floppy disk out of its drive

You take a floppy disk out of its drive when you no longer need to
get information from or store information on that disk.

1. Click the Practice floppy disk icon to select it.

Click the icon, not its name.
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2. Eject the floppy disk by choosing Put Away from the
File menu.

MNew Folder 3EN

Open 30
Fripd i
fimug Hilndop: R
Get Info 31

Gagniinais izt
Make Alias

Put Away

Find... HF

Find Again LA
Page Setup...

Print Desktop...

You choose Put Away by pointing to the File menu title,
pressing to pull down the menu, dragging to the Put Away
command, and releasing the trackball button.

Put Away returns the object you've selected to its original
place. In this case, it ejects the floppy disk from the disk drive
SO you can put it away.



Protect the contents of a disk

You can lock a floppy disk so its contents cannot be changed in
any way. When a disk is locked, you can look at the files it
contains, but you cannot modify the files on it, delete them, or
store any new files.

Use your practice disk to practice locking and unlocking a
floppy disk.

1. Hold the practice disk with your thumb on the label
and the metal shutter pointing away from you, as
though you were going to insert the disk into a drive.

2. Find the square hole in the near-left corner of the
floppy disk.

A moveable tab on the back side of the disk should be
blocking the hole, indicating that the disk is unlocked.

If you're using a high-density disk, you'll notice an additional
square hole, across the label from the first hole. This second
hole has no tab and is always open.

3. Turn the disk over and lock it by sliding the tab so that
the square hole is open.

Locked Unlocked

Use your thumbnail or a push pin to move the tab.

4. Unlock the disk by sliding the tab back so that the
square hole is blocked.

You are unlocking your practice disk now so you can use it to
store files in the next chapter.
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On your own: Install your programs

If you have a floppy disk drive and disks containing programs that
you plan to use with your Macintosh, you can install the programs

on your hard disk now (or you can wait until later and continue
with the next chapter).

The general instructions in this section describe how to copy the

contents of a program disk to your hard disk.

/\ Important: Some programs need to be installed in a
particular way. If your programs came with specific
instructions, follow them instead of the instructions in this
section. A

1. Lock the program disk.

The program disk contains your master copy of the program.

Locking the disk protects its contents but doesn’t keep you
from copying the contents onto another disk.

2. Insert the program disk into your floppy disk drive.
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3. Drag the program disk icon to the Macintosh HD icon

(your hard disk icon) until both icons are highlighted,
and then release the trackball button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Macintosh HD icon.

When you release the trackball button, messages appear on
the screen to let you know that the computer is copying the
contents of the program disk onto your hard disk.

When copying is finished, the contents of the program disk
appear on your hard disk in a folder that has the same name
as the program disk.

. Eject the program disk by selecting it and choosing Put

Away from the File menu.

. Open the Macintosh HD icon.

The Macintosh HD window shows you the contents of your
hard disk. Among its contents is the program folder, which
contains the same items as the original disk.



6. Click the program folder to select it.
7. Choose Open from the File menu.

The folder window appears, showing you the contents of
the program folder. The folder has the same contents as the
program disk.

8. Look for a System Folder in the program folder.

Some program disks contain a System Folder so they can be
used as startup disks. (A startup disk, by definition, is a disk
that has a System Folder on it.) If the program disk you've
copied has a System Folder, you now have two System Folders
on your hard disk. For the computer to work properly, you
must throw away any extra System Folders.

Throw away extra System Folders

Your startup disk must have only one System Folder on it.
Whenever you copy the contents of a program disk to your hard
disk, make sure that you have not copied an extra System Folder.
If you have, throw the extra System Folder away.

1. Drag the extra System Folder from the program folder
to the Trash.

2. Choose Empty Trash from the Special menu.

A message alerts you that you're about to throw away the
contents of the Trash (in this case, the extra System Folder).

3. Click OK to confirm that you want to throw away the
contents of the Trash.

4. Close the window by clicking its close box.
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Chapter 5

Learning More Before you begin

Make sure that your computer is on.

AbOUt Your ComPUter This short chapter introduces you to the Battery desk accessory

and the PowerBook control panel, with which you can monitor
In this chapter and control your computer’s power consumption.

= How to open the Battery desk accessory This chapter also tells you where to find answers to other

questions you may have about your computer.
= How to open the PowerBook control panel

= How to use the Balloon Help system

m  Where to look for information about your computer and
its software
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Open the Battery desk accessory

The Battery desk accessory tells you approximately how much
power is left in the battery as you use the computer.

To open the Battery desk accessory:

m  Choose Battery from the Apple (@) menu.

About This Macintosh...

% Alarm Clock
Calculator

= Chooser

Control Panels

You can leave the Battery desk accessory open to keep track of
the battery charge while you work. The desk accessory works like
a fuel gauge (the solid bars indicate how much power is left).

IEEE TR

For more information on how to use the Battery desk accessory,
go to the power management chapter in Part III of this book.
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Open the PowerBook control panel

The PowerBook control panel lets you control the balance
between power consumption and system performance (it also lets
you control other PowerBook features).

To open the PowerBook control panel:

1. Choose Control Panels from the Apple (&) menu.

About This Macintosh...

@ Alarm Clock
i Battery
Calculator

‘% Chooser

[z Control Panels [
Key Caps



2. Open the PowerBook icon.

—

—1—]

PowerBook

(Click the icon once to select it, then choose Open from the
File menu. Or double-click the icon.)

The PowerBook control panel appears. You drag the Battery
Conservation slider to the left to improve performance (but
battery power is used up more quickly) or to the right to

conserve power (but the computer may work more slowly).

[[=———— PowerBook

Battery Conservation
-+
Mazxcirnum

Performance

Mazxirnum
Conserwation

For more information on how to use the PowerBook control
panel, go to the power management chapter in Part III of this
book.

Use Balloon Help

Balloon Help explains icons, menus, commands, and other
objects on the Macintosh screen, using balloons similar to those
in comic strips. Each balloon points to the object it explains.

Many Macintosh programs also have Balloon Help.

Turn on Balloon Help

1.

Point to the Help icon near the right end of the
menu bar.

Press to pull down the Help menu.

Drag to highlight the Show Balloons command,
then release the trackball button.

L_

About Balloon Help...

Show Balloons

Finder Shortcuts

When Balloon Help is turned on, balloons containing
explanatory text appear next to objects that you point to
on the screen.

continues »
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4. To show a balloon describing your startup hard disk, Turn off Balloon Help

point to the hard disk icon. _
Balloons can block items on the screen as you work, so you may

A balloon appears next to the icon. Balloons do not affect how wish to turn them off when you're finished reading.
you work with your computer. You still select icons, choose

commands. and so on. »  Choose Hide Balloons from the Help menu.

5. Click your hard disk icon to select it.

You can select the icon even with the balloon showing. About Balloon Help .

6. Point to the File menu.

Hide Balloons

A balloon appears next to the menu title. Finder Shortcuts

7. Press to pull down the File menu.
The balloon disappears when you pull down the menu. (Point to the Help icon in the menu bar, press to pull down
8. Slowly drag to highlight the Open command, and then the Help menu, drag to highlight the Hide Balloons
release the trackball button. command, and then release the trackball button.)

Notice that a balloon appears next to a command if you pause
briefly as you drag past it.

The hard disk window becomes the active window. To see
more balloons, you can point to different parts of the window
and to different icons in the window.
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Use Part III of this book

Part III of this book, Macintosh Reference, contains all the
information you need to use your computer’s hardware and
system software. Unlike Parts I and II, which are meant to be read
from beginning to end, Part III is meant to be used like an
encyclopedia: you turn to it when you need to look up some
information, and read only that information.

To help you find the information you need, this book has a
table of contents and an index. The back of the book also has
a summary of commonly used skills, and a troubleshooting
section.

What next?

Congratulations. If you've gone through the Macintosh Basics
tour and Parts I and II of this book, you've seen and practiced all
the basic skills you need to use your computer productively.

At this point, you could

m check your battery’s charge and recharge it if necessary (see
the power management chapter for more information)

m start learning how to use your application programs

» turn to Part IIT and find out how to organize your files or how
to adapt your computer to your own use

m turn to any other topic in Part III that interests you

n take a break
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Chapter 6

Setting Up Your Programs

In this chapter

Reinstalling system software

Installing your programs

Working with several programs at a time
Using the Scrapbook

Using a RAM disk

Reminder: Back up

If you didn’t back up your computer’s hard disk as described in
Chapter 1, remember to do so soon. You will need the backup
copy if you ever need to reinstall system software.

Reinstalling system software

System software is the set of programs and other files that your
computer uses to start itself up, keep track of your files, and run
the application programs you use. When you turn on your
computer, it looks for a disk that contains the system software,

which is always in a folder called the System Folder. Any disk that
contains a System Folder with system software inside it is a startup

disk. The startup disk is usually the hard disk that’s inside your

computer, though another hard disk or a floppy disk can also be a

startup disk.

If your Macintosh cannot find a startup disk, it displays this icon in

the middle of the screen:

If you see this icon, you need to reinstall system software on your
computer’s internal hard disk from a backup copy. See the section

on restoring information on your hard disk in Chapter 8.
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Installing your programs

Most application programs come on floppy disks, and you install
them by simply copying them from the floppy disks to your hard
disk. Some programs need to be installed in a particular way. If
your program came with specific instructions, follow them.

To use your programs most effectively:

m Put only one copy of each program on your hard disk. Having
more than one copy can lead to problems when you're using
the program.

»  Whenever you copy the contents of a program disk to your
hard disk, be careful not to copy an extra System Folder.
Always check to see what you've copied, and drag any extra
System Folders to the Trash.

»  Keep the original program disk in a safe place. If the program
on your hard disk malfunctions, you can replace it with a fresh
copy from the original disk.
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» Ifa program malfunctions consistently, and installing a fresh
copy does not correct the problem, find out from the software
manufacturer whether your version of the program is
compatible with the system software you're using.

» Put frequently used programs (or aliases for those programs)
in the Apple menu so you can open the programs more
conveniently. See the chapter on adapting your computer to
your own use.

= If you want your computer to open a program automatically
each time it starts up, you can put the program (or its alias)
into the Startup Items folder. See the chapter on adapting
your computer to your Own use.

Installing programs without a floppy disk drive

If you have access to a network, you can connect your computer
to the network and copy programs from a shared disk. See the
chapter on networks.

Remember that the software license agreement for a given
program may limit the number of copies you're allowed to make.



Installing system software from floppy disks

System software is a set of programs that your computer uses to
start up and operate. If you purchased a system software update
kit or have system software on floppy disks or on a shared disk on
the network, use these instructions. To reinstall system software
from a backup you have made, see “Restoring the Information on
Your Hard Disk” in Chapter 8. You do not need to install system
software if you see the Macintosh desktop on your screen when
you turn on the computer.

If you are installing system software over a network, locate and
open the Installer program and start with step 2.

1. Make sure your computer is off. Find the Install disk.
Insert the disk into the floppy disk drive (metal end
first, label side up). Turn on your computer.

After a few moments, you'll see the Welcome box of the
Installer, the program that installs system software on your

hard disk.

. Press the Return key on your keyboard to continue.

The Easy Install dialog box appears. Easy Install puts the
system software that you'll need right away onto your hard

disk.

software.

. Press the Return key again to start installing system

Messages on your screen report how installation is

progressing.

continues »
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4. When the computer prompts you, remove the disk and Checking for computer viruses
insert the next disk the computer requests.
Viruses—programs that damage files or erase disks—can be

introduced into your computer from a floppy disk, from a shared
disk on a network, or from an electronic bulletin board service.

During installation, the computer automatically ejects a disk it
has finished with and requests the next disk it needs. If you're

installing over a network, you won't need to insert disks.
Programs that detect and eliminate viruses are available from user

5. Insert the remaining disks as the computer groups, bulletin boards, and dealers.

prompts you.
You should check for viruses frequently if you exchange disks

or data with other users. Some programs check for viruses
automatically.

6. When you see a message reporting that installation was
successful, press the Return key once more to quit the

Installer program.
m Check all disks—even those in new, unopened commercial

software packages—for viruses before using them or copying
anything from them to your hard disk.

If you see a message saying that installation was not
successful, you need to try again. Follow the instructions on

the screen.
»  Check your hard disk regularly with a virus-detection program

and correct any problems the program finds.

» Since new viruses appear regularly, make sure you have the
latest version of your virus-detection software.
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To avoid compatibility problems, be sure to use only one
virus-detection program at a time.

If your computer is on a network or if you use a modem,
check for viruses each time you copy information from
an outside source.

If you give information to other computer users on disks

or send information electronically, make certain that there are
no viruses on your computer system before distributing the
information.

Make sure that you have a virus-free copy of your System
Folder on floppy disks. Back up your System Folder
immediately after you install new system software—before
you install other software or open any programs.

Working with several programs at a time

You can open as many programs and desk accessories as your
computer’s memory allows.

All open programs are listed in the Application menu at the right
end of the menu bar. The name of the active program (the one
you're using right now) has a checkmark next to it, and its icon
appears in the menu bar.

Shous s

<% TeachTent

‘ Checkmark indicates
the active program

Finding out what programs are open

If you have several programs and windows open, you can find out
which program is active and what other programs are open by
pulling down the Application menu.

i -
Finder ]7 Open programs

The Finder icon

Hide Finder
Hide Oth er{|‘— Commands to hide or

display open windows
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Switching programs

You can switch to another open program or desk accessory
by choosing its name from the Application menu.

If a program’s icon is dimmed in the menu, that means its
windows are hidden. Choosing the program from the Application
menu displays its windows.

You can also switch to another program by clicking in a window
that belongs to an open program, or by double-clicking a program
icon (or the icon of a document that was created with the
program).
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Hiding and showing windows on the desktop

You can hide all windows except those of the active program by
choosing the Hide Others command from the Application menu.

The other programs remain open even though the windows are
hidden. When you switch to another program, its windows are
displayed.

If you want to see all the open windows, choose Show All from
the Application menu.



Changing the amount of memory a program uses

Each program you open sets aside the amount of memory it
needs. (If you don’t have enough memory to open a program, you
need to quit one of the programs already open to free up some
memory.)

On occasion you may want to increase or decrease the amount of
memory a program uses. You increase the amount so you can
open more or larger documents in that program, and you
decrease the amount so you can open more programs at the same
time. You adjust the program’s memory size in its Info window.

1. Quit the program if it’s open, and then click the
program’s icon to select it.

2. Choose Get Info from the File menu.

3. Drag across the box containing the number you want to
change (either “Minimum size” or “Preferred size”).

“Preferred size” must always be larger than “Minimum size.”

4. Type the number of kilobytes (K) of memory that you
want the program to use.

If the program frequently runs out of memory, increase both
the preferred size and the minimum size.

If you want to be able to open more programs, decrease the
minimum size. If you type a size smaller than “Suggested size,”
the program may work more slowly, show other performance
problems, or not work at all.

TeachText Info

Kind -
Size:

Where:

Created:
Modified:
Version:

Comments -

TeachText

System Software

application program

36K on disk (36,735 bytes used)

Hard Disk Café:

Thu 25 Apr 1991, 12:00
Wed 22 Jul 1992, 10:07
7.1, © Apple Computer, Inc.
1985-1991

|:] Locked

~Memory Requirements ...
i Suggested size: 192

K
Minimum size : K
Preferred size: (192 K

The amount of memory the
program needs to open

The amount of memory the program

will use if enough memory is available

5. Close the Info window.

If you make the memory size smaller than suggested, you'll
see a message asking you to confirm your decision. Click
Cancel to avoid problems with the program.
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Using the Scrapbook

You can use the Scrapbook to store text, graphics, sounds, and
other elements that you frequently include in your documents.

Storing items in the Scrapbook:

1. Inyour document, select the text or other element that
you want to store in the Scrapbook.

2. Choose Copy from the Edit menu.
3. Choose Scrapbook from the Apple () menu.

The Scrapbook opens. You can use the scroll bar to see the
different text, graphic, and other elements it contains.

Scrapbook

| The type of
item of
information

The second of seven items displayed
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4. Choose Paste from the Edit menu.

The new element is pasted ahead of the one previously
displayed.

Copying items from the Scrapbook:
1. Choose Scrapbook from the Apple (6) menu.

2. Use the scroll bar to display the item you want to use in
a document.

Choose Copy from the Edit menu.
Open the document you want to use the item in.

Decide where you want to place the element.

S W e W

Choose Paste from the Edit menu.

Deleting items from the Scrapbook:
1. Choose Scrapbook from the Apple () menu.

2. Use the scroll bar to display the item you want to
delete.

3. Choose Clear from the Edit menu.



Using a RAM disk

A RAM disk is a portion of your computer’s memory that you set
aside for use as a temporary storage device. Using a RAM disk
conserves power because the computer uses less energy to access
RAM than to access a hard disk or a floppy disk.

To use a RAM disk, you should have at least 4 MB of RAM in your
computer because memory assigned to a RAM disk is not available
for opening programs.

Choosing Sleep or restarting the computer does not affect a RAM
disk—but if your computer has a built-in floppy disk drive,
choosing Shut Down erases the contents of the RAM disk (but
does not remove the RAM disk itself).

Remember a few precautions if you use a RAM disk:

» Before using a program on a RAM disk, test the program on
your hard disk or a floppy disk to make sure that it works
properly with your computer.

» Don't store your only copy of a file on a RAM disk. Keep a
backup copy on your hard disk or a floppy disk.

Creating a RAM disk
1. Choose Control Panels from the Apple (#) menu.
2. Open the Memory control panel.

The RAM disk portion of this control panel is at the bottom
of the window. If your computer has less than 3 MB of RAM,
this portion does not appear.

E[[E==———"—— Memory = |

Disk Cache
Always On

Cache Size

Select Hard Disk:
Lo Magintgsh €D vl

Virtual Memory

Oon K "Available on disk: 27M

= @ off Available built-in memory : 4M
32-Bit Addressing

Qon

— ® off

Percent of available memory
to use for a RAM disk:

RAM Disk
@ 8 g: . 0% 50% 100%
RAM Disk Size

Use Defaults

v7.0.1

continues »
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3. Click the On button below the words “RAM disk.”

4. Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.

Choose a size just large enough to accommodate the
programs and documents you want to put on the RAM disk.
Don't choose a larger size than you need because memory set
aside for the RAM disk won't be available for opening
programs.

The size of the RAM disk you select appears in the “RAM Disk
Size” box.

5. Choose Restart from the Special menu.

A RAM disk icon appears on the desktop when the computer
restarts.

6. Drag the items you want to the RAM disk icon.

Erasing a RAM disk

There are two ways to erase the contents of a RAM disk. They do
not remove the RAM disk itself or make more memory available
for opening programs.

m Select the RAM disk icon and choose Erase Disk from
the Special menu.

» Drag everything on the RAM disk to the Trash and
choose Empty Trash from the Special menu.
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Resizing or removing a RAM disk

1. Copy any programs or documents that you want to save
onto the internal hard disk or a floppy disk.

If you want to resize a RAM disk, you need to remove its
contents and then restore them.

Drag everything in the RAM disk to the Trash.
Choose Empty Trash from the Special menu.
Choose Control Panels from the Apple (6) menu.
Open the Memory control panel.

AN A

Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.

Drag the slider to 0% if you want to remove the RAM disk.
7. Choose Restart from the Special menu.

If you resized your RAM disk, a new RAM disk icon appears on
the desktop when the computer restarts. If you removed your
RAM disk, no icon appears.

8. Ifyou resized the RAM disk, copy any items you want
back to it.

/\ Important: The contents of the RAM disk are erased when
you choose Shut Down, though the RAM disk itself is not
removed. A



Chapter 7

Power Management

In this chapter

m  Checking the battery level

= Responding to low-power messages
» Recharging the battery

m Removing or replacing the battery
»  Maximizing battery life

= Getting the most work time out of the battery

Monitoring the battery charge level

Your computer’s main power source is a nickel-cadmium battery.
The battery provides power for up to 3 hours of work (the exact
time depends on how often you use the hard disk, how bright the
screen is, and other factors). Use the Battery desk accessory to
monitor the charge level of the battery so you can recharge it
when necessary.

Using the Battery desk accessory

To open the Battery desk accessory, choose Battery from the
Apple (@) menu.

About This Macintosh...

& Alarm Clock
fi Battery

Calculator
3 Chooser
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The Battery desk accessory appears. Responding to low-power messages

When the battery charge drops to about 15%, the computer
[O¢A nmmoono - @ | displays a series of low-power messages. The work time remaining
after you see the first message will vary depending on how you
are using the computer. It's a good idea to act promptly.

The line of rectangles is the battery gauge. Black rectangles
indicate the charge level. You can see the level decrease while the What you should do
battery is in use, and increase while the battery is recharging in When you see a low-power message, do either of the following
the computer.

Plug in th dapt
When you click the lever to the right of the battery gauge, a Sleep = Tluginthe poweradaptes or

button appears. = Save your work and put the computer to sleep.

O A cIIEROOOF ¢ What you should know

S E— Lever

The first low-power message indicates that it’s time to recharge
r4

P 4 the battery. Right after this message appears, the screen
brightness dims automatically to save power.

If you continue to work without plugging in the power adapter;

. . . the computer displays a second low-power message.
You may sometimes find it convenient to put the computer to

sleep by clicking this button, instead of choosing the Sleep
command.
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The second message is followed almost immediately by a third
and final message indicating that the computer is about to put
itself to sleep. When time is up, the computer goes to sleep
automatically to protect the contents of RAM.

If you continue working until the computer goes to sleep
automatically, you may not be able to wake it again until you
recharge the depleted battery in the computer for 15 minutes.

If you can’t plug in the power adapter, the contents of RAM are
retained in sleep for at least 2 days. If you leave the battery in the
computer and recharge it within 2 days, you should be able to
wake the computer and resume work where you left off.

/\ Important: Recharge a depleted battery as soon as possible.
Leaving a depleted battery in the computer for longer than 2
weeks (especially in a hot location, such as the trunk of a car)
may damage the battery so that it can’t be recharged. If this
happens, you need to replace the battery. A

Recharging the battery
There are two ways to recharge:

» Plug in the power adapter to recharge the battery without
removing it from the computer, or

= Remove the battery and recharge it in the (optional)
recharger.

Recharging with the power adapter

Plug in the power adapter as shown.

Power adapter port
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A Warning: Use only the power adapter that came with your
computer. Adapters for other electronic devices (including
other portable computers) may look similar, but they may
damage your computer. A

A lightning bolt icon appears in the Battery desk accessory when
the power adapter is plugged in and the battery is recharging. The
lightning bolt icon disappears when recharging is about 85%
complete, though recharging continues. The icon appears even if
the power adapter is plugged into the computer only, so make
sure the adapter is plugged into both the computer and an
electrical outlet.

[ O h e RERROOOO F 3 |

Lightning bolt icon
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You can continue to use the computer while the battery is
recharging, but the battery will take longer to recharge if you do.
Battery recharging time while the computer is in use depends on
how often you use the hard disk, how bright the screen is,
whether you are using an external monitor, how deeply the
battery is depleted, and other factors.

If you are using several of your computer’s power-consuming
features (such as an external monitor and a program that requires
frequent hard disk access), and you are not using the features
designed to conserve power (such as processor cycling), the
battery may not recharge until you put the computer to sleep or
shut it down.

If you recharge a fully depleted battery with the computer shut
down, it takes about 2—3 hours to bring the battery to 80% of its
capacity. It takes several more hours to bring the battery charge to
100%.

While the computer is shut down and the power adapter is
plugged in, you can remove a charged battery from the computer
and replace it with a battery you want to charge. If you do this,
disconnect and then reconnect the power adapter after inserting
the second battery (otherwise the second battery will not
recharge).



Recharging with a recharger

A battery recharger and additional batteries are available as
options for your computer. If you purchase a recharger and an
extra battery, you can charge one battery while you use the other,
s0 you always have a fully charged battery on hand.

The recharger can accommodate two batteries. The battery slots
work independently, so you can put batteries in or take them out
at different times.

The recharger must be plugged into an electrical outlet to charge
a battery. You can plug it in using the power adapter that came
with your computer, or you can purchase an additional (identical)
power adapter from your authorized Apple dealer.

A Warning: Do not use any other type of power adapter with
the recharger. Doing so may damage the recharger, the power
adapter, or both. A

To recharge a battery, follow these steps.
1. Place the recharger on a level surface.

2. Connect the recharger and the power adapter as shown
in the illustration.
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3. Place the battery in the recharger as shown.
Recharging begins immediately. You can remove a battery
from the recharger at any time.

/\ Important: To preserve a battery’s charge, don’t leave it in
the recharger if the power adapter is not plugged into an
electrical outlet. A

The lights on the recharger indicate the following:

»  No light: The recharger is not plugged in, or the battery is
defective. (If the light goes off during recharging, there is a
problem with the battery.)

»  Yellow: The battery is charging.

m Green: The battery is charged to at least 80% of its capacity,
and can be used.

The table shows approximate recharging times for fully depleted
batteries.

80% charge 100% charge
In the recharger:
1 battery 2.5 hours 5 hours
2 batteries 5 hours 10 hours
In the computer (shut down): 2-3 hours 6-8 hours

106 Chapter 7: Power Management

Removing or replacing the battery

Don't attempt to use your computer without a battery (even when
the power adapter is plugged in).

To remove or replace the battery, follow these steps.

1. Save your work, and then choose Shut Down from the
Special menu.

2. Close the display.

3. Open the battery door by sliding the door in the
direction indicated by the arrow.

The door is physically attached to the battery.




4. Carefully pull the battery out of its compartment.

5. Ifyou are inserting another battery, slide it into the
battery compartment.

Replacement batteries come with a door attached.
6. Close the battery door by pushing it back into place.

7. If you just inserted a new battery, it’s a good idea to
plug in the power adapter in case the battery is not
fully charged.

A\ Important: Nickel-cadmium batteries contain metals which
are hazardous when released to the environment. It is
inappropriate, and in some cases unlawful, to throw batteries
away with your household or business trash. Instead of
throwing away your spent batteries, dispose of them as
described here.

In the United States: Return spent batteries to your
authorized Apple service provider, who will make sure they
are included in Apple's battery recycling program.

Elsewhere: Many locations have government or Apple-
sponsored collection and/or recycling programs for spent
batteries. Dispose of spent batteries in accordance with the
mandatory or voluntary battery collection schemes in your
location. Contact your authorized Apple service provider for
information about the recommended battery disposal
procedures in your area. A

Warning: Damaged nickel-cadmium batteries may leak
small amounts of potassium hydroxide. This substance can
cause severe burns to the skin and eyes. If you touch a
damaged battery, immediately wash your hands and any
other affected areas with water for at least five minutes.
Do not use soap. A
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Maximizing battery life

To maximize battery life, discharge and then recharge the battery
completely once every 90 days. Just use the computer as you
normally would, but ignore the low-power messages that appear
on the screen. (Make sure to save your work, however.) When the
computer goes to sleep automatically, recharge the battery
completely before using that battery again. You can do this in
either of two ways:

m Leave the battery in the computer, plug in the power adapter,
and let the battery recharge overnight, or

= Remove the battery from the computer and recharge it in a
recharger for 5 hours (if you are recharging just one battery)
or 10 hours (if you are recharging two).
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Your battery will last longer if you recharge it at or slightly below
room temperature.

With proper care you can expect your battery to last for at least
ayear. If you notice that the battery no longer holds a charge for
as long as it should, you may need to replace it.



Maximizing work time

Your PowerBook’s battery can provide up to 3 hours of work time
before you need to recharge it. The actual work time available
depends on what equipment you're using with your computer
and what steps you take to conserve power while you work.

Ways to conserve battery power

The more of these steps you take, the longer you can use your
battery before recharging it.

» Turn down the screen brightness whenever possible. At its
brightest level, the screen consumes about a third of the
power your computer is using.

= Adjust the battery conservation settings in the PowerBook
control panel for maximum conservation: set the battery
conservation slider at Maximum Conservation; keep processor
cycling turned on. The rest of this section describes these
settings in detail.

Keep virtual memory turned off in the Memory control panel.

Quit any program that uses a modem unless you're using the
program for telecommunication. As long as the program is
open, your modem is consuming power.

If you're working near an electrical outlet, plug in the power
adapter.

If you aren’t using the computer, put it to sleep and plug in
the power adapter.
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Adjusting the battery conservation settings

The Battery Conservation section of the PowerBook control panel
gives you several ways to regulate your computer’s power
consumption.

The easiest approach

Just use the Battery Conservation slider to choose the setting you
prefer.

1. Choose Control Panels from the Apple (#) menu, and
open the PowerBook control panel.

2. In the Battery Conservation box, drag the slider to the
setting you want.

[[&===—————= PowerBook gl

Battery Conservation
=
Maximum

Performance

Maximum
Conservation

There are four settings along the scale. If you're trying to
meet a deadline, Maximum Performance allows you to work
with the fewest interruptions. If you don’t have a power
adapter with you, Maximum Conservation gives you the
longest work time.

When you change the setting, the new setting takes effect
immediately.
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3. Close the PowerBook control panel.

You can think of the battery conservation setting as an automatic
sleep setting. If you don't use the computer for several minutes
(how many depends on which setting you choose), it goes to
sleep without any action on your part. A computer in sleep has a
darkened screen and appears to be off; though it is still drawing
battery power at a low level.

To put the computer to sleep before the automatic sleep setting
takes effect, choose Sleep from the Special menu.

To wake the computer from sleep, press any key (except Caps
Lock).

Automatic sleep does not take effect under any of the following
circumstances:

»  The AppleTalk software is turned on in the Chooser and the
power adapter is plugged in. (Automatic sleep does take effect
if the power adapter is not plugged in.)

= Your computer is connected to a shared disk on the network.

= Your computer’s printer or modem port is in use.



More about automatic sleep

The Battery Conservation slider controls two different power
conservation features: system sleep and hard disk sleep.

m  System sleep is a state in which your computer uses only the
power it needs to maintain the contents of RAM. (The
contents of RAM include any open programs and documents,
and various control panel settings such as the clock time.)

» Hard disk sleep stops your computer’s internal hard disk from
spinning when it isn't being used.

If system sleep is in effect, so is hard disk sleep.

The table indicates how the battery conservation settings
correspond to sleep times.

Minutes before sleep if you choose:

Performance Conservation
System 15 8 4 1
Hard disk 15 4 2 0.5

Using the battery conservation options

The Battery Conservation section of the PowerBook control panel
includes a button labeled Options. Click this button to see more
options that affect your computer’s power consumption.

Battery Conservation Options

[ Don't sieep when plugged in

Processor Cycling

@® fAllow cycling (more battery savings)
QO Don't allow cycling

Processor Speed
@ Standard speed
O Reduced speed (more battery savings)

(o)

Don't sleep when plugged in

If the power adapter is plugged in, you can prevent automatic
sleep by clicking “Don’t sleep when plugged in.”
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Processor cycling

If the computer is not doing anything for a few seconds, it
reduces the power consumption of its microprocessor. The
microprocessor comes back up to speed instantaneously when
you resume work. This feature is called processor cycling.

You don’t need to do anything to use the processor cycling
feature. But if you notice that one of your programs performs very
slowly, you might want to turn off processor cycling while using
that program.

To turn off processor cycling, follow these steps.

1. Choose Control Panels from the Apple menu, and open
the PowerBook control panel.

2. Click the Options button.
3. Click “Don’t allow cycling.”

Processor Cycling
O Allow cycling (more battery savings)
@ Don't allow cycling
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4. Close the PowerBook control panel.
To turn processor cycling back on, click “Allow cycling.”

You may notice other effects of processor cycling. For example,
if you have open programs doing something in the background,
processor cycling may slow those programs down. You may also
notice that the Alarm Clock is updated irregularly or that the
wristwatch pointer appears more often. These changes do not
indicate a problem with your computer.

When you turn processor cycling off, the computer drains the
battery faster. The computer may also become very warm to the
touch, especially on the side beneath the keyboard. These
changes do not indicate a problem with your computer. However,
you should keep processor cycling turned on whenever possible.

/\ Important: To conserve battery power, turn processor
cycling off only when using programs that it interferes with.
Turn processor cycling back on again as soon as possible. A



Chapter 8

USiﬂg Disks Preparing a new disk for use

Before you can use a new disk, you need to prepare it so the
In this chabter computer knows where to store information on the disk. This
p preparation is called initializing (or formatting) the disk.

m  Preparing a new disk for use

« Note: You don't need to initialize the floppy disks that are
used for backing up your system. The PowerBook 145B

m  Choosing a startup disk Backup program initializes them for you automatically. <

»  Erasing a disk

= Protecting the information on a disk The hard disk inside your computer is initialized at the factory,

»  Restoring the information on your hard disk but you need to initialize new 3.5-inch (89-millimeter) floppy
disks that tt in a floppy disk drive.

» Ifyou can't save files on a floppy disk 155 Hhal you weiit S use 1  foppy tisk (Lve
= Fjecting a disk Initializing a hard disk

= Caring for disks Occasionally a hard disk may become damaged in such a way that

» Testing and repairing disks you have to reinitialize it. (The key symptom of such damage is
that the hard disk’s icon does not appear on the desktop when
you start up the computer using another disk.) You lose all the
information on a damaged disk when you reinitialize it.

If your hard disk’s icon does not appear on the desktop, first try
to repair it as described later in this chapter. If you can’t repair the
disk, use the Apple HD SC Setup program to reinitialize the disk.
The program is on the Disk Tools disk that came with your
computer.
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. Insert Disk Tools and turn on your computer.

. Locate the Apple HD SC Setup icon and open it.

ey
—

Apple HD SC Setup

The name of the hard disk currently selected is shown as the
“volume name.” The SCSI ID number of the selected hard
disk is displayed above the Drive button. (The ID number of

an internal hard disk is 0.)

. Click Drive until the disk you want to initialize appears.

Apple HD SC Setup

Update

SCSI Device: 0 ——

Partition

Test

i

Quit

The volume name is Hard Disk—

[0

| The hard disk's
SCSI ID number

| The hard disk’s
name
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You cannot initialize the disk that you used to start up your
computer or the disk that contains the Apple HD SC Setup
program.

. Click Initialize.
. Click Init to initialize the hard disk.

. If a message appears asking you to name the disk,

type a name and then click OK.

. Click Quit when you see a message reporting that

initialization was successful.

If a message reports that initialization failed, try again.
If initialization fails a second time, take the disk to your
authorized Apple service provider for repair.



Initializing a floppy disk

Initializing a new floppy disk prepares the disk to store
information.

1. Insert a new floppy disk into your floppy disk drive.

If you inserted a high-density disk (1.4 MB), this message
appears:

This disk is unreadable:
e
Do you want to initialize it?

If you inserted a double-sided (800K) disk, this message
appears:

This disk is unreadable:
==

Do you want to initialize it?

{( Eject ]} (one-sided] (Two-sided]

2. Ifyou inserted a high-density disk, click Initialize.
If you inserted a double-sided disk, click Two-Sided.

A message alerts you that you're about to erase any
information that may be on the floppy disk. A new floppy disk
has no information on it.

3. Click Erase.

A third message asks you to name the disk.

Please name this disk:
=%

4. Type a name for the disk.

If you don’t name the disk, the computer gives it the name
“Untitled.”

5. Click OK.

The computer takes about a minute to initialize the disk.
When initialization is finished, the icon of the floppy disk
appears on the desktop.
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Erasing a floppy disk

Erasing a disk actually reinitializes it.

A Warning: When you erase a disk, you lose any information
that was on the disk. A

1. Click the icon of the disk you want to erase.

2. Choose Erase Disk from the Special menu.
A message appears.

3. Depending on the type of disk you're erasing, click
Initialize or Two-Sided.

The computer takes about a minute to erase the disk.
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Designating a startup disk

If you use more than one hard disk with your computer, you can
specify which hard disk you want the computer to use as the
startup disk. (A startup disk must have a System Folder on it that
contains the correct version of the system software.)

If you don’t specify a startup disk, your computer uses its internal
hard disk as the startup disk (if it has a System Folder).

1. Choose Control Panels from the Apple (&) menu.
2. Open the Startup Disk control panel.

3. Click the icon of the disk you want to use as the startup
disk.

[EC== startup Disk =—=

Select a Startup Disk:

BN (e
Hard [rizh Fonseca

4. Close the Startup Disk control panel.



Scanning order for startup disks

When you turn on your computer; it looks for a startup disk
(a disk containing a System Folder) in the following sequence:

1. internal floppy disk drive (if any)
2. external floppy disk drive (if any)
3. disk (or RAM disk) selected in the Startup Disk control panel
4. internal hard disk
5

. external hard disk (if there is more than one, it looks first at
the hard disk with the highest SCSI ID number)

6. internal hard disk (the computer returns to this drive and
waits another few seconds)

If the computer does not find a startup disk, it displays a blinking
question mark in the middle of the screen.

To bypass the internal hard disk in the scanning sequence, press
-Option-Shift-Delete while the computer starts up.

/\ Important: If you use an external hard disk, turn it on and
wait a few seconds before you turn on your Macintosh, or the
computer may not recognize the disk. A

Protecting the information on a disk

The information on a locked floppy disk or in a locked file can be
opened or copied but cannot be changed.

Locking a floppy disk

= Slide the tab on the back side of the disk so that the square
hole is open.

Use your thumbnail, a push pin, or a similar object to move
the tab.

Locked Unlocked

To unlock the disk, slide the tab back so that it covers the
square hole.
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Locking a file

You use the Get Info command to lock a document or a program.
Locking a program may affect its operation.

1. Click the icon of the file you want to lock.
2. Choose Get Info from the File menu.

3. In the Info window, click the Locked box in the
lower-left corner.

E[I==== From Amy Info

N
From Amy

Kind : TeachText document
Size: 1K on disk (161 bytes used)

Yhere: J’s disk: From Amy

Created:Mon, Oct 8, 1991, 10:33 PM
Modified:Mon, Oct 8, 1991, 10:35 PM
Version:n/a

Comments -

m Locked |:] Stationery pad
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4. Close the Info window.

To unlock the file, click the Locked box again (so the X
disappears).

You can't lock a folder, but you can lock items in a folder.

Locking an alias does not lock the original file. Locking an alias
merely protects it from being thrown away.



Backing up your files

You can back up the work you store on a hard disk by copying
individual files onto another disk in the usual way (dragging their
icons to the icon of the other disk). You can back up the contents
of an entire floppy disk by dragging its icon to another floppy disk
icon or a hard disk icon.

Use the application program called PowerBook 1458 Backup to
copy the entire contents of your Macintosh hard disk onto floppy
disks. Keeping this backup copy up to date will protect you in
case information on your hard disk is accidentally lost or
damaged.

You should update your backup copy at least once a month, and
in between full backups you should store copies of important
documents on floppy disks. It’s a good idea to keep two sets of
backup copies, and to alternate between them (using one set one
month, and the other the next) when updating your backup copy.
This protects you from losing your files in case something goes
wrong with one set of disks.

You can also purchase a backup program with additional features
that make copying faster. (For example, some programs have a
feature that lets you copy only the new and changed information
on your hard disk.)

If something happens to the information on your hard disk, you
can use the backup copy you made to put the information back
onto your hard disk. To do this, you use the PowerBook 145B
Restore program that came with your Macintosh. See “Restoring
the Information on Your Hard Disk” later in this chapter.
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Using PowerBook 145B Backup for the first time 3. Click the appropriate button.

When you use the PowerBook 145B Backup program for the first n  The first time through, click Copy System Folder.
time, you should make a copy of your System Folder, and then a Th dii , -

time through, click Copy All Files.
copy of all the files on your hard disk. Follow these steps: - © second tiime throtigh, click Lopy A% HIEs
4. 1 high-density fl disk into the disk drive.
1. Open the PowerBook 145B Backup program by double- nsert a high-density floppy disk into the disk drive

clicking its icon. 5. Follow the instructions on the screen until a message

tells you that you're finished. As you remove each disk

from the computer, label it so you can find it again

@ later.
6. Repeat steps 1-5 and make a backup copy of all files on
PowerBook 145B Backup your hard disk.

7. When you're finished, be sure the floppy disks are
properly labeled and locked, then store them in a safe,

The PowerBook 145B Backup program opens.
cool place.

2. Make sure your floppy disks are high-density. Then
click the Continue button.

A message appears, telling you how many high-density disks
you need to make the copy and approximately how long it will
take. Make sure you have enough time and disks to complete
the copying. If you stop the copying before it’s finished, you'll
have to start over again from the beginning.
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Using PowerBook 145B Backup to update your
backup copy

Keeping your backup copy up to date will protect you in case
information on your hard disk is accidentally lost or damaged. You
can use the floppy disks that contain a backup copy of all the files
on your hard disk.

Don't update your backup copy of the System Folder. Save this in
case you need to reinstall system software.

To use PowerBook 145B Backup to update your backup copy,
follow these instructions:

1. Get the floppy disks that you used to make a previous
backup copy.

Have some extra high-density disks on hand in case there is
more information on your hard disk than there was the last
time you made a copy.

2. Turn on your Macintosh, if it’s not already on.

3. Open the PowerBook Backup 145B program by double-
clicking on its icon.

o

PowerBook 145B Backup

The PowerBook 145B Backup program opens.

PowerBook 145B Backup H
[0 T]

I1t’s important to make a copy of what’s on your hard
disk, in case items are accidentally lost or damaged.

This program requires high-density floppy disks.

You can safely stop the backup at any time, without
affecting your hard disk.
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4. Make sure your floppy disks are high-density. Then
click the Continue button.

A message appears, telling you how many high-density disks
you will need to copy all files on your hard disk, or to copy
just the System Folder. It also tells you approximately how
long it will take to make the copy.

5. Click the button that corresponds to your choice.

Make sure you have enough time and disks to complete the
copying. If you stop the copying before it’s finished, you'll
have to start over again from the beginning.

6. Unlock the disk labeled 1.

To unlock the disk, turn the disk label-side down and use a
pen or your fingernail to slide the tab in the lower right
corner of the disk so that it covers the square hole. (The disk
has two square holes, but only one of them has a tab.)
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7. Insert the disk into the floppy disk drive.

If you did not unlock the disk correctly, it is ejected and a
message appears. Unlock the disk, making sure that the tab
snaps into place, and try again.

A message appears, telling you that the disk contains
information. If you click the Continue button, all the
information currently stored on the disk is erased.

8. Click the Continue button.

If there is a problem with the disk, a message appears.
Otherwise copying takes place automatically. A sound alerts
you when it’s time to insert another disk.

9. When the first disk is ejected, repeat steps 7 through 9
for the next disk in your stack of backup disks. Be sure
to lock and label the disks as they are ejected.

10. The PowerBook 145B Backup program lets you know
when you're finished. Be sure to store the disks in a
safe, cool place.



Restoring the information on your hard disk

If information on your hard disk becomes damaged or lost, you
can restore it if you have a backup copy of the information. You
can use the program called PowerBook 145B Backup that came
with your Macintosh to make a backup copy of the information on
your hard disk. The program called PowerBook 145B Restore can
put that information back on your hard disk.

You can also use PowerBook 145B Backup to make a copy of your
System Folder (the folder that contains the software the
Macintosh uses to operate). If your Macintosh does not start up
any more, replacing the System Folder may solve the problem.
You can use PowerBook 145B Restore to replace the damaged
System Folder on your hard disk.

For instructions on using PowerBook 145B Backup, see
“Protecting the Information on a Disk” earlier in this chapter.

/\ Important: If at any time during restoring, you see a
message reporting that the hard disk is damaged or
unreadable, turn to “Testing and Repairing Disks” later in this
chapter. A

To restore information from your backup floppy disks to your
hard disk, follow these steps:

1. Get the floppy disk labeled Disk Tools that came with
your computer and the floppy disks that you used to
back up your hard disk.

2. Make sure your Macintosh is off.

3. Insert the Disk Tools floppy disk into the floppy disk
drive, then turn on your Macintosh.

4. Locate the PowerBook 145B Restore icon.

5y

PowerBook 145B Restore

continues »
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5. Open the PowerBook 145B Restore icon by double-
clicking it.

In a moment you'll see this screen:

PowerBook 145B Restore

If you used PowerBook 145B Backup to make a copy of
what’s on your hard disk, you can use PowerBook 145B
Restore to copy items back to your hard disk in case of
a problem.

Youw’ll need the set of disks that you made with
PowerBook 145B Backup.

6. Read the information on the screen and click the
Continue button.
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7. Insert the backup disk labeled 1.
Restoring proceeds automatically.
8. Respond to any messages you see on the screen.

If PowerBook 145B Restore finds an item on your hard disk
that is newer than an item with the same name on the floppy
disk, you are asked whether you want the older version of the
item to replace the newer version. Click the choice you want.
If you think the item on the hard disk may be damaged, you
should replace it.

9. Repeat steps 7 and 8 for the next disk in your stack of
backup disks.

Make sure you insert disks in the correct order.

10. The PowerBook 145B Restore program lets you know
when you are finished. Store your backup disks in a
safe, cool place.

11. Restart your Macintosh and make sure that everything
is back on your hard disk.

If the Macintosh still does not start up or your hard disk still
does not work properly, see “Testing and Repairing Disks”
later in this chapter. If you are able to repair the disk, then try
again to restore the information on your hard disk.



Restoring your System Folder

If your Macintosh does not start up any more, replacing the
System Folder may solve the problem. If you used PowerBook
145B Backup to make a backup copy of your System Folder, you
can use PowerBook 145B Restore to replace the damaged System
Folder on your hard disk with a fresh copy from your backup
disks.

To restore the System Folder to the hard disk, follow the
instructions in the section “Restoring Information on Your Hard
Disk,” using floppy disks containing a backup copy of your System
Folder.

If you can’t save files on a floppy disk

If you can’t save files on a floppy disk, the disk may be locked, full,
or damaged, or the disk drive may not be working properly. Try
the following:

Make sure the tab on the back of the disk is in the unlocked
position (the square hole should be closed).

If you see a message reporting that the disk is full, erase
unneeded files from that disk, or save on another disk.

If you see a message that the disk is not initialized, and you
know that it has been initialized, eject the disk and carefully
insert it again. If the same message appears, the disk is
probably damaged. You may be able to recover its information
with Disk First Aid or another disk-recovery program. (See the
section on testing and repairing disks in this chapter.)

Check the disk for obvious damage to the plastic case or the
sliding metal shutter.

Insert a different disk and try saving again. If you can’t save on
the second disk, the disk drive may be damaged. Take the disk
drive to your authorized Apple service provider for repair.
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Ejecting a disk If you can't eject a floppy disk

You can eject a floppy disk by doing any of the following: If you can't eject a floppy disk in the usual way, try the following in

order:

Click the disk icon to select it and choose Put Away from the
File menu.

The disk is ejected and its icon disappears from the desktop.
Drag the disk icon to the Trash.

The disk is ejected and its icon disappears from the desktop.
(Dragging a disk to the Trash does not erase the disk’s
contents.)

Click the disk icon to select it and choose Eject Disk from the
Special menu.

1. Hold down the 8 and Shift keys and press the number 1 key

on your keyboard to eject a disk in an internal disk drive;
press #-Shift-2 to eject a disk in an external disk drive.

. Turn off the Macintosh. If the disk isn’t ejected, then hold

down the trackball button while you turn the computer on
again.

. Locate the small hole near the disk drive’s opening, and

carefully insert the end of a large straightened paper clip into
it. Push gently until the disk is ejected. Do not use excessive

force.
The disk is ejected and its dimmed icon remains on

the desktop.

You can use the first two methods to remove a hard disk icon
from the Macintosh desktop (provided that it’s not your startup

disk), or to disconnect from a shared disk on the network.

\
All three methods also work with CD-ROM discs. )

4. 1If nothing works, take the computer or disk drive to your
authorized Apple service provider to have the disk removed.
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Caring for disks

For information on floppy disk care, see the section on working
with disks in Part II of this book, or consult the instructions that
came with your floppy disks.

Hard disk precautions

Hard disk drives are delicate mechanisms and should be handled
with care.

Do not bump, jar, or move your computer while the hard disk
is in use. If you need to move the computer, wait until the
hard disk stops spinning.

Do not spill any liquids on or near the hard disk.

Do not expose the hard disk to hazardous vapors, such as
those from cleaning solvents.

Testing and repairing disks

Both floppy disks and hard disks can become damaged by
repeated use and handling. If you see a message reporting that
a disk is damaged or unreadable, you can use Disk First Aid or
Apple HD SC Setup to try to diagnose and correct the problem.
Both programs are on the disk called Disk Tools that came with
your computer.

If a hard disk icon doesn’t appear

If you can’t start up from a hard disk or don’t see its icon on the
desktop, try the following:

» If the hard disk is internal, shut down your Macintosh, wait at
least 10 seconds, and then turn it on again.

» If the hard disk is your startup disk, start up with a different
disk. If the hard disk’s icon appears on your desktop, reinstall
the System Folder on the hard disk using your backup copy.

continues »
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If the hard disk is external, make sure it is turned on and its
cable is connected firmly; then restart the Macintosh.

Check the ID numbers of all SCSI equipment connected to
your computer. Each device must have a unique ID number
(the computer itself has the ID number 7, and the internal
hard disk has the number 0). Also check that the chain of
devices is terminated properly. (See the chapter on enhancing
your computer system for information about setting SCSI ID
numbers and checking termination.)
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Using Disk First Aid

You can use the Disk First Aid program to test floppy disks
and hard disks that may have been damaged. Disk First Aid
also repairs some types of disk damage. Disk First Aid is on the
Disk Tools disk that came with your computer.

1. Insert Disk Tools and start up your computer.
2. Open the Disk First Aid icon.

o)

Disk First Aid



. Click the Drive button until the name of the disk you
want to test appears. Click the Eject button if you want
to insert a different floppy disk.

. Click Open.

. Choose Repair Automatically from the Options menu.

& File Edit Bty
Repair Automatically
Ready to sf Erase Disk...

Uolume: Archives

6. Click the Start button to begin testing the disk.

7. When testing and repair are finished, choose Quit from

the File menu.

If you want to test another disk, choose Close from the File menu,
then select and open another disk (repeat steps 3—7).

If Disk First Aid cannot correct the problem:

Try repairing the disk again. Sometimes repeating the process

corrects the problem.

Use another disk repair or recovery program. Some disk
repair programs let you recover information from a damaged

disk.

Consult a specialist for help.

Once you have recovered all the information you can, erase
(reinitialize) the disk. If initialization doesn’t work, discard the
damaged floppy disk, or take the hard disk to your authorized

Apple service provider for repair.
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Testing a hard disk 4. Click Test.

You can test a hard disk with the Apple HD SC Setup program, 5. When a message tells you that testing is complete, click

which is on the Disk Tools disk that came with your computer. Quit.

If the test reveals a problem, you may be able to correct it
. by using Disk First Aid or another disk repair program, or you
2. Open the Apple HD SC Setup icon. may have to reinitialize the disk. Consult a specialist

for assistance if necessary.

)

Apple HD SC Setup

1. Insert Disk Tools and start up your computer.

3. Click the Drive button until the disk you want appears.

Apple HD SC Setup

SCSI| Device: 0 —f—— Th€ hard diSk'S
SCSIID number
I Quit '

| The hard disk’s name

The volume name is Hard Disk —

[0

130 Chapter 8: Using Disks



Chapter 9

Organizing Your Files

In this chapter

Straightening up your files

Using folders to organize your files
Filing documents when you save them
Making items easier to find

Finding an item

Creating a template or stationery
Getting information about your files
Assigning a label to a file

Tips on transferring files

Straightening up your files

To accomplish this... Do this. ..

Straighten up all icons in
the active window

Choose the Clean Up command
from the Special menu

Straighten up selected Hold down the Shift key
icons only while choosing Clean Up
Arrange icons alphabetically Hold down the Option key

by name, or by the
list view displayed most
recently in that window

while choosing Clean Up

Line up icons near the right
edge of the desktop

Click the desktop, then hold down the
Option key while choosing Clean Up

You can also have icons arrange themselves in a staggered grid
when you choose Clean Up. See the chapter on adapting your
computer to your own use.
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Using folders to organize your files

Macintosh folders, like the paper folders in a file cabinet, can be
used to store and organize your work. You can place one folder
inside another to create a hierarchy of files.

Hard disk

L)

Budgets \ Proposals

Feasibility Résumés
studies

Draft 11 Draft 21 Draft 37

Issues
list
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Creating and naming folders

You can create a new folder whenever the Finder is the active
program.

1. Choose New Folder from the File menu.

A new folder appears in the active window (or on the desktop
if no window is active). The name is already selected.

2. Type a name for the folder and press Return.

If this doesn’t work, click the folder’s name to select it, and
try again.
You move, copy, and remove folders in the same way that you do
other icons.

Many programs also let you create and name a new folder in the
dialog box that appears when you save a document.



Filing documents when you save them

The first time you save a document (or whenever you choose Save
As to create another version of that document), a directory dialog
box appears. A directory is the list of files and folders contained in

a folder or on a disk.

This directory lists the
contents of the folder or
disk named above it.
Double-click a folder to see
its contents.

Type a name for your

Use this pop-up menu to see the
directory of a higher-level folder
or disk.

You use this box to name your document and indicate where
to store it. Directory dialog boxes vary slightly from program
to program, but all share certain features.

The disk that contains the directory
that's currently displayed.

[ Macintosh HD¥ |

0 finnual vepart 93

O Application Programs
0 oart farm

O art samples

D Botsy 8728796

0 Bagk list

Save this document as:

document here.

Modest Proposal |

> Macintosh HD

i

2 Click to see the items on the Macintosh

Desktop desktop, including other disks.

New ()

Click to create a new folder in the
directory that’s currently displayed.

i

Cancel

Click to save your document
in the directory that’s currently

Save

displayed.
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Making items easier to find

Your Macintosh provides several ways to make a file, folder,
or other item easy to find and open. You can

create aliases for the item and put the aliases in convenient
locations

install the item (or its alias) in the Apple (@) menu

move the item (or its alias) to the desktop

Creating an alias

An alias represents and points to a file, folder, disk, or other item
(even a shared item on a network). You can make as many aliases
for an item as you want.

1.
2.

Click to select the item you want to make an alias for.
Choose Make Alias from the File menu.
The name of the alias appears in italics and ends with “alias.”

If you wish, type a new name for the alias (the name is
already selected), and then move it to a new location.
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Uses for aliases

Alias for

Location

Purpose

Any item that
could be stored
in several places

Everywhere the
item belongs

You can get access to an
item from several places.

Apple Menu On the desktop You can easily add or
Items folder remove Apple menu items.
A program that On the desktop;  You can start the program
must stay with in the Apple without opening the folder
certain files menu or disk where it is stored.
A document or Anywhere on When opened, the alias
folder storedon  your work disk asks for the disk by name,
a separate disk then opens the original
when the disk is inserted.
Anitem on a Anywhere on When opened, the alias
shared disk your work disk automatically connects to

the shared disk and opens
the item.

« Trouble? If you open an alias and nothing happens, or if
you see a message that the original file isn’t available, then
the original has been deleted or the alias is damaged. You
can open the alias’s Info window to find out where the
original is. «



Locating the original of an alias
An alias’s Info window shows the location of the original.
1. Select the alias whose original you want to find.

2. Choose Get Info from the File menu.

E[J=== Informer alias Info

% informer alias

Kind: alias
Size: 2K on disk (1,075 bytes used)

Where: J's disk: Server aliases:

| Location of the
original—includes
folder levels and
disk name (if the

Comments : original is on a

| different disk)

Created: Yed, Jun 5, 1991, 9:54 &AM

Modified: Tue, Jun 18, 1991, 3:21 PM

Original: Instructional Products : Information
Society : Informer :

D Locked

Find l]rigi"[__lal

3. Click the Find Original button.

The window containing the original item opens. The icon is
selected. (If the original is on another disk, you're asked to
insert the disk.)

If you deleted the original, or if it is on a shared disk that’s not
available, you'll see a message that the original can’t be found.
Aliases are not deleted when the original is deleted (and vice
Versa).

Installing an item in the Apple menu

You can install any item in the Apple menu, and then open the
item by choosing it from the menu.

1. Open the System Folder icon and locate the Apple
Menu Items folder.

2. Drag the item you want to install (or its alias) into the
Apple Menu Items folder.

The item appears immediately in the Apple menu.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging its icon out of the folder.

« Trouble? 1f the Apple menu does not contain the items
it should, make sure that the Apple Menu Items folder is
in the System Folder of your startup disk. If it is, open the
folder to check that all the items you want in the menu appear
there. «

Moving an item to the desktop

You can make an item easy to find by dragging its icon to the
desktop. The icon stays there until you remove the disk on which
the item is stored.

If you've placed an icon on the desktop, you can put it back in its
original location by selecting the item and choosing Put Away
from the File menu.
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Finding an item 2. Type the name (or part of the name) of the item you

want to find.
When the Finder is the active program, you can use the Find

command in the File menu to find any item on any disk
connected to your computer. (The Find command cannot locate 3. Click the Find button.
items inside the System file. You need to open the System file to
see its contents.)

Capitalization does not have to match.

The first item that matches the name you typed is shown
highlighted in a Finder window. If an item is found on the

o ) desktop, you see a message. If no item matches, you hear an
Finding an item by name alert sound.

1. Choose Find from the File menu. 4. To see the next matching item, choose Find Again from

The dialog box that appears lets you find an item by name. the File menu.

If no more items are found, you hear an alert sound.
Type the name (or
FIn=="—~——— partial name) you
-i— want to find.

Find: |

( More choices (‘cancel ) { Fina JH - Click to start a search.

Click to choose additional
search criteria.

If the dialog box you see has more items than shown here,
click the Fewer Choices button in the lower-left corner.
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Finding an item using other criteria

You can use the Find command to find items by size, label, date,
or other characteristics.

1. Choose Find from the File menu.

2. Ifyou see a button labeled More Choices, click the
button.

The dialog box that appears lets you select search
characteristics using pop-up menus.

Click to show search
results all at once (instead
of one at a time).

Pop-up menus
of search Type text or set
characteristics a date here.

= ¢t IIM=—¢

Find and select|items whose

[ name v | [ contains ]| |

Search [ on all disks | [Jall at ence

Fewer Choices

(cancer ] [ Find i

Click to display the
smaller dialog box
that searches for
names only.

Pop-up menu of Click to start a
search locations search.

The content of the middle pop-up menu and the text area
vary according to the item selected in the left pop-up menu.

3. Choose an item from the left pop-up menu.
4. Choose an item from the middle pop-up menu.

5. Adjust the date, choose an item, or type text in the
upper-right area of the dialog box.

Click a number to select it;
click the up or down
arrow to change it.

Find g
Find and select items whose
[ date modified w | [ is before v] 10/[Kl/90 @t
Search [ on all disks | [ all at once

(‘cancel ] [ Find

continues »
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6. Choose a search location from the pop-up menu 8. Click the Find button when you've finished selecting
labeled Search. options.

The first matching item is shown highlighted in a Finder
window. To see the next matching item, choose Find Again

Find
N — from the File menu. If the item is found on the desktop, a
[date modified v | [ is before +) 10/E1/90 message appears. If no item is found, you hear an alert sound.
: When you display items all at once, they are shown
Search |~/0n all disks | [Jall at once i . . . )
____________________________________ highlighted in an outline view.
Fewer Chgq on “A's disk” [ Cancel ] [[ Find ]]
on “Art files”

Er—- P _— 7=
on the dESktOD EDE Js disk =V
the selected items Name Size Last Modified

D Read Me 3K Wed, Jun 3, 1992, 11:13PM
LRFer X 15K Fri, Apr 24, 1992, 10:59 AM

. . D save this! 7K Thu, Oct 4, 1990, 8:50 PM
Location for the search < [ Scanner — Mon, Jul6, 1992, 7:16 AM
29K Thu, May 21, 1992, 8:50 PM
34K Thu, May 21, 1992, 8:51 PM
382K Mon, Jul 6, 1992, 7:16 AM
Mon, Aug 10, 1992, 2:05 PM

7. If you want all items displayed at once, click the
checkbox labeled “all at once.”

Alist view, IIndentation means that an item
in outline is located inside a folder.

form, shows

the contents

of folders.
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Finding items that meet two criteria

You can locate items that meet two sets of criteria, such as all
items created before a certain date and larger than a certain size.

1.
2.

Choose the first criterion.

Click the “all at once” box so that an X appears.
Click the Find button.

The items found are shown highlighted in an outline view.

Choose the Find command again, before you click or
take any other action.

You choose Find immediately so that the items located in the
first stage of the search remain highlighted.

Choose the second criterion.

Choose “the selected items” in the pop-up menu
labeled Search.

Click Find to begin the second stage of your search.

The items meeting both criteria are highlighted.

Ways to use the Find command

The Find command can help you locate files quickly, organize
documents, and develop an efficient system for backing up and

archiving your work.

This characteristic

Can be used to locate

Name

Kind

Size

Label

Lock

Modification date

Creation date

1. Files whose names you can’t recall exactly
2. Allitems for which you use a standard name,
such as status reports or expense reports

1. All application programs
2. All aliases

Large files, to make space available on a disk

All the files to which you added the same
label (such as “top secret”)

Locked files, to unlock them for editing

All files changed since a certain date,
to back up new and changed files

All files created before a certain date,
to archive or erase outdated material
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Creating 1 template or stationery If the program you're using does not offer a stationery pad
option, you can use a document’s Info window to create a

Most documents can be saved as or converted into a stationery stationery pad.

pad, which is a template form of the document. The template )

retains its format and content, and you can use it repeatedly as a 1. Click the document icon to select it.

master for similar documents with different content. 2. Choose Get Info from the File menu.

Many programs let you save a document as a stationery pad when 3. Click “Stationery pad” near the lower-right corner
you choose Save or Save As. Click the stationery pad option to so that an X appears in the checkbox.

save your document as a template.

E[JI=== Memo Pad Info
< Walthrop » o Walthrop Memo Pad
O finnual report 93 Q pipet Kind : TeachText stationery pad
O App. programs = Size: 1K on disk (19 bytes used)
D\ é}i’: Lo | Desktop Where : Macintosh HD :
art samples

D Betsy 87272791

N g (;k.;}‘}gk Created: Tue, Sep 3, 1991, 6:57 AM

. Modified: Tue, Sep 3, 1991, 6:57 AM
O Car info Version: n/a

O Caspar maps

D finance repont [T r"'“""""s:

Save this document as: N Stati di
o= o} Suoneny padicon

D Locked E Stationery pad

Regular ‘ Click here to save the
document icon document as a stationery
pad.
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4. Close the Info window. Using the Info window

The document icon now appears as a stationery pad icon. The Get Info command displays information about a

When you open a stationery pad, an untitled window appears selected item.

showing the contents of the stationery, or a dialog box appears 1. Click to select the item you want information about.

asking you to name the new document. .
2. Choose Get Info from the File menu.

If you want to change the stationery pad itself you must first turn
it back into a regular document. You can do this by opening the

stationery pad’s Info window and clicking “Stationery pad” to el
remove the X.

Read Me Info

Read Me
System Software v7.1

Kind : document
Size : 3K on disk (1,622 bytes used)

Getting information about your files here: s sk i e
When the Finder is the active program, you can obtain Fodified-wed,Nov &, 1991, 12.00 P11

Version:n/a

information about your files in two places:

Comments -

» in the file’s Info window

| | lﬂ thC VICW menu [JLocked [] stationery pad

You can type comments in the Info window and use the
Find command to search for them later.

3. Close the window.
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Using the View menu

You can use the View menu to display the contents of a window
by icon or small icon, or you can list items according to various
characteristics such as name, size, or kind. (You can use the Views
control panel to change how files are listed and what information
is included in the list. See the chapter on adapting your computer
to your own use.)

Windows are preset to show icons. You can also display items in a
list by choosing a command from the View menu. For example,
listing items by the date and time of their most recent
modification makes it easy to back up files you have changed
recently.

The type of list displayed is underlined.

N Q.=
Name Size Kind Label Last Modified

D O Art ideas — folder Essential Sat,May 5, 140

D O caspar maps — folder Hot Thu, Nov 2, 1 .

D) credit union account 17K document Personal Mon, Jun 19,

When the contents of a window are displayed as a list, you can
click any column heading (such as Size or Last Modified) to
rearrange the list according to that characteristic.
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Assigning a label to a file

You can assign a label to a file and then group related files
according to the label you have given them.

To assign a label to an icon, click the icon to select it and then
choose the label you want from the Label menu. Choose By Label
from the View menu to regroup your files. The label is visible only
when the contents of a window are displayed as a list.



Tips on transferring files

You can transfer files from your computer’s internal hard disk in
the following ways:

m  Overa network

You can connect your computer to a network and transfer files
over the network. For information, see the networking
chapter.

= Over telephone lines

If your computer is connected to a modem or has a modem
installed, you can transfer files over telephone lines using an
appropriate communications program. For more information,
see the chapter on expanding your computer system.

On floppy disks

If your computer has a built-in floppy disk drive or is
connected to an external floppy disk drive, you can transfer
files from your computer’s internal hard disk to a floppy disk.
(If your computer does not have a built-in floppy disk drive,
see the chapter on expanding your computer system for
instructions on connecting a disk drive.)

On another hard disk

If your computer is connected to another hard disk, you can
transfer files from your computer’s internal hard disk to
another hard disk. For instructions on connecting a hard disk,
see the chapter on expanding your computer system.
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Chapter 10

Adapting Your Computer
to Your Own Use

In this chapter

Specifying which items you want opened at startup
Installing an item in the Apple menu

Installing files in the System Folder

Changing the labels in the Label menu

Setting the time and date

Setting a time for the Alarm Clock to go off
Turning the alarm off

Changing time and date formats

Changing number and currency formats

Adjusting the way the trackball or mouse works
Adjusting the way the keyboard works

Making keyboard shortcuts easier to type
Adjusting the keyboard for very slow typing
Adjusting the blinking of a menu item
Adjusting the blinking of the insertion point
Changing the way the contents of windows appear
Changing an icon

Turning off the Empty Trash warning

Managing memory

Setting the beep sound

Installing a sound

Removing a sound

Recording sounds

Changing the background pattern

Magnifying the screen image
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Specifying which items you want opened
at startup

To have a program or a document open automatically when

you start up your computer, drag its icon or its alias to the Startup
Items folder, which is inside the System Folder. Programs or
documents that you put in the Startup Items folder are opened
when you start up your computer. You can open as many files as
your computer’s memory allows.

If you no longer want a file to open automatically when you start
up your computer, remove the icon or alias from the Startup
Items folder.

Installing an item in the Apple menu

To have an item’s name appear in the Apple (@) menu, drag its
icon or its alias to the Apple Menu Items folder, which is inside
the System Folder.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging the item out of the folder.
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Installing files in the System Folder

Certain files need to be installed in the System Folder so your
computer can use them as part of the system software. These files
include

= system extensions and control panels
» preferences for application programs

» software that controls printers, scanners, and other
equipment

= sounds
= fonts

Usually, you install these files by dragging their icons to the
System Folder icon (not the System Folder window). Sometimes
these files need to be installed by a program that comes with the
files. Check the instructions that came with the files for any
specific installation procedure.



Most special files are stored in folders inside the System Folder.
When you drag a file’s icon to the System Folder icon, your
computer recognizes which type of file it is and stores the file in
the appropriate folder.

This folder holds networking
and printing software and
files that extend your
computer’s capabilities.

The System file holds sounds,
and keyboard files.

HEEees===== susten| Folder Ee=========0T2

8 items 3.9 Mﬂ in disk 34.2 MB available
(£} .

@ @J This program

Apple Menu Items Extensions System Finder manages the
_ = = Macintosh
desktop

Preferences Startup Items Control Panels Scrapbook File 6 '
4l B2

This folder holds settings
for application programs.

This file holds items you
put in the Scrapbook.

If you drag an item to the System Folder window instead of the
System Folder icon, the file is not stored in the appropriate folder
automatically, and it may not work properly.

Items you want in the Apple Menu Items folder or the Startup
Items folder need to be dragged to either folder directly. (This
chapter has instructions for installing Apple menu items and
specifying the items you want opened at startup.)

Removing files from the System Folder

You remove a file from the System Folder by dragging its icon out
of the System Folder.

Depending on the equipment you use, whether or not you're on a
network, and how you use your computer, you can remove the
following items from your System Folder if you want to conserve
space on your startup disk:

» software for printers or other devices you don’t use (for
example, the AppleTalk ImageWriter driver)

» networking software, if you are not on a network (and don’t
plan to be) and don't use AppleTalk Remote Access

= Apple menu items you don’t use (you need the control
panels, but you may not need the Calculator or the Puzzle, for
example)

» fonts, sounds, or keyboard files you don’t use

Be sure you have backup copies of the files on floppy disks before
you remove them from your System Folder.
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Changing the items in the Label menu

You can change the labels in the Label menu. You make these
changes in the Labels control panel.

1. Choose Control Panels from the Apple (&) menu and
open the Labels control panel.

J

==
Labels

2. To change a label, drag across it to select it and then
type your new label.
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Setting the time and date

Your computer has a clock that keeps track of the time and date (a
battery keeps it running when the computer is turned off).

Many programs rely on the clock to automatically enter times and
dates in documents you create or print, and the Finder uses it to
keep track of when files are created or changed.

1. Choose Control Panels from the Apple (#) menu and
open the Date & Time control panel.

ey
==
Date & Time




[(E=E=—=—===—1Dale ¢ Time E===——=—
E@ Current date Current time
05/H)/92 |T

| 2:43:50 PM |

(pate Formats... )

(Time Formats... |

To set the date, click the month, date, or year to

select it, then click the up or down arrow (or type

the new number).

E[I==——=—=——= Date & Time =i —"———=
% Current date Current time
05/20/92 2f:s0em | B

(pate Formats... ) (Time Formats... |

To set the time, click
the hours, minutes, or
| seconds to select them,
then click the up or
down arrow (or type

the number).

You can also set the time and date using the General Controls

panel or the Alarm Clock.

Setting a time for the Alarm Clock to go off

You can set the Alarm Clock to alert you when it’s time for an
appointment or a meeting.

1. Choose Alarm Clock from the Apple (&) menu.

2. Click the upward-pointing lever near the upper-right
corner to expand the Alarm Clock.

[O 3:52:18 PM &

The lever points downward, and the Alarm Clock expands to
its full size.

[0 3:52:40PM ¢
6/21/92

O IF ax

continues »
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3. Click the alarm clock icon in the lower-right corner to

. Button in the upper position O 3:53:34PM ¢
select . indicates that the alarm is on. — L@ g.51:00 aM
The glarm clock icon b@comes 'highlighte'd When you select it. ® Zo Icon showing
The time that appears in the middle section is the current ringing alarm
alarm clock setting.

8. Click the close box to close the Alarm Clock.

[0 3:53:34PM ¢
@ 8:21:00 AM

The alarm will not go off unless you close the Alarm Clock,
click the lever to make the Alarm Clock smaller, or make

@ another window active.

Turning the alarm off
4. Click the hours, minutes, or seconds in the alarm clock

setting to select them. When the system clock reaches the time set for the alarm, the

alert sound plays twice and an alarm clock icon blinks over the

Up and down arrows appear to the right of the time display. Apple icon at the left end of the menu bar.
5. Click the up or down arrows repeatedly until the To turn off the alarm, choose Alarm Clock from the Apple (@)
number you want appears. menu and click the button to the left of the alarm clock setting.

6. Repeat steps 4 and 5 as necessary.

7. Click the button to the left of the alarm clock setting to Changmg time and date formats

turn the alarm on. You can change how times and dates appear based on personal

The button and the alarm clock icon change to indicate that preference or local custom.

the alarm is turned on. (Clicking again turns the alarm off.)
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Changing the date format 3. In the dialog box that appears, make the changes you

want.
1. Choose Control Panels from the Apple (&) menu and

open the Date & Time control panel. A sample of the format you choose appears at the bottom of

the dialog box.
2. In the Date & Time control panel, click Date Formats.

4. Click OK to close the control panel.

Choose standard formats
from this pop-up menu.

Type preﬁx and separators % Date Formats: | U.s. - I
in these boxes.
- Long date ] - Short date
Prefis: [ Month/Day/Year | Use this pop-up menu to set the
I Weekd I order of elements in the date.
eekday w| [, .
[ Month ~) Separator: @ Type the separator between
Use these pop-up menus to set the I_I . date elements here.
order of elements in the date. | Day v | | [Leading zero for day
[ vear o [JLeading zero for month
lick h ad . [] Show century
Click here toa []Leading zero for day
a zero before
a single-digit number. - Samples
Thursday, January 2, 1992 Cancel

Thu, Jan 2, 1992
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Changing the time format 3. Make the changes you want.

1. Choose Control Panels from the Apple () menu and A sample of the format you choose appears at the bottom of
open the Date & Time control panel. the dialog box.
2. In the Date & Time control panel, click Time Formats. 4. Click OK to close the control panel.

Choose standard formats
from this pop-up menu.

Time Format: | U.S. v |
- Clock - Format
O 24 hour Before noon: | AM o
When you choose the ® 12 hour | Type the text that identifies
12-hour clock, you can Noon & midnight: After noon: | PM before and after noon here.

also choose either 0:00
or 12:00 to represent
noon and midnight.

O 0:00
@ 12:00 Separator: |l Type the separator between hours,
minutes, and seconds here.

[JUse leading zero for hour Cancel

- Samples

12:34 AM 4:56 PM

o T

152 Chapter 10: Adapting Your Computer to Your Own Use



Changing number and currency formats 2. Make the changes that you want.

You can choose among several formats for displaying numbers 3. Close the control panel.
and currency.

1. Choose Control Panels from the Apple (&) menu and
open the Numbers control panel.

A

S
Numbers
Choose standard formats
from this pop-up menu.
S aumbers SRR
. |
Type the decimal separator Number Format: [ U.S. ~]
here or choose a separator
from the pop-up menu. o SEREPENEFS s 0 QUAPCOY) ey
Decimal: \DEl Symbol: Type the currency symbol here.
Thousands: DE' @© Before number To place the currency
7 O After number _ | symbol before or after the
Type the thousands __| S number, click a buton.
separator here or $1,23456
choose a separator from ;

the pop-up menu.
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Adjusting the way the trackball or 2. Click the tracking speed you want.

mouse works The Very Slow option is useful for drawing or for a graphics
tablet because the pointer moves at a constant speed relative

You can adjust two aspects of trackball or mouse operation in the
to trackball or mouse movement.

Mouse control panel: tracking, which is the relation between
trackball or mouse movement and pointer movement on the 3. Click the double-clicking speed you want.

screen, and double-clicking speed. Adjust the double-clicking speed if your computer often

1. Choose Control Panels from the Apple (&) menu and interprets two clicks as a double click, or a double click as two
open the Mouse control panel. single clicks.

2 | ¥ + T+ The space between arrows
@ = ¥ ¥@ ¥O corresponds to the time

W Double-Click Speed between clicks.

Mouse
Mouse button highlights twice
E0=— Mouse =—— at the interval selected.
Mouse Tracking
B B
5  000®00 4. Close the control panel.

Very Slow Slow Fast

¥ - +

Lo o ‘o te
W Double-Click Speed
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Adjusting the way the keyboard works

You can adjust the rate at which a character repeats when its key is
held down as well as the delay before the character begins
repeating. You can also change the keyboard layout if you have
additional keyboard layouts installed.

1. Choose Control Panels from the Apple (&) menu and
open the Keyboard control panel.

=0
Keyboard

Options for the speed at
which a character repeats

EJ=—— Keyboard =——|
I Key Repea\lRaQe ! Delalg Until Repeat | OpthnS fOI‘ delay
O00®O Olo®0O0O
Slow Fast Off Long Short before a key repea[s
Keyboard Layout

Dvorak ats .

=15 Options for keyboard
layout (if more than

= one is installed)

. Close the Keyboard control panel.

. To adjust the rate at which a key repeats when it is held

down, click the button for the rate you want.

. To adjust the delay before keys repeat, click the button

for the delay you want.

If the keys repeat when you don’t want them to, set a longer
delay before a character begins repeating. (If you click the Off
button, the keys don’t repeat at all.)

. To change the keyboard layout, click the name of the

keyboard layout you want to use.

You may have a choice of more than one keyboard layout.
(Additional keyboard layouts are available from various
sources. You install them by dragging them to the System
Folder icon.)
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Making keyboard shortcuts easier to type

With the system software feature called Sticky Keys, you can type
keyboard shortcuts (such as 8-S for the Save command) without
actually pressing the keys simultaneously.

» To turn Sticky Keys on or off, press the Shift key five
times without moving the mouse.

With Sticky Keys on, you can type a keyboard shortcut by first
pressing the modifier key (88, Option, Control, or Shift) and then
pressing the character key. An icon in the right end of the menu
bar (to the right of the Application menu icon) changes to
indicate whether Sticky Keys is on and whether a modifier key has
been pressed or locked.

A modifier A modifier key is locked
Sticky Keys key has been (pressing the key again
i | pressed. | unlocks it).
ke

You can have Sticky Keys beep when a modifier key is pressed.
You set this option in the Easy Access control panel. Choose
Control Panels from the Apple (#) menu and open Easy Access.
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Adjusting the keyboard for very slow typing

The system software feature called Slow Keys lets you type very
slowly and ignores accidental keystrokes by delaying the
acceptance of the next keystroke.

n To turn Slow Keys on or off, hold down the Return key
for about four seconds. A beep signals when the feature
has been turned on or off.

You can adjust how long you want Slow Keys to delay acceptance
of the next keystroke. You can also set Slow Keys to make an
audible click each time a keystroke is accepted. You make these
adjustments in the Easy Access control panel. Choose Control
Panels from the Apple (@) menu and open Easy Access.



Adjusting the blinking of a menu item

You can change the number of times a menu item blinks when it’s
chosen. You make this adjustment in the General Controls panel.

1. Choose Control Panels from the Apple (&) menu and
open the General Controls panel.

2. Click the button for the number of times you want the
menu item to blink.

Clicking the Off button prevents a menu item from blinking.

Menu Blinking

3. Close the control panel.

Adjusting the blinking of the insertion point

You can adjust how quickly the insertion point blinks (the
insertion point indicates where any text you type will appear). You
make this adjustment in the General Controls panel.

1. Choose Control Panels from the Apple (&) menu and
open the General Controls panel.

2. Click the button for the blinking rate you want.

Rate of Insertion
Point Blinking

Slow Fast

The insertion point in the control panel blinks at the rate you
selected.
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1 Options for clean-up Pop-up menu of fonts for icon
Chapgmg the Wﬂy the contents of icons names and list views
of windows appear

JI1I)
=

Views I% Pop-up menu of font

Font for views: [_Geneva ~) E|——Slz§sl‘f<zr icon names
and liSt viEws

You can change the way the contents of Finder windows are
displayed, and you can change the items in the View menu. You

I leon Views

make these changes in the Views control panel. Choose Control EabE O
Panels from the Apple (8) menu and open the Views control o CAmasswtoeu Option to snap icons
| pple (&) p [BnDp Ostagseredgria to an invisible grid
pan€l. -List Views - whenever they are
R T moved
®@ O O [X] Show 1abe1
[X] show date i
] |:| Calculate folder sizes | |:| Show version CheCk_ed items
v D D Show disk info in header D Show comments appeal n the
| G View menu.
Views
Options for the size Options for information
of icons displayed in ~ displayed in list views
list views

Use the Views control panel to change

» the font and font size used in all views (press to open the

: See the summary and shortcuts section near the end of this book
pop-up menu, then drag to choose a font or a size)

for more information about using windows and list views.
» the arrangement of icons or small icons

m the size of icons used in list views

» what information is included in list views, including folder
sizes and the amount of available space on disk
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Changing an icon

You can change an icon by creating or copying a picture you want
and then pasting it into an icon’s Info window.

Some icons can’'t be changed, including those for control panels
and other parts of the system software. Every icon fits inside a
small square.

1. Select the picture you want to use for the icon.

2. Copy the picture by choosing Copy from the Edit menu.

3. Switch to the Finder, then click to select an icon you

want to change.

4. Choose Get Info from the File menu.

5. Click the icon at the upper-left corner of the Info

window to select it.

A box appears around the icon when it’s selected. If no box

appears when you click, the icon can’t be changed.

E[= overseas accounts Info

]

Kind:
Size: zero K on disk (O bytes used), for O

overseas accounts

folder

items

Where: J’s disk : untitled folder

Created: Wed, Oct9, 1991, 9:25 AM
Modified: Wed, Oct9, 1991, 9:25 AM
Comments :

continues »
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6. Choose Paste from the Edit menu.

The picture you copied replaces the selected icon in the Info
window. If the picture is bigger than the icon, it automatically
shrinks to fit.

== overseas accounts Ir

@ overseas accounts

7. Close the Info window.

You can restore the original icon by clicking the picture in the
upper-left corner of the Info window and choosing Cut from the
Edit menu.
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Turning off the Empty Trash warning

When you choose Empty Trash from the Special menu, a message
warns you that you will not be able to recover the contents of the
Trash once it's emptied. (The warning helps you avoid throwing
away items unintentionally.)

You can turn off this warning in the Trash’s Info box.
1. Click the Trash icon to select it.
2. Choose Get Info from the File menu.

3. Click the checkbox labeled “Warn before emptying” to
remove the X.

To turn the warning back on, click the checkbox so that an X
appears.

You can also override the warning by holding down the Option
key when you choose the Empty Trash command.

Until you choose Empty Trash, items in the Trash continue to
occupy space on your disk.



Managing memory

Occasionally you may need to make adjustments in how your
Macintosh uses its random-access memory (RAM) in order to
work efficiently with large programs or with several programs at
once.

Checking memory use

You can find out how much memory your computer has, how
much of it is available, and how much memory is being used by
each program you have open. You find this information by making
the Finder the active program and choosing About This Macintosh
from the Apple menu.

Total memory available
(including virtual memory)

The largest program
you can open now

=E[1l=—————= Abou} This Macintosh ==——=—F|

System Software 7.1
Macintosh SE/30 © Apple Computer, Inc. 1983-1992

Total Memory : 4,096K Largest Unused Block: 2,325K
System Software  1,518K [
| B TeachText 192k |
]
]
Open Memory The bar indicates how much memory a
programs  allocated for program reserves for its own use. The dark
each program portion is the amount it is actually using.

Making the most of your memory

Remember the following tips on memory management:

Closing a document window does not quit the program. The
program remains open and uses memory until you choose
Quit from the File menu. (The Application menu, at the right
end of the menu bar, shows which programs are open.)

If you have opened and quit several programs, your
computer’s memory may be fragmented and you may not be
able to open a program that requires a lot of memory. To
solve this problem, you can restart your computer.

If you're not using network services (such as electronic mail
or a shared printer), you can make more memory available by
turning off AppleTalk in the Chooser and restarting your
computer.

If you're not sharing files over a network, you can make more
memory available by turning off file sharing. (See the chapter
on networking for more information.)

Removing system extensions you don’t need makes memory
available (for example, you don't need the AppleShare
extension if your computer will never be on a network and
you don't use AppleTalk Remote Access).

continues »

Chapter 10: Adapting Your Computer to Your Own Use 161



»  Reducing the size of the disk cache makes more memory
available. (See the disk cache section in this chapter.)

» Reducing the amount of memory a program uses may allow
you to open more programs at once (see the chapter on
setting up your programs).

Adjusting the disk cache

The disk cache is memory set aside to help programs work more
quickly and efficiently. But the memory in the disk cache is not
available for opening programs or documents. If you often want
to open more programs than memory allows, you can set the disk
cache to a smaller size.
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You set the size of the disk cache in the Memory control panel.

1. Choose Control Panels from the Apple (&) menu and
open the Memory control panel.

@

=
Memory

no

Click the up or down arrows next to the Cache Size
box.

Memorg EI

Cache Size  [128K _Arrows adjust cache in
preset amounts.

3. Choose Restart from the Special menu.



Using hard disk space as memory

Your computer can use space on a hard disk to increase the
memory available for opening programs. The disk space, called
virtual memory, is not available for storing files.

Your computer should contain enough built-in memory for your
regular needs—that is, for the programs you frequently have open
simultaneously. You can use virtual memory when you want to
open additional programs or work with extremely large
documents.

Virtual memory is most effective when you are using several small
programs simultaneously. It slows the computer’s performance if
you're using one very large program.

You adjust the use of virtual memory in the Memory control
panel.

1. Choose Control Panels from the Apple (&) menu and
open the Memory control panel.

4

—— 11—}
Memory

. Click the On button to turn on virtual memory.

. Press the pop-up menu and drag to choose a hard disk

to use for virtual memory.

. Click the up and down arrows to set the amount of disk

space to be used as virtual memory.

Select Hard Disk:

|== Macintosh HD
Available on disk: 36M

Pop-up menu of hard disks in use
Space available on the disk

Available built-in memory: 4M Macintosh HD
After restart
L Total memory (includes

virtual memory)

The preset amount is equal to the amount of RAM installed in
your computer. Choosing a larger amount of virtual memory is
likely to slow the computer’s performance, so it is
recommended that you accept the preset size.

continues »
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5. Choose Restart from the Special menu.

After you restart, your computer’s total memory includes the
virtual memory you set aside on the hard disk. Choose About This
Macintosh from the Apple (@) menu to see memory use
information.

A\ Important: When you turn on virtual memory, the system
software creates a file named VM Storage in your System
Folder (if the startup disk is used for virtual memory) or
on the desktop (if another hard disk is used for virtual
memory). This file is large—the size of the computer’s RAM
and the selected amount of virtual memory combined. For
example, if your computer has 4 MB of RAM and you add
2 MB of virtual memory, the VM Storage file will occupy 6 MB
of space on your startup disk. A
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Turning on 32-bit addressing

Your computer can use very large amounts of memory (more than
8 megabytes) by taking advantage of a feature called 32-bit
addressing—the use of very long (32-digit) binary numbers to
control the way data is manipulated.

You can turn 32-bit addressing on or off in the Memory control
panel.

1. Choose Control Panels from the Apple (&) menu and
open the Memory control panel.

%

=0
Memory

2. Click the appropriate buttons in the control panel.

32-Bit Addressing

@ on 32-bit address is off

QO off (will be on after restart)

3. Choose Restart from the Special menu.



Setting the beep sound 3. Click the beep sound that you want your computer to

use.
Many programs have the computer make a sound when your
attention is required or when you're attempting an action that the
computer cannot perform at that time. 0 Sound

Speaker Alert Sounds
Yolume

Droplet

You can choose the type of beep sound that you want your
computer to make. You can also set the sound’s volume.

7-

Quack
Simple Beep
Sosumi

Wild Eep

1. Choose Control Panels from the Apple (&) menu.

O = NOb UG

2. Open the Sound control panel.

|<]))) When you click a sound to select it, it’s played at the current
— volume setting.
Sound

4. Drag the slider up or down to set the volume.

If you set the volume to zero, instead of hearing a beep, you'll
The Sound control panel appears. The beep that your see the menu bar flash.

computer is currently using is already selected. 5. Close the Sound control panel.

Chapter 10: Adapting Your Computer to Your Own Use 165



Installing a sound

Your computer comes with several beep sounds. You can get
additional sounds from various sources.

» To install a sound, you drag its icon to the System
Folder icon (not the System Folder window).
The sound is automatically installed in the System file, where
it belongs.

D)

Oom-pah

Once you add a sound to the System file, it is listed in the Sound
control panel.
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Removing a sound

You can remove sounds in the Sound control panel. Make sure
you have a backup copy of the sounds on floppy disk. (To copy a
sound, you can open the System file to see its icon.)

1.

5.

Choose Control Panels from the Apple (&) menu.

2. Open the Sound control panel.
3.
4

. Choose Cut from the Edit menu.

Click to select the sound you want to remove.

If you selected the wrong sound, you can choose Paste to
restore the sound.

Close the Sound control panel.

You can also remove a sound by opening the System file and
dragging the sound’s icon out of the System file and out of the
System Folder.



Recording sounds

Your computer can use an external microphone, which you can
use to record a sound and add it to the Sound control panel.

1. Connect a microphone or another audio source to the
sound input port (marked with the icon ¢) on
your computer .

For more information, see the chapter on expanding your
computer system.

2. Choose Control Panels from the Apple (&) menu.
3. Open the Sound control panel.

The Sound control panel appears. The icons of the available
sound input devices appear near the bottom of the window.

4. Click the icon of the sound input device you want to
use.

Bpisas..
ita

Microphones

0
W Recorder 6

. Click the Add button.
. Get ready to record, then click the Record button.

Recording begins immediately. You have ten seconds to
record your sound.

| <

Record Stop Pause Play Cancel
| | :00 SBee
0 seconds 110 -

. Click Stop to stop recording.
. To listen to the sound you recorded, click Play.

. To save the sound you recorded, click Save.

continues »
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10. Type a name for the sound, and click OK. Changing the background pattern

You can change the background pattern that appears on your

computer screen in the General Controls panel.
Give this sound a name:
[Andrea's firstword | 1. Choose Control Panels from the Apple (8) menu and
) open the General Controls panel.
=%
The new sound appears in the Sound control panel. Its icon also ==
appears in the System file. e
EC1== General Controls ==

Rate of Insertion
Point Blinking

il
O ® O

Fast

Menu Blinking Time ®
— 10:27:51 AM
|==] @ 12hr. O 24hr.
O 00® | bat [
off 1 23 3/28/92
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You can choose from a variety of patterns provided, or you 5. To edit a pattern, click in the pattern editing area to the
can create your own design by editing one of the patterns left of the sample pattern.
supplied.

Each dot in the square changes from white to black (or black
to white) when you click it. Your changes are displayed in the
sample pattern.

. To see the patterns available, click either of the small

triangles above the sample pattern. ,
continues »

. Click the sample pattern to see the new pattern on
your desktop.
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6. When you've finished creating your new pattern, click
the sample pattern to display it on your desktop.

7. To save the new pattern, double-click the sample
pattern.

If you don’t save the pattern, you lose it when you click one of
the small triangles to display another pattern.

8. Close the control panel.
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Magnifying the
screen image

The CloseView control panel lets you magnify
the image on your computer screen up to
sixteen times. It is supplied as part of your
system software.

CloseView is not installed when you first start
up your PowerBook. It is in a folder called
Extras located on your hard disk.

To install CloseView:

1. Double-click the Extras folder to
open it.



2. Locate the CloseView control panel.

%

==
CloseView

3. Drag the CloseView icon to the
System Folder icon (not the System
Folder window) on your startup
disk.

4. Choose Restart from the Special
menu.

To turn CloseView on or off, press
#-Option-O.

To turn the magnification on or off, press
$—Option—X. (When CloseView is on and
the magnification is off, a rectangle on

the screen indicates which area will be
magnified. You can move the rectangle by
moving the pointer.)

To increase or decrease magnification, press
$#—Option—Up Arrow or 8—Option—Down
Arrow.
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You can set additional options in the
CloseView control panel. Choose Control
Panels from the Apple (8) menu and open
the CloseView control panel.
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Turns CloseView on

=0

Closeliew =———|

Clase
V?gw

OOn_=I=
@ orf NS0

@ Black on White
O White on Black

Magnification

Oon v
@ orf NS H

Keyboard ® on
Shorteuts (O off

~e %1
~e % ||
[

E = Option

% = Command i

B 1988-1991,
hpple Computer, Inc.

developed by
Berkeley Systems, Inc.

Inverts
screen
image

Turns shortcuts
on or off

Turns
magnification
on or off

Keyboard
shortcuts

Arrows
change
magnification
power



Chapter 11

Pﬁnting Before you print

Before you can print, your computer must be connected to a

is ch printer, either directly or over a network. See the information that
In this ¢ apter came with your printer for instructions on how to connect it, or
m Before you print check with your network administrator.

»  Printing your work

. o Choosing a printer
= Controlling background printing

Once your printer is connected, you must tell your computer
which printer to use by choosing that printer. You need to do this
even if only one printer is connected to your computer. You
choose a printer when you're using it for the first time and
whenever you change printers.

»  Working with fonts

You choose the printer in a program called the Chooser. How you
use the Chooser depends on whether your printer is connected
directly or over a network.
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If your printer is connected directly to your computer

Make sure you've connected the printer according to the
instructions that came with it.

1. Choose Chooser from the Apple (&) menu.

2. Click the icon of your printer to select it.

L Chooser
O Select a port:
[
. X g
LQ AppleT...geWriter LQ | %
l l 5
Personal ...Writer SC  Personal LW LS
O Active
StyleWrit 5| AppleTalk .
PIAS? A% PP @ Inactive

< Ifyour printer’s icon does not appear in the Chooser:

The printer software is not in your System Folder. Close the

Chooser and install the software you need. Consult the

documentation that came with your printer for instructions

on installing its software. «
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If you have a Personal LaserWriter SC, you're finished. Close
the Chooser now.

3. Click the icon of the port to which your printer is
connected.

If your printer is connected to the computer’s modem
port (marked with the icon %), you're finished. Close the
Chooser now.

If your printer is connected to the computer’s printer
port (marked with the icon &), continue with step 4.

4. Click the Inactive button next to the word ‘AppleTalk.”

If Inactive wasn’t already selected, a message appears.
Click OK.

5. Close the Chooser window.

If your printer is connected over a network

Ask your network administrator or the person who set up your
computer to tell you

= which printer you can use
» which zone it’s in (if the network has zones)

» what its name is (every printer on a network has its own
name)



1. Choose Chooser from the Apple (6) menu. 3. Click the icon of the printer you want to use.

&

s Ifyour printer’s icon does not appear in the Chooser:
The printer software is not in your System Folder. Close
the Chooser and install the software you need. See the
documentation that came with your printer, or consult the

2. Click the Active button next to the word “AppleTalk.”

If Active wasn't already selected, a message appears. Click OK.

|Types of devices available ~ Names of individual printers network adminstrator. <
—laee 4. If the Chooser lists AppleTalk zones, click the zone
f —To]| | Select a Laseririter: where the printer is located.
gl & Accounting ufi
ImageWriter Human Resources Zones are listed alphabetically. You can also type to select a
Marketing
Sales zone.
5 5. Click the name of the printer you want to use (even if
AppleTalk Zones: only one name appeal's).
4th floor west ||
Sth floor east G 6. If you want to continue using your computer while
6th floor east Background Printing: @ On O Off your documents are being printed, click the On button
6th floor west o e
B i next to Background Printing.
AppleTalk |_© .
QO Inactive

Background printing is not available with all printers. If it’s not
available, these buttons do not appear.

Network zones (these appear only if ‘AppleTalk must be active

your computer is connected to a to use any network devices, 7. Close the Chooser.
network that has zones) including network printers.
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Selecting Page Setup options

You use the Page Setup dialog box when you've selected a new
printer in the Chooser, or when you want to use a different paper
size or printing options.

m  Choose Page Setup from the File menu and select the options
you want.

When a LaserWriter printer is selected, this or a similar Page Setup
dialog box appears:

Pop-up menu of
special paper sizes

Laserllriter Page Setup -m
Paper: @ US Letter O A4 Letter -
OUS Legal O B5 Letter O|_Tabloid v | (cancer )
Reduce or A Printer Effects: Options
| Enlarge: 7 X Font Substitution?
Orientation [X] Text Smoothing?
t Xl Graphics Smoothing?
llﬂlJ [X] Faster Bitmap Printing?

Printed copy as a Click to open a dialog box where
percentage of the you can select enhancements
original’s size to the printed image.
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When an ImageWriter printer is selected, this Page Setup dialog
box appears:

Imagelriter I 0K I
Paper: @ US Letter O A4 Letter
QO US Legal O International Fanfold

O Computer Paper
Orientation Special Effects: []Tall Adjusted

B []50 % Reduction
RS [ No Gaps Between Pages

Each type of printer offers different options. Some programs
provide additional options. You can choose Show Balloons from
the Help menu and then point to options to see descriptions, or
check your printer or program manual for details.



Updating printer software on networked computers

All computers that share printers on a network must have the
same version of the printer software. The printer restarts itself
each time a different version is used (which takes time and clears
any fonts from its temporary memory).

A\ Important: All computers on a network must have the same
printer software versions in the System Folder. A

You or your network administrator should update the printer
software on all Macintosh computers on the network. You do not
have to update any files other than the printer software.

To update printer software, use the Installer program and the
accompanying Printer Update document that came with your
printer or system software upgrade. If you are installing system
software over the network, locate and open the Installer program.
If you purchased a system software update kit, the Installer will be
on one of the disks.

Installer Printer Update

. Locate the Installer and Printer Update files, and then

open the Installer icon.

. Click OK.

The Easy Install dialog box appears.

. Make sure that the hard disk indicated is the

correct one.

Click the Switch Disk button until the correct disk name
appears.

. If you want to install software for additional printers,

click the Customize button, and then select the names
of the printers you want to install software for.

continues »
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If you want to update the printer software that is already Printing your work
installed on your disk, go to step 5.
You can print a document while it’s open and its window is active;

When you click Customize, the custom installation dialog box you can also print documents while the Finder is active,

shows a list of printer software.
1. Make sure that the document you want to print is in

. . the active window.
Printer software available

If you're printing in the Finder, select the documents you

Click the items you want to select; want to Prim~
Shift-click to select multiple items.
Software for LaserlWriter [ Tosian 2. Choose Print from the File menu.
Software for Personal Laserlriter SC -
T The printing options that appear depend on the selected
— Warthrop printer and the program in which the document was created.
=
Fiect Bisk
Page range (clicking All prints the entire
Paper-feed document; entering page numbers in the
method From and To boxes prints those pages only)
5. Click Install. LaserWriter “Laserlriter” m
. . . Copies: P @Al F 3 To:
6. When you see a message reporting that installation was opies I ages: @Al Ofrom:|_ [To:| |

Cover Page: @ No QO First Page O Last Page

aper Source: @ Paper Cassette O Manual Feed
Print: @ Black & White O Color/Grayscale
Destination: @ Printer QO PostScript® File

successful, click Restart.

If a message reports that installation was not successful,
try again.
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< Printing color or gray-scale documents: You can print color Printing the contents of a window or the desktop
or gray-scale documents on any color printer that can use the
LaserWriter printer software. If you print a color document on
a black-and-white printer, the document is produced as a
halftone (that is, it is composed of patterns of dots). < 1. Make sure that the window whose contents you want to
print is active.

You can print a list of the contents of the active window when
you're working in the Finder.

Some programs offer additional printing options. See the
manuals that came with your programs for more information 2. Choose Print Window from the File menu.
on their printing features.

3. Click Print.

Select the options you want.

4. Click Print.
A status message appears. If background printing is turned on,
the message disappears after a few seconds, and you can do
other work while printing continues. Instructions on
controlling background printing are in this chapter. When no window is active, you can print the items on the desktop
by choosing Print Desktop from the File menu.

The window’s contents are printed, including items not visible
on the screen.
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Solutions to common printing problems

If nothing happens or if you see an error message when you try
to print, try the following:

»  Make sure that the printer is turned on and warmed up.
m  Check the cable connections to the printer.

» Ifyour printer is an ImageWriter, make sure that the Select
light is on. (If not, press the Select button.)

m  Make sure that the printer has paper and that the paper is
feeding properly.

m  Make sure that a printer (and its name or port) is selected in
the Chooser.

= Ifyoure on a network, make sure that you are using the same
version of the printer software as everyone else.

» Ifan error message states that the printer could not print your
document, turn off the printer for at least 10 seconds. Then
turn it on again, wait for the printer to warm up, and try to
print again.

180 Chapter 11: Printing

If fonts printed on a laser printer look jagged or if lines or letters
are missing, your computer may not have enough memory
available to print your document properly, the font may not be
available in your printer, or the font substitution option may be
turned off in the Page Setup dialog box. Try the following:

m  Make sure font substitution is turned on in the Page Setup
dialog box.

»  With background printing turned on, quit the program you're
using immediately after you choose the Print command.

» Transfer the fonts you need to your printer (see the section
on transferring fonts in this chapter).

»  Make use of fewer fonts and sizes in your document.



Controlling background printing You can use PrintMonitor to

If you are using a LaserWriter or StyleWriter printer and the = check the printing of your document

background printing option is turned on in the Chooser, you can = cancel a document that’s printing or waiting to print

continue to work while your documents are printing.
» set the date and time you want a document to print or
You don't need to do anything once background printing is postpone printing indefinitely

turned on. But if you wish, you can control background printing

with PrintMonitor, a program that’s part of system software. = check the paper supply

PrintMonitor’s icon blinks at the right end of the menu
bar when the printer is out of paper. You can change this

alert signal with the Preferences command in the File
A few moments after printing begins, PrintMonitor opens menu.

automatically and its name appears in the Application menu.

1. After you have started printing a document, choose
PrintMonitor from the Application menu.

» check when to feed paper manually

PrintMonitor’s icon blinks at the right end of the menu

e Printoniler ) Nameof the bar to signal that you must confirm manual printing. You
Lrinting document being can change this alert signal with the Preferences
[, Sea Lion Salute @ Wellesley | printed and i i
o printer in use command in the File menu.
1 ) Read Me @ Wellesley 1 it Documents )
2 {8 Banana Slug Lyrics @ Wellesley _ | printed nextt(()abe 2. Select the options you want, and then close the
- selected item can PrintMonitor window.
( cancel Printing ] [ set Print Time... | be removed from
- — the list)

Printing Status: Sea Lion|Salute

One Page To Print Click to set a
status: starting job . .
print time.

Click to stop printing the Description and status of the
current document. current printing job appear here.
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Working with fonts

A font is a collection of letters, numbers, and symbols in a
distinctive typographic design.

Several fonts come with your computer’s system software. They
are stored in the Fonts folder (inside the System Folder on your
startup disk). You can install additional fonts and remove fonts.

Additional fonts are supplied in the Extras folder on your hard
disk.

Outline fonts and bitmap fonts
The Macintosh uses two types of fonts:
= outline fonts
m  bitmap fonts

Both types of fonts are installed in your System file when you
install system software.
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Outline fonts (also called scalable or variable-size fonts) can
appear at any size, because each character is described as a
mathematical formula that adjusts according to the size you want.

Your computer needs only a single outline font in a particular
typeface (such as Courier) to display or print that typeface in any
size. The outline fonts supplied with Macintosh system software
are called TrueType fonts.

g

Courier




Bitmap fonts (also called fixed-size fonts) appear only in certain Installing fonts
sizes, because each character is a grid of black-and-white dots
(called a bitmap), which is a rendering of the character’s shape in

a specific size. 2. Locate the font you want to install, and drag it to the

System Folder icon (not the System Folder window) on
your startup disk.

1. Quit all open programs.

Fonts are supplied either as individual files (for individual
fonts) or in suitcases (for font families). To install an entire
font familiy, drag its suitcase to the System Folder. If you want
to install an individual font within a family, open the
appropriate suitcase to see the individual font files.

For the best type quality when using bitmap fonts, your computer A message lets you know that the font will be stored in the
needs a separate bitmap font in each size you want to display or Fonts folder.
print, such as 12-point Times or 9-point Monaco. 3. Click OK.

Monaco 9
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Removing fonts

1.
2.
3.

Quit all open programs.
Open the System folder on your startup disk.
Locate the Fonts folder and open it.

The Fonts folder contains font files (for individual fonts) and
font suitcases (for font families). If you want to remove an
individual font within a family, open the appropriate suitcase
to see the individual font files.

Locate the font you want to remove, and drag it out of
the Fonts folder window and out of the System Folder
window.

Close the Fonts folder window and the System Folder
window.
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Transferring fonts to a LaserWriter printer

If you're using a LaserWriter printer equipped with PostScript and
you want to print with PostScript fonts that are not built into your
printer, you can transfer, or download, those fonts from your
System Folder to the printer. Downloading fonts saves printing
time if you plan to print several documents that use those fonts.

When you download a font, it’s stored in the printer’s memory or
on a hard disk attached to the printer. You can download as many
fonts as the printer’s memory and hard disk space allow.

You download fonts with the LaserWriter Font Utility, which is
supplied on your hard disk.

1. Locate and open the LaserWriter Font Utility icon.

=

LaserYriter Font Utility



. Choose Download Fonts from the File menu.

. If the font you want to download is not listed, click the

Add button to add fonts to the list.

—Download to
@® Printer
Q Printer’s giskis)

Fonts to download:
Courier
Courier-Bold

e

Courier-BoldObliqu

)

Fonts available
for downloading

Courier-0blique
Helvetica
Helvetica-Bold

2]
— Add.. ] [ Bemope ]———
( cancel ] [ Download JI— |

Click to remove
selected fonts
| from the list.

L Click to download

all listed fonts

Click to display a directory dialog box for
locating and selecting additional fonts.

to the printer.

Use the directory dialog box that appears to locate the fonts

you want.

4. In the directory dialog box, locate your font, click its
name, and then click Add.

[&2 condensed Garamond ¥ |

[ GaramBollta e Hard disk
D GaramlLig

D GaramLiglta
O GC Printer Fonts Desktop

D GC Screen Fonts

5. When you've added all the fonts you want to download,

click Done.

The fonts you added are listed in the Font Utility dialog box.

6. Click Download to send all the fonts in the list to the

printer or its hard disk.

7. Click OK when downloading is finished.

8. Choose Quit from the File menu.
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Finding out about available fonts

Many programs have a Font menu that lists the fonts installed in
your system, though some programs do not list them all. You can
open the Fonts folder, inside the System Folder, to see all the
fonts stored there. You can also see available fonts with the Key
Caps desk accessory in the Apple (@) menu.

The LaserWriter Font Utility program (supplied with the system
software disks) provides three ways to see the fonts available for
printing on a LaserWriter: you can display a list of fonts on the
screen, print a font catalog, or print a set of font samples.

Displays a

list of all fonts Download Fonts... %D
available to—{ _pisplay Available Fonts... %L
the printer initislize Prinlter’s Bisk..,

Page Setup...
Prints a list—{_Print Font Catalog... %P
of the fonts Print Font Samples...
available to
the printer Quit %0

Prints a sample of each font
available to the printer
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Other ways to use the LaserWriter Font Utility
You can also use the LaserWriter Font Utility program to
» initialize a hard disk attached to a printer

» control whether a start page is printed

m restart a printer

» send PostScript files to a printer

Initializing a hard disk attached to a printer

You can attach a hard disk to some printers. A hard disk allows
you to store more fonts. See the manual that came with your
printer for information about connecting a hard disk.

1. Make sure the corret printer is selected in the Chooser.
2. Open the LaserWriter Font Utility icon.

3. Choose Initialize Printer’s Disk from the File menu.

4

. Click the Drive button until you see the name of the
hard disk you want to initialize.

5. Click Initialize.

Initializing erases any information that was on the hard disk.



Restarting a LaserWriter printer Turning the printer’s start page on or off

Restarting the printer clears its memory, removing the fonts The LaserWriter can print a start page each time it is turned on or
stored there. restarted.
1. Open the LaserWriter Font Utility icon. 1. Open the LaserWriter Font Utility icon.
2. Choose Restart Printer from the Utilities menu. 2. Choose Start Page Options from the Utilities menu.
3. Click Restart. 3. Click the On or Off button.
A fire you sure you want to Loseririer Printer start page:
restart your PostScript printer? LT" ®0n
Doing so will erase all fonts in o @ O off
the printer's memory.

I Cancel I Restart
R

4. Click OK.
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Transferring a PostScript file to a LaserWriter 4. 'Type a name for the log, and then click Save.

You can use the LaserWriter Font Utility to send a file in PostScript The file is sent to the printer and a record of the PostScript
format to a LaserWriter printer. activity is saved in the log.
1. Open the LaserWriter Font Utility icon. You can open the log to see the sequence of PostScript

hen the file was sent.
2. Choose Download PostScript File from the Utilities commands when the file was sent

menu.

3. Click the name of the file you want to download to the
printer, and then click Open.

A dialog box asks you to save a file that will contain a record of
the PostScript activity.

o Travel disk v o Travel disk
0O Art ideas
0O CCMC Stuff -
D Class Schedule Desktop
0O New figs
O Taiko Report
D to Roy
Save PostScript output as:
PostS(:ript Log

The name of a log that
records PostScript activity
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Chapter 12

Using Your Computer Xhat networking offerj |
on a Network oureonp you ar

In this chapter

= Gain access to information on other computers.

»  What networking offers
» Setting up your Macintosh on a network

»  Gaining access to files on shared disks

»  Working with files and folders on other computers

»  Sharing your own files

»  Using access privileges

» Linking programs
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You can designate specific folders and hard disks on your

computer as “shared files” that other people can gain access to.

= Print documents on network printers.

7]

7

» Link your programs to programs on other computers.

You can link your programs in order to share features between
those programs.
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» Update files over the network automatically.

-
2 —
AT P
e -
\

You can automatically update documents created in programs that
use the Macintosh system software’s publish-and-subscribe
feature. (See the instructions that came with your programs for
information about publish-and-subscribe.)

Setting up your computer on a network

Before you can use your computer on a network, you need to
physically connect your computer to the network and install
networking software.

If a network administrator manages the network to which you'll
be connecting your computer, ask that person for advice or help.



Connecting to a network

Your computer has built-in AppleTalk networking software. This
software directly supports the LocalTalk cables you need to
connect your computer to the network. (If your computer has the
appropriate port or expansion card, AppleTalk also supports
Ethernet and TokenRing cables.)

1. Choose Shut Down from the Special menu.

2. Connect the LocalTalk cable to the printer port (&) on
the back of your computer.

If your computer has a combined printer/modem port,
connect the LocalTalk cable to that port.

See your network administrator or the documentation that
came with your cables if you need more information.

0 .
= Printer port

|
O

Ug

Turning on AppleTalk

The first time you turn on your computer after you have
connected it to a network, you need to make sure that
AppleTalk is turned on.

1. Choose Chooser from the Apple (&) menu.
2. Click the Active button to turn on AppleTalk.

f === Chooser
8 Select a file server:
[} = T ‘
g — r 1_f1c1t31 Intelligence iy
AppleShar AppleTalk...geWriter Artiste
N Corner Pocket
General Purpose
= eshitieg Greg's Macintosh
Image¥Writer LaserWriter Kitty Margola's Macintosh
Monterey
AppleTalk Zones: Niles Davis's Macintosh
Engineering i Sonoma
Ventura
Marketing 1=
Production
Publications
Research
@ Active
K% (RrIEEIN QO Inactive
AppleTalk must be

active before you can
use a network.

continues »
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3. Close the Chooser.

When AppleTalk is active, Macintosh PowerBook computers go to
sleep automatically only when they run out of battery power, or
when the power adapter is plugged in and the PowerBook is not
connected to any shared disks on the network.

Naming your computer and its owner

Before you use the network, you should give your computer a
name and name yourself as its owner.

1. Choose Control Panels from the Apple (&) menu and
open the Sharing Setup icon.

ﬂ

Sharing Setup

% Ifyou can't find or can’t open the Sharing Setup icon: Check
whether the Sharing Setup icon is in the Control Panels folder
and the File Sharing and Network icons are in the Extensions
folder inside the System Folder. «
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2. Type your name in the box labeled Owner Name and

press Tab.

[l==—————-— Sharing Setup

Network Identity

Owner Name:

onathon Janss
Owner Password:

Macintosh Name : I\Jonakhon Jones's Macintosh

Type your password in the box labeled Owner Password
and press Tab.

Your password can be up to eight characters long. Remember
the capitalization you use. After you press Tab, your password
is replaced by bullets () so no one can read it.

Type a name for your computer in the box labeled
Macintosh Name.

This is the name others will see when they access your
computer on the network.

5. Close the Sharing Setup control panel.



Gaining access to files on shared disks

You can retrieve and store information on other computers
connected to your network. For example, a colleague can

place some files for you on a shared disk called a file server—

a computer dedicated to storing shared files. Individually owned
computers on your network might also have shared disks.

Before you begin

Before you store or retrieve information on the network, do the
following:

Find out the name of the shared disk you want to access and
the name of the computer that it’s on.

If your network has zones, find out the name of the zone that
computer is in.

Find out if you are registered on the computer or if it allows
guest access.

A computer owner or network administrator can limit access
to files on a shared disk. Ask the owner or network
administrator what type of access you have to the files.

If you're a registered user, find out the name and password
you need to use.

Find out exactly how your name and password are spelled,
including capitalization.

Connecting to a shared disk

1. Choose Chooser from the Apple (6) menu.

2. Make sure that AppleTalk is active.

3. Click the AppleShare icon in the upper-left section
of the Chooser window.

AppleShare icon
EDE Chooser
i
: Select a file server:
ol g, Ak . _
) =5 Artificial Intelligence 4]
Apple'l':alk...ge:WriQe Artiste
N Corner Pocket
f=] _‘ General Purpose
= i) Greg's Macintosh B
Image¥riter LaserWriter Kitty Margola's Macintosh
Monterey
AppleTalk Zones: Niles Davis's Macintosh
Engineering it Sonoma
Ventura
Marketing = | [
Production
Publications

Research

@ Active
QO Inactive

T AppleTalk

File servers and other
computers with shared disks

continues »
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« Ifthe AppleShare icon does not appear: Make sure that 7. Click Guest or Registered User.
AppleTalk is active in the Chooser. Make sure that the
AppleShare file is in the Extensions folder in your System

Folder, and restart your computer. « %
“ 9 ] Connect to the file server "Artiste" as:
4. Ifyou see a box labeled “AppleTalk Zones”, click the Click here if
zone the computer is in. O buest you are not
@® Registered User registered on
Computers with shared disks are listed as file servers on the NEE R KRS | the computer

network. Password: (Scrambled) that you’re
I:I connecting to.

5. Click the name of the computer you want to use.

(cancel ] (setpassword] [ ok ||

If the name you want isn’t listed, make sure you have selected
the correct zone (if your network has zones), and make sure
the other computer is turned on.

6. Click OK. If you are a guest, click Guest and go to step 10. If the Guest
option is dimmed, guests do not have access to this computer.

8. Ifyou are a registered user, make sure the name in the
box is correct.

Capitalization does not need to match.
9. Type your password.

Capitalization does need to match.
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10. Click OK.

If your password is not accepted: Make sure that Caps Lock is
not on. Type your password again, taking care not to make
typing errors. If it’s still not accepted, ask the computer’s
owner for help.

11. Click the name of a shared disk to select it.

fArtiste

Select the items you want to use:

[®

ooogd
<l
L |

Shared disks
and folders

Adam's Folder
Boilerplate
Hichaer frd

Checked items ([X]) will be opened at
system startup time.

Dimmed items are not available to you,
or you're already connected to them.

12. Click OK.
The icon of the shared disk appears on your desktop.

13. Close the Chooset.

Disconnecting from a shared disk

When you're finished using a shared disk, close any open files
or programs on the shared disk and then disconnect in one of the
following ways:

» Select the shared disk icon and choose Put Away from the File
menu.

» Drag the shared disk icon to the Trash.

»  Choose Shut Down from the Special menu. Shutting down
automatically disconnects from the shared disk.
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Connecting quickly to a shared disk

By making an alias for a shared disk, you can connect to that disk
by simply opening the alias.

1.

Connect to a shared disk.

See the section on connecting to a shared disk in this chapter.
Select the shared disk icon.

Choose Make Alias from the File menu.

Put the alias in a convenient location and rename it if
you wish.

Next time you want to connect to the shared disk, open
the alias you created in step 3.

If you originally connected to the shared disk as a

registered user, a message appears. Type your password.

If you connected to the shared disk as a guest, this message
does not appear.

The shared disk icon appears on your desktop.

If the shared disk is on a computer that is turned off, or if
there is a problem with the network, you'll see a message.
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Connecting automatically when you start up

You can connect automatically to one or more shared disks
whenever you turn on your computer.

1.

Connect to the computer that has the shared disk you
want to open.

See the section on connecting to a shared disk in this chapter.

2. Click the checkbox next to the name of the shared disk.
Click one
of these % Artiste
buttons to Select the items you want to use:
indicate N
whether Adam's Folder X7
. Boilerplate O
you want to Richner Art Oz
enter your Checked items ([X]) will be opened at
pzlSSWOl‘d system startup time.
at startup., ——| 4ED Save My Name Only
(O Save My Name and Password
Click a box to connect

automatically when you start
up your computer.



3. If you're connecting as a registered user, click the
button that indicates whether you want to save your
name only, or both your name and your password.

For more security, click “Save My Name Only.” When you start
up your computer, you'll need to enter your password to
connect to the shared disk.

4. Click OK.
5. Close the Chooset.

Working with files and folders
on other computers

Once you are connected to a shared disk, you can use the files
and folders on it as if they were on your own computer.

You may not be able to open some items on a shared disk if the
owner has restricted access to those items. For information on
how to check your access privileges, see “Working With Privileges
That Others Have Set” later in this chapter.

Creating a new folder on another computer

You can create a new folder on a shared disk (as long as you have
the correct access privileges). If you are a registered user, you
become the owner of any folder that you create. If you are
connected as a guest, you share ownership of the folder with all
guests and registered users.

The icons of folders that you own on another disk have a
darkened tab.

My Folder

When you own a folder, you can determine who can use it and
in what way. See “Using Access Privileges” later in this chapter for
more information.

Changing your password

If you are a registered user, you may be able to change the
password you use to connect to a shared disk. (Your network
administrator can restrict this capability.)

1. Connect to the computer that has the shared disk
you want.

2. Click the Set Password button.

continues »
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3. Type your current password. Then press Tab and type a
% new password.

Connect to the file server "fArtiste" as:

Abullet () appears for each letter you type.

QO Guest
@ Registered User
Name: |Jonathon Jones |
Password: |:| (Scrambled) 0ld password: l:l
New password: l:l
(cancel ] [setPassword) 0K

Click here to change
your password. 4. Click OK

5. Click OK in the dialog box that appears.
If a message tells you that you cannot change your password,

your network administrator has turned off this feature. 6. Retype your new password and click OK.

Your new password is now in effect.
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Giving folder ownership to someone else

You can give away ownership of any folder you own. Once you do
s0, however, the new owner can restrict your access to that folder.
Make sure you have copies of any files you may need before you
give ownership of a folder to someone else.

1.

Connect to a shared disk.

2. Click a folder that you own to select it.
3.
4

. Type the name of a registered user or group in the box

Choose Sharing from the File menu.

labeled Owner.
Close the Sharing window.

A message asks you to confirm that you want to change the
owner of the folder.

Click OK.

The user or group that you named assumes ownership
immediately.

Sharing your own files

You can share files stored on your computer with others on

the network. For example, members of your work group can
connect to your computer and open a file from their own
computers. (They do not have to be using System 7.) Or, if you
have both a desktop Macintosh and a PowerBook computer, you
can transfer files from one computer to the other without using
floppy disks.

You control what you share and with whom you share it:
» You share only the items you specify.

= You share only with the people you specify—one person,
a group of people, or everyone on the network.

= You can see everything on your own computer from another
computer on the network.

How file sharing works
There are three steps to sharing a folder or disk:
1. turn on file sharing

2. select a folder or disk to share

3. decide whom to share it with

The folder or disk you share is not accessible to anyone but you
until you choose whom to share it with.
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Turning file sharing on

1. Choose Control Panels from the Apple (&) menu and

open the Sharing Setup icon.

ﬂ

Make sure the boxes in the Network Identity section of the

Sharing Setup

control panel are filled in.

2. In the section labeled File Sharing, click the
Start button.

O

Sharing Setup

Network Identity
Owner Name:

yorathon areses

Macintosh Name : Idona(hon Jones's Macintosh

+Status

i File sharing is off. Click Start to allow other users
Start i
i to access shared folders.

Click here to start file sharing.
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3. Close the Sharing Setup control panel.

If you want to give everyone on the network access to the items
you share, continue with the next section, “Turning On Guest
Access.”

Turning on guest access

If you want all users connected to the network to have access to
your shared folders and disks, you need to turn on guest access.

1. Choose Control Panels from the Apple (8) menu and
open the Users & Groups control panel.

52

Users & Groups

2. Open the <Guest> icon.



3. Click the box under File Sharing labeled “Allow guests
to connect” to place an X in it.

E[=—— <6uesb =—V11
t‘g | Flle Sharing To allow guests to connect to
BX] Allow guests to connect your computer, click here so
that an X appears in the box.
@ Program Linking
: . |:] Allow guests to link to programs
on this Macintosh

4. Close the window and click Save in the box that
appears.

You can still restrict access to any folder or disk you share, as
described in the section “Using Access Privileges,” later in this
chapter.

Continue with the next section to select a folder or disk to share.

Selecting a folder or disk to share

You can share any folder, hard disk, or CD-ROM disc connected to
your computer. (You cannot share floppy disks.) You can share up
to ten folders or disks at a time. (This number does not include
folders within the folders or disks you share.)

1. Make sure file sharing is turned on.
2. Select a folder or disk to share.

3. Choose Sharing from the File menu.
4

Click the box labeled “Share this item and its contents”
to place an X in it.

el For All Eyes
m Yhere: Jonathon Jones's Macintosh:
L : For AllEyes
Cth here to Share [he ——E Share this item and its contents

item you've selected. See  See  Make

Folders Files Changes

ey B B B
R s B = B
Everyone X X X

D Make all currently enclosed folders like this one

D Can’t be moved, renamed or deleted

For information about the other checkboxes in this window,
see “Using Access Privileges,” later in this chapter.
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5. Close the window and click Save in the dialog box. /\ Important: Before you put programs inside shared folders
or disks, remember that copyright laws may prevent those
programs from being shared. Check the applicable licensing
agreements and follow their specifications. A

At this point, only you have access to the item you shared and
the files inside it, unless you turned on guest access and some
or all of the boxes next to “Everyone” are checked.

If you haven’t turned on guest access, continue with the
section “Naming a Registered User” if you want to name the Taking back a shared folder or disk
specific people you want to share the item with. (Even if the
checkboxes next to Everyone are selected, you cannot give

access to everyone unless you've turned on guest access, as 1. Select the shared disk icon.
described in the previous section.)

Any shared folder or disk can be made private again.

2. Choose Sharing from the File menu.

sh folder, its i s with ki
IFyou shared a folder, its icon appears with a darkened tab 3. Click the box labeled “Share this item and its contents”

and network cables:
to remove the X.
. If people are connected to your computer, you see a message
asking you to confirm your decision.
:HE:

Shared Folder

When people on the network are connected to your shared
folder, its icon appears with faces in the center:

P

(&

-

:h:
Shared Folder
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Naming 1 registered user 3. Type the name of a person you want to register.

You can register as many as 100 people and groups combined, but Make sure you notify the person of the name you type.
for best network performance you should name no more than 50. (Capitalization does not have to match.)
1. Choose Control Panels from the Apple (&) menu and
open the Users & Groups icon. Em Users & Groups e
1 9"\5B Q
H . ] [D]H

Users & Groups

4. To register more users, repeat steps 2 and 3.
2. Choose New User from the File menu.

To assign passwords or to name groups of users, continue
with the next two sections. If you want to start sharing
immediately, go to “Selecting a User or Group to Share a

< Ifyou can’t find the New User command: Make sure the Folder or Disk,” later in this chapter.
Users & Groups window is active. <

An icon labeled New User appears. Its name is selected
for editing.
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Setting a registered user’s password Naming a group of users

You can assign passwords for registered users to verify their You can name several registered users as a registered group.

identities when they want to gain access to your computer.
Y 8 Y P 1. Open the Users & Groups control panel and choose

1. Open a user icon in the Users & Groups control panel. New Group from the File menu.
An icon labeled New Group appears. The name is selected for
EC=——= Niles Davis =—=—= editing.
User Password: [:' Type the User’s
password here.
Q File Sharing El| Users & Groups =—"—=015
[X] Allow user to connect § items
E Allow user to change password _{_}_
Groups : @ @
ﬁ Jonathon Jones Guest>
2 EF
Niles Davis Barb Hughes Ellen Fitzwater
@ Program Linking ]
: : |:| Allow user to Tink to programs (::l] |¢> o
on this Macintosh

2. Type a name for the group.
2. Type a password in the User Password box, then

press Tab.

The password can be up to eight characters long. When you
press Tab, the password is replaced by bullets. Make sure to
inform the user of the exact password, including
capitalization.

3. Close the window, and then click Save in the dialog
box.
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3. Drag user icons to the new group icon.

The icons are not moved inside the group icon, as they would
be if it were a folder. Instead, member icons are created inside
the group icon. You don’t need to drag your own icon to the
group icon because you (as the owner) have access to the
entire contents of your computer (unless you specify
otherwise).

You don't need to include the <Guest> icon in any group.

To allow this group access to a shared folder or disk, go to the
section “Selecting a User or Group to Share a Folder or Disk.”

Seeing who'’s in a group

= To see the names of all group members, open the group
icon.

E[IE=—=—==Testing Team =51

3 items

Ellen Fitzwater Barb Hughes Niles Davis

kel

al B

You can open any member icon to see or change the settings
you've made for that user.

To see all the groups that a user belongs to, open the
user’s member icon or user icon.

Niles Davis

User Password:

File Sharing

E Allow user to connect

E Allow user to change password

Groups :

Testing Team
Crackerjack Team
Lunch Group

@ Program Linking

D Allow user to link to programs
on this Macintosh

>

L The groups the user
belongs to are listed here.

el
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Selecting a user or group to share a folder or disk

You can give one registered user or group exclusive access to a
shared folder or disk on your computer.

1.
2.

Select a folder or disk to share.
Choose Sharing from the File menu.

Click the box labeled “Share this item and its contents”
so an X appears.

Choose a user or group from the User/Group
pop-up menu.

E—————— T Eyes
Yhere: Jonathon Jones's Macintosh:
For AllEyes
= ¢

[X] Share this item and its contents

See See Make
Folders Files Changes

ovner: Dtm i~ © ® K
User /Group: | ® <None> X X X

Testing Team X X X

———— | Crackerjack Team
[[] Make all cur|  Lunch Group Tike this one

[[] Can’t be moy _ Niles Davis
Etark Hughes
Ellen Fitzwater

Jonathon Jones
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5. To share the item with only the user or group you’'ve
chosen, click the bottom row of checkboxes (next to
Everyone) to remove the X from each box.

ECI=—=— For All Eyes

Yhere: Jonathon Jones's Macintosh :
For All Eyes
= ¢

E Share this item and its contents

See See Make
Folders Files Changes

ovner: [Tl @ © K
vsersorow: g T1 @ © K

Everyone D D D —

D Make all currently enclosed folders like this one

D Can’t be moved, renamed or deleted

| Remove the X marks in
this row.

6. Close the window and click Save in the dialog box.



Preventing specific users or guests from accessing 2. To deny access to a specific user, open the user icon.
your computer

To prevent all network access to your computer, you can turn file = Niles Davis
sharing and program linking off, as described elsewhere in this User Password:
Chapter. : | File Sharing
1. Choose Control Panels from the Apple (8) menu and 2 e e v et
ow user to change password
open the Users & Groups icon.
Groups :
Testping Team 4
Cracker jack Team |
Lunch Group ||
A

H gl @ Program Linking
|:| Allow user to Tink to programs

Users & Groups on this Maointosh

3. To deny access to guests, open the <Guest> icon.

=)
I

<Guest>

EC]
File Sharing

E Allow guests to connect

@ Program Linking

D Allow guests to link to programs
on this Macintosh

continues »
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4. If an X appears in the “Allow to connect” checkbox,

click to remove the X (to deny access).
. Close the window and click Save in the dialog box.

If you deny access to a user who is currently connected, he or
she is disconnected immediately. That user is no longer a
member of any group, and can connect only as a guest.

If you deny access to guests, any guests currently connected
are disconnected immediately. Only registered users and
groups that you've specified will have access to your
computer.
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Removing a user from a group

1. In the Users & Groups control panel, open the
group icon.

2. Drag the member icon for that user to the Trash.

3. Choose Empty Trash from the Special menu.

Removing a user or group from your list of
registered users

You can remove a registered user or group at any time. When you
remove a user, he or she will no longer be a member of any
registered group.

1. Open the Users & Groups control panel.
2. Drag the user icon or group icon to the Trash.
3. Choose Empty Trash from the Special menu.

If the user is currently connected, he or she is disconnected
immediately.

You cannot throw away the <Guest> icon or the owner icon.



Giving away ownership of a folder or disk on
your computer

You can give away ownership of a shared folder or disk on your
computer to a registered user or group.

Because you are the owner of your computer, the new owner of a
folder or disk on your computer cannot restrict your access to it.
However, the new owner can change the access privileges

that other people have to the item. If you give away ownership of
a folder or disk, make sure to remove any folders or documents
that you don’t want others to see or change.

1. Select a shared folder or disk.
2. Choose Sharing from the File menu.

3. Choose a name in the Owner pop-up menu.

EL] For All Eyes
Yhere: Jonathon Jones's Macintosh:
For AllEyes
= ¢

E Share this item and its contents

See See Make
Folders Files Changes

Owner: | <Any User> X X X

User/Group: [ Testing Team X X X
Crackerjack Team

Lunch Group X X X

] Make all cur|_Niles Davis like this one
Eiark Hughes -
[J can’tbe mo|[ " Ellen Fitzwater |

® Jonathon Jones

If you select <Any User>, then anyone on the network can
change the access privileges or ownership of the item.

4. Close the window and click Save in the dialog box.

5. Click OK to confirm that you want to change
ownership.

Turning file sharing off

You can turn file sharing off at any time. When file sharing is off,
people on the network cannot access folders or disks on your
computer, and you cannot access your computer from another
computer on the network.

When you turn file sharing back on, the items you shared before
are available again automatically.

1. Choose Control Panels from the Apple (&) menu and
open the Sharing Setup icon.

H

Sharing Setup

continues »
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2. In the section labeled File Sharing, click the Stop
button.

A dialog box appears in which you can specify a delay before
file sharing is turned off. If you specify a delay, users who are
connected to your computer are warned to save their work
and disconnect.

How many minutes until file
sharing is disabled?

Cancel l 0K |

3. Type the number of minutes you want to elapse before
file sharing is turned off.

To turn file sharing off immediately, type the number 0.

4. Click OK.

If someone is using files on your Macintosh when file sharing is
turned off, any changes he or she has not saved will be lost.
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Monitoring file-sharing activity

When file sharing is on, you can see who is connected to your
computer and what folders or disks you've shared.

= Choose Control Panels from the Apple (#) menu and
open the File Sharing Monitor icon.

B
1

——1—3
File Sharing Monitor

S ====—=—= File tharing Monitler B=————+

Jonathon Jones's Macintosh

{1 shared Items (3 Connected Users
Becky's folder 4> [@ <Guest> aty
Get Your Reports Here | [@ Niles Davis |
For AllEyes

N N

File Sharing Activity:

Bisconnect

| I
Idle Busy




Disconnecting someone who is connected to
your computer

You can disconnect users who are currently connected to your
computer in the File Sharing Monitor control panel.

1. Select the user or users you want to disconnect.
2. Click Disconnect.

3. Type the number of minutes that you want to elapse
before users are disconnected.

How many minutes until selected
users are disconnected?

If you specify a delay, users are warned to save their work and
disconnect. To disconnect a user immediately, type 0.

4. Click OK.

A message remains on the screen until the time is up. You can
switch to any program you already have open so you can
continue working.

5. When the designated amount of time has elapsed, close
the File Sharing Monitor.

Gaining access to your computer
from another computer

You can connect to your own computer from another computer
on the network and access everything on the disks attached to
your computer.

1. Make sure that file sharing is turned on.

2. Choose Control Panels from the Apple (8) menu and
open the Users & Groups icon.

52

Users & Groups

continues »
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3. Open the owner icon (the one with the bold outline).

4. Click the boxes labeled “Allow user to connect” and
“Allow user to see entire disk” to place an X in them.

Jonathon Jones zl

O

File Sharing

E Allow user to connect
E Allow user to change password
E Allow user to see entire disk

Groups:

[©

<l

When these boxes are checked, you can see and use
everything on your disks while you're using another
computer.

To restrict your access, click a checkbox to remove the X.
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5. Close the window and the Users & Groups
control panel.

6. Leave your computer turned on.

To gain access to your computer, connect to it as a registered
user. Type your owner name and password as they appear in the
Sharing Setup control panel of your computer. Then connect as
you normally would.

< Ifyou are unable to connect to your computer: Make sure
that your computer is turned on, that your computer has file
sharing turned on, and that you have the correct access
privileges. Make sure that you type your password exactly as it
is entered in the Sharing Setup control panel, including
capitalization. «

Changing your password

You can change the password you use to gain access to your own
computer from another computer.

1. Choose Control Panels from the Apple (&) menu and
open the Sharing Setup icon.

H

Sharing Setup



2. Type a new password in the box labeled Owner Using access pl’iVﬂCgﬁS

Password and press Tab.
Access privileges let you control what other people can do with
the information you share on a network. For example, you might
S == sharingSetup == want to let people see a file but prevent them from changing it.
Network Identity
T Gunertiome: DTS Understanding access privileges

Owner Password:

Macintosh Name : |Jona(hon Jones's Macintosh

You can set access privileges for any shared folders on your own
computer and any folders you create on another Macintosh.
Owners of other computers can set access privileges that restrict
what you can do with their shared disks.

Remember the capitalization. Your password is replaced by

bullets to keep it private. Three categories of people can have access privileges to shared

disks and folders:

. Close the Sharing Set trol L.
3. Close the Sharing Setup control pane n The owner: The owner of a folder can change the access

Your new password is now in effect. privileges to that folder. You become the owner of a folder
automatically when you create it and you are the owner of any
folder on your computer. You can keep ownership or give it
away.

n Aregistered user or group: A registered user has special
access to shared disks over the network. A registered group is
a group of registered users.

» Everyone: This category includes the owner, registered
users, and guests.
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There are three types of access to shared items:
» See Folders: allows people to see, open, and copy folders.
m See Files: allows people to see, open, and copy files.

» Make Changes: allows people to copy, delete, or change the
contents of a folder or disk, or to add items to a folder or disk.

The table indicates which privileges you need to see folders, see
files, or make changes to items in a shared folder or disk.

Make

Action See Folders See Files Changes

Copy or move files to a folder
Copy a file from a folder
Copy a folder from a folder
Create a folder in a folder
Delete a file from a folder
Delete a folder from a folder

Open and use a file in a folder

OO0OXOXKX O O
NXOXOOX O
KOXKXXOOKX

Save changes to a file in a folder
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Setting access privileges to folders and disks

You can set access privileges for shared items on your own
computer and for items that you own on other computers.

1. Select a folder or disk.
2. Choose Sharing from the File menu.

The dialog box you see may be slightly different from the one
pictured.

For All Eyes

Jonathon Jones's Macintosh:
For AllEyes

SIE=———
Q: Yhere:

[X] Share this item and its contents

See See Make
Folders Files Changes

ovner: Gt ~] . ®
vserforow: (T~ R R K
Everyone X X X

|:| Make all currently enclosed folders like this one

D Can’t be moved, renamed or deleted

» Ifyou've selected a folder inside a shared folder, the
checkbox at the top is labeled “Same as enclosing folder.”

n Ifyou've selected a folder on another computer, the
Owner and User/Group areas are text boxes, not
pop-up menus.



» Ifyou've selected a folder you do not own, all the
checkboxes and their labels are dimmed.

3. Choose a registered user or group to share the
item with.

Choose from the list of users and groups in the pop-up menu,
or type the name of a registered user or group in the box.

4. To set access privileges, click the appropriate checkbox.

» To set the same privileges for the folders within this folder
or disk, place an X in the box labeled “Make all currently
enclosed folders like this one.” If you're working with an

item that contains a large number of folders, such as a CD-

ROM disc, this action may take a few minutes to complete.

= To prevent the folder from being changed, place an X
in the box labeled “Can’t be moved, renamed, or deleted.”
If you check this box, no one—not even you—can change
the folder. (The folder can still be viewed and copied.)

» Ifyou want the folder to have the same privileges that the
folder or disk enclosing it has, place an X in the checkbox
labeled “Same as enclosing folder.” This box only appears
for folders inside shared folders. When you move such a
folder to another folder, its access privileges change
automatically to reflect those of the enclosing folder.

5. When you're finished setting access privileges, close
the Sharing dialog box and then click Save in the dialog
box.

Access privilege strategies

Access privileges can be combined in several ways. A few common
and useful strategies are summarized here.

» Allow everyone on the network all access privileges.
As long as you've turned on guest access, everyone on the
network can open, read, and change the files and folders.

See See Make
Files Folders Changes

Owner E g E
User /Group X X X
Everyone E IZI IZI

continues »
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= Keep a folder or disk private. To keep a folder or disk on
your own computer private, do not share it. To keep your
folder on another computer private, use these settings.

See See Make
Folders Files Changes
Owner IE XI E

User /Group O O O
Everyone D D D

= Allow access to one other person or group. This set of
privileges allows the owner of the item and one registered

user or group to use the item.

See See Make
Folders Files Changes
Owner E E E
User /Group X X X

Everyone D I:l I:I
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Keep a folder private but allow others to place files or
folders into it. People on the network can deposit files or
folders into this folder but only the owner can see, remove, or
change its contents. (This configuration is sometimes called a

drop box.)

See See Make
Folders Files Changes
owner X X X
User /Group O O X

Everyone D D E

Set up a folder as a bulletin board. People can open and
read the files in this folder but cannot change them. Only the
owner can add files.

See See Make
Folders Files Changes

Owner !ZI E g
User /Group X X |
Everyone E E D




Working with privileges that others have set

When you are using the By Icon or By Small Icon view, the
appearance of shared folders indicates the access you have.

Icon Meaning

N A darkened tab indicates that you own the folder
and can set its access privileges.

anN A plain tab indicates that you can open and use the folder.

A strap indicates that you cannot open and use the folder.

A strap with an arrow indicates that you can put files

¥
@ or folders into the folder, but you cannot open it or

use any files or folders within it.

Checking your access privileges

When you open a folder on another computer, icons under the
title bar indicate the privileges that you do not have.

= = =
You can’t You can’t You can’t
make changes see files in see folders
to files in this this folder. in this folder.
folder.
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Linking programs

Some programs can exchange information directly with other
programs. For example, one program might be able to instruct
another program to add a row to a spreadsheet or change the font
size of a paragraph.

Programs implement linking in various ways and not all programs
have this capability. See the documentation that came with your
programs for more information.

Linking to a program on another computer
You can only link to programs that are shared.

1. Within your program, choose the menu command that
allows you to link programs.

The menu location and command name depend on the
program you're using. You use a dialog box to find the
program that you want to link to.
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Choose a program to link to:
Macintoshes Programs
Artiste £ J|cCADWorks ufs
Diane's Macintosh The Bottom Line
Monterey WordRighter
Niles Davis's Macintosh
Ventura I
AppleTalk Zones

Engineering i
Graphics
Marketing
Production 7]
Publications
Research o (cancet ] [ sx

If your network has zones, select a zone in the lower-
left section of the dialog box.

Select the Macintosh you want to connect to in the
upper-left section of the dialog box.

Select the program you want to link to.



5. Click OK.

In most cases, you need to identify yourself as a guest or a
registered user.

&

Connect to program "BeanCounter"” as:

O 6Guest
@® Registered User

Name: | Jonathon Jones l

Password: |:|

6. Click Guest or Registered User.

If you are a guest, click Guest and go to step 9. If the Guest
option is dimmed, guests do not have access to this computer.

7. Ifyou are a registered user, make sure that the name is
correct.

8. Type your password.
9. Click OK.

The two programs are now linked.

Disconnecting a program link

To disconnect a link to a program on another computer, quit the
program you used to create the link.

Allowing other people to link to your programs

You can allow people on the network to link to programs on your
computer.

m  First you turn on program linking.
»  Then you make a program available for linking by sharing it.

= Then you either allow guest access or allow specific people to
link.

= Finally, you open the program.

These steps are outlined in the following sections.
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Turning program linking on

When you turn program linking on, your computer is visible to
others on the network whenever they attempt to link a program.
Before you turn program linking on, make sure that AppleTalk

is active and that you have named your Macintosh in the Sharing
Setup control panel.

1. Choose Control Panels from the Apple (&) menu and
open the Sharing Setup icon.

2. In the section labeled Program Linking, click the
Start button.

EmS—————=|ShalingjSetup
Network Identity

Owner Password:

Macintosh Name : IJona(hon Jones's Macintosh

i File sharing is off. Click Start to allow other users
Start ; i
i to access shared folders.

@ Program Linking

Status

Program linking is off. Click Start to allow other
Start ; - i
i users to link to your shared programs.

3. Close the Sharing Setup control panel.

Once program linking is turned on, you must select programs
to share before network users can link to them, as described
in the next section.
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Selecting a program for linking

Before a network user can link to your program, you need to
share it.

1. Quit the program if it’s open, then click its icon to
select it.

2. Choose Sharing from the File menu.

3. Click the box labeled “Allow remote program linking”
to place an X in it.

YordRighter

Kind : application program
Where: Jonathon Jones's
Macintosh :WR Folder :
YordRighter

Program Linking

[] Allow remote program tinking—|—— Click here to share this program.

If the box is dimmed, the program does not support linking.
4. Close the window.

At this point, no one but you can link to the program until you
turn on guest access or name registered users, as described in
the following sections.

5. Open the program.



Allowing guests to link to your programs

You can let everyone on the network link to your shared
programs.

1. Choose Control Panels from the Apple (#) menu and
open the Users & Groups icon.

2. Double-click the <Guest> icon.

3. Click the box labeled “Allow guests to link to programs
on this Macintosh” to place an X in it.

El <Guestr ==

File Sharing

E Allow guests to connect

@ Program Linking

I:] Allow guests to link to programs
on this Macintosh

4. Close the window.

Guest users can now link to any of the programs you're
sharing, as long as the programs are open.

Naming specific users to link to your programs

You can identify the registered users and groups you want to link
to your programs.

1. Choose Control Panels from the Apple (#) menu and
open the Users & Groups icon.

2. Open the icon of a user.

3. Click the box labeled “Allow user to link to programs
on this Macintosh” to place an X in it.

[ Niles Davis ===

User Password: l:l

File Sharing

F=

E Allow user to connect
|Z| Allow user to change password

Groups :

<

@ Program Linking

D Allow user to Tink to programs
on this Macintosh

4. Close the window and click Save in the dialog box.

5. To give more registered users access to your programs,
repeat steps 2 through 4.
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Chapter 13

EXpaﬂding Your Using SCSI devices

A SCSI device is any product—including hard disk drives, CD-ROM

Computer SYStem drives, scanners, and printers—that communicates with Macintosh

computers by means of a standard electronic interface. (SCSI
stands for Small Computer System Interface.) You can attach up to

In this chapter six SCSI devices to your computer by linking them together in a
a  Using SCSI devices chain that starts at your computer’s SCSI port.
= Connecting a modem The SCSI port on Macintosh PowerBook computers looks like

this:
s Connecting a printer

= Connecting a mouse or other ADB device

»  Using sound input and output devices

= Adding memory to your computer

@: ——SCSI port icon
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To connect a SCSI device to the SCSI port on your PowerBook,
you need an Apple HDI-30 SCSI System Cable.

Setting up one or more SCSI devices for use with your PowerBook
involves the steps listed here.

» installing software

m setting SCSI ID numbers

» checking that the SCSI chain is properly terminated
m connecting cables

These steps are described in the following sections.

Installing software

Most SCSI devices come with software that allows your computer
to communicate with them. These programs are called drivers. (If
no drivers come with a device, then it doesn’t need any.) To install
a driver, follow the instructions that came with the device.
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Setting SCSI ID numbers

Each device in a SCSI chain must have a unique ID number
between 1 and 6 so the computer can identify it properly. The
information in this section can help you assign SCSI ID numbers
to the devices you want to use with your computer.

A Warning: Using two or more devices with the same SCSI ID
number can cause your equipment to malfunction. You could
lose information as a result. A

Your computer has the SCSIID number 7, and its internal hard
disk has the number 0.

See the documentation that came with your SCSI devices for
information about ID numbers and how to change them.



The ID numbers of Apple SCSI devices can be set as follows.
1. Make sure the SCSI device is turned off.

If the device is already part of a SCSI chain, make sure that all
devices in the chain are turned off, including the computer.

2. Locate the ID number indicator and switch (usually on
the back panel of the SCSI device).

ID number indicator

'
?

ID number switch

. Check the ID numbers of all the devices you want to

connect.

If all the devices have unique ID numbers, you've finished this
part of the procedure. Continue with the next section,
“Checking That the SCSI Chain Is Properly Terminated.”

. If you need to change a device’s ID number, choose an

available number between 1 and 6.

. Insert the end of a straightened paper clip into the

small hole below the ID number indicator.

The small hole gives you access to the ID number switch.

. Push the ID number switch repeatedly until the

number you want appears in the ID number indicator.
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Checking that the SCSI chain is properly terminated

To ensure accurate transmission of information, a chain of SCSI
devices must have a terminator at each end. Terminators are built
into some SCSI devices and can also be added externally.

SCSI terminator

= Your PowerBook’s internal hard disk, which is always the first
device in the chain, has a small built-in terminator. However,
for reliable information transfer in a chain of SCSI devices, it
should be supplemented with an external terminator as
described in these instructions.

» External SCSI devices from Apple do not have built-in
terminators.

» External SCSI devices from other vendors may have built-in
terminators; see the documentation that came with the
device.

226 Chapter 13: Expanding Your Computer System

If you are attaching one SCSI device
Make sure that there is

= anexternal terminator between the HDI-30 system cable and
the SCSI device and

m aninternal terminator in the SCSI device, or an external
terminator attached to the device.

If you are attaching more than one SCSI device
Make sure that there is

m aninternal terminator in the first external device, or an
external terminator between the HDI-30 system cable and the
first device;

m aninternal terminator in or an external terminator attached to
the last device; and

m no other terminator (internal or external) in the chain.

If you have too many devices with internal terminators, your
authorized Apple service provider can remove extra terminators.

Correct chain configurations are shown in the illustration on the
following page.



Connecting cables

A Warning: When making SCSI connections, always turn off
power to all devices in the chain. Failure to do so can cause
the loss of information and damage to your equipment. A

1. Shut down your PowerBook and all SCSI devices in the
chain.

2. To connect the first device, use an Apple HDI-30 SCSI
System Cable.

Attach the smaller end of the cable to your computer’s SCSI
port (marked with the icon <) and the larger end of the cable
to either SCSI port on the device.

3. To connect the next device, use a SCSI peripheral
interface cable.

Both cable connectors are the same. Attach one connector to
the available SCSI port on the first device, and the other
connector to either SCSI port on the next device.

4. Repeat step 3 for each additional device you want to
connect.

The illustration shows where to add cable terminators.

Connecting one SCSI device

Terminator

\lf this SCSI device has an internal

HDI-30 cable terminator, omit this external terminator.

Connecting more than one SCSI device

If this SCSI device has an internal
terminator, omit this external terminator.

SCSI peripheral interface cables

HDI-30 cable

A\ Important: The total length of a SCSI chain should not
exceed 20 feet (6 meters). Apple SCSI cables are designed to
meet this restriction. If you are using SCSI cables from
another vendor, check the length of the chain. A

Once your SCSI devices are connected, always turn them on
before turning on your PowerBook. If you turn the computer on
first, it may not be able to start up, or it may not recognize the
SCSI devices.
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Connecting a modem

Apple offers an optional, low-power, internal fax/data modem for
your computer. See the modem manual for information about this
modem and how to use it.

You can also connect an external modem to the modem port on
the back panel of the computer.

To connect an external modem, follow these steps.

1.
2.

5.
6.

Make sure the computer is in sleep or shut down.

Connect the modem to a power source and to the
phone line.

See the documentation that came with the modem.
Make sure the modem is turned off.

Connect the modem cable to the modem port (marked
with the icon ¥).

Turn on the modem.

Wake or restart the computer.

If your computer does not have an internal modem, the external
modem is ready to use.

If your computer does have an internal modem, continue with
step 7.
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7. Choose Control Panels from the Apple () menu.
8. Open the PowerBook control panel.

9. Click the External Modem button.

Modem

=
O Internal Modem @ External Modem

10. Close the control panel.
The external modem is ready to use.

If you have both an internal and an external modem, remember to
select the modem you want to use in the PowerBook control
panel before opening your telecommunications program.



Connecting a printer

The printer port on your computer can accept either a

direct cable connection (to a printer such as the StyleWriter)

or a network cable connection (to a printer such as the
LaserWriter IINTX). The printer port is marked with this icon: &.

Some printers, including the Personal LaserWriter SC, are
connected through the SCSI port (marked with the icon <).

Follow the instructions that came with your printer to connect it
to your computer.

A Warning: The StyleWriter printer comes with its own power
adapter. This power adapter is not interchangeable with your
computer’s power adapter. Connecting the computer’s power
adapter to the printer will not damage your equipment, but
the printer will not work properly. Connecting the printer’s
power adapter to your computer will damage the adapter.
Use each power adapter only with the equipment for which it
was intended. (You may want to label the adapters.) a

Connecting a mouse or other ADB device

Your computer has one Apple Desktop Bus (ADB) port, to which
you can connect optional low-power input devices (such as a
mouse) provided by Apple and other vendors. The ADB port has
this icon: »x.

Make sure that any such devices you connect are designed for
portable computers. Standard ADB devices designed for desktop
Macintosh computers may drain your battery very quickly, in
some cases even if the power adapter is plugged in. Low-power
devices are marked with this icon: O.

By connecting devices in a chain, you can attach up to three
devices to the ADB port. See the instructions that came with your
ADB device(s) for information about their power consumption,
and make sure that the total power drawn by all devices you're
connecting does not exceed 200 mA.
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Using sound input and output devices 3. Decide where you want to place the microphone.

A Warning: Do not plug a sound output device (such as a pair
Connecting a microphone of headphones) into the sound input port. Doing so may

. . damage your audio equipment. A
Your PowerBook has a sound input port to which you can connect ey quip

an external microphone. (Sound recording is described in the

chapter Adapting Your Computer to Your Own Use.) Sound output devices
1. Open the door covering the back panel of your The PowerBook also has a sound output port (marked with the
computer. icon 4y)) to which you can connect speakers, an amplifier,

headphones, or other audio output devices. The sound output
port accepts a standard stereo miniplug, like that used to attach
headphones to a portable tape player.

2. Plug the microphone into the sound input port on the
back panel. The sound input port has the icon ¢.

Sound input port  Microphone
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Adding memory to your computer

Your PowerBook computer comes with at least 4 MB of RAM.
By adding memory upgrade cards you can increase your
computer’s memory. You can find out how much memory your
computer has by choosing About This Macintosh from the
Finder’s Apple menu.

Apple provides memory upgrades through its authorized dealers.
Memory upgrades are also available from other vendors; ask your
dealer for more information.

Apple recommends that memory upgrades be installed by an
authorized Apple dealer.

Your PowerBook computer also supports virtual memory, a

feature that makes use of hard disk space to provide additional
RAM.

Chapter 13: Expanding Your Computer System 231



Chapter 14

Travel, S‘[Qrage’ and Service Traveling with the PowerBook

The safety instructions in the first part of this book also apply
when you are traveling. In addition, note these precautions:

In this chapter
= Do not transport your PowerBook while it is turned on.

Choose Sleep or Shut Down from the Special menu, and wait
= Storing the computer until the hard disk stops spinning, before you move the
computer.

» Traveling with the computer

= Getting service and support

» Transport batteries either inside the computer or in the
protective case provided with each battery. Do not transport
unprotected batteries.

»  Getting more information about Macintosh computers

» Bring backup copies of your system software and other
important files on floppy disks, in case you need to reinstall
them.

= Do not check your computer as baggage. Carry it with you.

» Do not allow your computer or any hard disks or floppy disks
to pass through X-ray machines. Have security officials
manually inspect your computer and disks.

m  Be prepared to show security officials that your computer is
working. Have a charged battery or a power adapter ready to
use.
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Some airlines may restrict or prohibit the use of computers in
flight. Check ahead to find out what restrictions, if any, apply.

Take the necessary plug adapters if you're traveling overseas.
(You may need to use them with the power adapter.) You do
not need a voltage transformer. The power adapter can handle
90 volts to 260 volts AC (48 to 62 Hz).

Check the diagrams below to determine which plug adapters
you'll need, or ask your travel agent.

Outlet Type

Locations

XD
9

&

N\

United States, Canada, parts of Latin America,
Japan, Korea, the Philippines, Taiwan

Former Soviet Union, most of Europe, parts of
Latin America, the Middle East, parts of Africa,
Hong Kong, India, most of South Asia

Mexico, United Kingdom, Ireland, Malaysia,
Singapore, parts of Africa

China, Australia, New Zealand
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Storing the PowerBook

Short-term storage (up to 2 weeks)

1.
2.

Save your work on a hard disk or floppy disks.

Choose Battery from the Apple (8) menu and note the
charge level of the battery.

3. Choose Shut Down from the Special menu.

Close the display.

If the battery is not fully charged, or if you plan to
leave the computer in storage for more than a week,
plug in the power adapter.

If the battery is fully charged, you can store the computer
without its power adapter plugged in for up to a week.

Store the computer in a cool, dry place.

Storage temperatures should remain between 50°F/10°C and
104°F/40°C. Avoid leaving the computer where temperatures
may be extreme or unpredictable—in the trunk of a car, for
example.



Long-term storage (more than 2 weeks)

1.

Save your work on a hard disk or floppy disks.

2. Choose Shut Down from the Special menu.
3.
4. Recharge the battery.

Close the display.

Plug in the power adapter or use the recharger.

If you recharged the battery in a recharger, put the
battery back into the computer.

Store the computer in a cool, dry place.

Storage temperatures should remain between 50°F/10°C and
104°F/40°C. Avoid leaving the computer where temperatures
may be extreme or unpredictable—in the trunk of a car, for
example.

If you leave the battery in storage for more than 6 months,
you may not be able to recharge it.

Service and support

If the PowerBook malfunctions or is damaged

If your computer is malfunctioning but does not appear to be
physically damaged, shut it down (and leave the power adapter
plugged in, if possible) until you can get help.

If you know or suspect that your computer is physically damaged,
disconnect the power adapter, remove the battery, and do not use
the computer until it can be repaired.
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How to get help

To obtain service in the United States, you can contact either your
nearest authorized Apple dealer or Apple Computer directly. If
you are in North America, call 800-538-9696 to request the name
of an authorized dealer near you. If you are anywhere else, check
the local telephone directory.

To contact Apple directly, call 800-SOS-APPL (800-767-2775),
Monday through Friday, 8 .M. to 5 p.M. (Pacific time) to speak to a
Technical Support Engineer. If your PowerBook requires service,
the Technical Suppport Engineer will arrange for your computer
to be picked up at your location, sent to Apple’s centralized repair
facility for repair, and returned to you at any location you specify
in the United States. Apple has established a centralized repair
facility to help you get the best performance from your system.

If you need answers to product questions or information about
product updates, your authorized Apple dealer can help you.
Apple’s technical support organization backs each dealer and
international technical support group with an AppleLink network,
a state-of-the-art on-line information service, to ensure prompt
and reliable assistance. Apple guarantees parts and warranty labor.
(Regulations in each country determine the length of warranty.
Some restrictions may apply, depending on the country of original
purchase.)
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If you cannot return to the authorized Apple dealer from whom
you purchased your system, go to the nearest service location. For
the location nearest you, write or call one of the following:

Apple Computer, Inc. Apple Canada, Inc.

Customer Relations 7495 Birchmount Road
20525 Mariani Avenue Markham, Ontario, L3R 5G2
Cupertino, CA 95014-6299 Canada

USA (800) 268-7796/7637

(800) 538-9696

For locations in other countries, either call the Apple
headquarters in your country or write to the United States
address on this page.

Apple also offers service plans. One is the AppleCare Service
Agreement (available in the United States, Canada, and Australia
only), which extends full warranty coverage up to three years.
Your AppleCare contract will be honored at any participating
authorized Apple dealer within the country of purchase—an
added benefit if you relocate.

You can purchase AppleCare at any time, but you may want to
purchase it with your system, or at least before your warranty
expires, to avoid an inspection at your own expense.



For more information about
Macintosh computers

Macintosh user groups

Whatever your level of computer experience, you may be
interested in joining a Macintosh user group. Group activities may
include new product demonstrations, question-and-answer
sessions, and classes on using programs or writing your own
programs.

Ask your authorized Apple dealer for the name of the Macintosh
user group nearest you, or call 800-538-9696. For names of user
groups outside the United States, or if you're interested in starting
your own group, contact:

Berkeley Macintosh User’s Group
1442-A Walnut Street, #62
Berkeley, CA 94709

USA

510-549-BMUG (510-549-2684)

or

Boston Computer Society
One Center Plaza

Boston, MA 02108

USA

017-367-8080

Technical information

Apple makes technical information for Macintosh computers
available through the Apple Technical Library and the Apple

Communications Library, both published by Addison-Wesley
Publishing Company and available at bookstores.

Apple Technical Library

The Apple Technical Library includes comprehensive technical
documentation for all Macintosh computer models as well as
the multivolume guide to the Macintosh operating system,
Inside Macintosh.

Apple Communications Library

The Apple Communications Library offers complete technical
information about Macintosh communications products and the
Macintosh in a network environment.
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APDA

APDA® is Apple’s worldwide source for over 300 development
tools, technical resources, training products, and information for
anyone interested in developing applications on Apple platforms.
Customers receive the quarterly APDA Tools Catalog featuring all
current versions of Apple and the most popular third-party
development tools. Ordering is easy; there are no membership
fees, and application forms are not required for most of our
products. APDA offers convenient payment and shipping options
including site licensing.

To order product or to request a complimentary copy of the APDA
Tools Catalog:

APDA

Apple Computer, Inc.
P.O. Box 319

Buffalo, NY 14207-0319

1-800-282-2732 (U.S.)

1-800-637-0029 (Canada)

(716) 871-6555 (International)

(716) 871-6555 (Fax)

AppleLink: APDA

America Online: APDA

CompuServe: 76666,2405

Internet: APDA@applelink.apple.com
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Assistance for hardware and software developers

If you plan to develop hardware or software products for sale
through retail channels, you can get valuable support from Apple
Developer Programs. Write to:

Apple Developer Programs
Apple Computer, Inc.

20525 Mariani Avenue, M/S 51-W
Cupertino, CA 95014-6299



Quick Reference

Summary and Shortcuts

Double-click

= Double-click an object on screen by pointing to the
object and clicking twice in rapid succession, without
moving the trackball or mouse.

Double-clicking is a common shortcut for opening an icon or
the selected item in a directory dialog box.

Shift-click
» Hold down the Shift key while clicking.

Shift-clicking is a way to select more than one icon or item
ina list.

Working with icons
Selecting icons
To do this Take these steps

Select an icon
Deselect an icon

Select multiple icons

Deselect an icon in a
group of selected icons

Select multiple icons
that are near each other

Select contiguous icons
in a list

Select text in an icon’s
name

Click the icon.
Click anywhere except the selected icon.

While holding down the Shift key, click
each icon.

While holding down the Shift key, click
the icon.

1. Place the pointer at one corner of the
group of icons.

2. Drag diagonally to select the icons, then
release the trackball or mouse button.

1. Place the pointer to the left of the top icon
or the bottom icon.

2. Drag up or down the list, releasing the
trackball or mouse button when the pointer is
left of the last icon.

Click the icon’s name (not the icon itself).
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Opening an icon

You open an icon by selecting it and choosing Open from the File
menu or using the keyboard shortcut $8-O or 8—Down Arrow. Or
you can double-click the icon.

Moving, copying, and renaming an icon

To do this Take these steps

Move an icon Drag the icon to where you want it.

Copy an icon onto
another disk

Drag the icon to the icon of the other disk
(or to an icon or window that belongs to
that disk).

1. Click the icon to select it.

2. Choose Duplicate from the File menu, or
press §8-D.

3. If you wish, rename the icon and drag it to a
new location. You can also make a copy by
holding down the Option key while you drag
the icon to another folder or window.

Copy an icon on the
same disk

Rename an icon 1. Select the icon’s name by clicking the name
(not the icon).

2. Type a new name and press the Return key.
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Working with windows

Making a window the active window

You make a window active by clicking inside it. You can also make
a window active by clicking its icon (even though it’s dimmed)
and choosing Open from the File menu, or by double-clicking the
dimmed icon.

Moving a window and changing its size

To do this Take these steps

Move a window Drag the window’s title bar (at the
top of the window) to the new

location.

Resize a window Drag the size box (in the

lower-right corner).

Or click the zoom box (in the
upper-right corner).

Close a window Click the close box (in the
upper-left corner).
Or choose Close from the File

menu. Or press 3-W.




Scrolling through the contents of a window

E[E———— Trees =————_1-
12 iterns 11.5 MB in disk 7.5 MB available

Scroll box (shows
relative location in
window)

R

Applications

b

o '
3 0
Fy

3 El
x> b
2 2,
z

= o
3

m ; -
P m

Satah's report

[1

0
i |

Scroll arrow (used | Every window has two scroll bars, one for vertical
to view the content  scrolling and one for horizontal scrolling. (A gray
beyond the scroll bar indicates more content beyond window’s
window’s borders)  borders; a clear bar indicates all content is visible.)

n Click the up, down, left, or right scroll arrow.

n Click the vertical or horizontal scroll bar (when it’s
gray).

» Drag the vertical or horizontal scroll box along its
scroll bar.

Opening higher-level folder windows

You can open a higher-level folder window (whose contents
include the active window) from a pop-up menu in the active
window’s title.

1. Hold down the 3t key as you press the active window’s
title.

A pop-up menu of the higher-level folders (and the disk)
appears.

2. Drag to choose a higher-level folder (or the disk), and
then release the trackball or mouse button.

The folder (or disk) window you chose appears as the active
window.

Open pop-up menu with the
name of the active window
at the top (“Old reports”)

Active window

) 0ld reports

Name £ JH status Kind showing the
[l bocumental = Ll throp ModernLink doolCr Eolr(litems of tcliqe
D) Elizabeth 4 /1 2K Memetfriter d o 1der named
O Jeremy's Stajus 6420 12K MademLink do Old reports

This folder contains the folder “Old reports.”

If you hold down the Option key as well as the 8 key, the old
window closes when the new window appears.
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Using the outline form in list views

Any list view you choose from the View menu (that is, any view
except the icon and small icon views) shows the contents of the
active window in outline form. You can see the contents of a
folder without opening the folder in its own window.

Open folder (with contents

indented below)
E=——— JHdata/2 =——T1F
[ Hame Size Kind
Vli'l At ideas —- falder ﬁ
O tistview T docurnent
—= soreen shots —- folder
O sereent 14k docurnent Open folder iﬂside
_'D ] Caspar maps -- folder
O credit union account 17K document dl’lOth@f fO]def
[ Read Me 1K TeachTest do (Wl[h contents
[ g Screens K alias. . ll’lderlted belOW)
TeachText 42K application pr 3
I
A downward-pointing triangle indicates that the folder’s

contents are displayed; a right-pointing triangle
indicates that the folder’s contents are hidden.

Click the triangle next to a folder name to display or hide the
folder’s contents in the active window. If you double-click a folder,
it opens in its own window, and its outline view closes.

< Shortcuts: When a folder is selected in an outline view,
pressing $8—Right Arrow displays its contents and
$—Left Arrow hides its contents. <
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Working with menus

Macintosh menus come in two types: pull-down menus and
pop-up menus. The menus in the menu bar are pull-down menus.

The Help menu, which

Menu bar (you you use to display
pull down menus information about items
from here) Menu titles on the screen
€ File TN sicts Label Speciall €] L The Application
fado :
menu, which
{ ta ¥ shows the
4 Copy
| easte programs that
{te
T Selectan % are currently
ipb open
Dimmed command Menu commands affect
(not available) whatever you've selected—
in this case, “Macintosh

HD.”



Pop-up menus often appear in dialog boxes that you use to set Choosing an item from a menu
options or preferences. You can recognize a pop-up menu by a
small solid triangle, pointing down, next to its name. The name
shows the current option or preference.

To choose a command from a menu, point to the menu name,
press to “pull down” or “pop up” the menu, drag to the item you
want to choose so that it’s highlighted, and then release the

mouse or trackball button.
Pop-up menu (closed)

Select a Document: Choosing an item from a submenu
= Walthrop v} Pressing the triangle

op
Y = Walthrop displays the menu Some menu items are submenus. A submenu name has a small
(but does not allow solid triangle next to it, pointing to the right. The submenu opens

h ou to choose a e TR
o e aps fnenu item). when the submenu name is highlighted.

O credit union account| [ o
1 Envelopes
[0 Glossary

1 JH as writer

3 App. programs
1 Art ideas
[ art-10/4

To choose an item in a submenu:

(el | 1. Point to the menu name and press to open the menu.

continues »

Pressing the menu title or the icon displays
the menu and selects the title (allowing you
to choose a menu item by dragging to it).
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2. Drag to the menu item so that the submenu appears.

Justify & p

Spacing

U poimi
qijo;

a2

~Plain
Bold
Flafic
Underline
OmilimeE

Shadarm

3. Drag sideways to the submenu, drag to the submenu
item you want to choose so that it’s highlighted, and
then release the trackball or mouse button.

| Underline

fiahc

Olujilliinle]

Shadom
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Keyboard shortcuts in the Finder and in
directory dialog boxes

Key

Action

Up, Down, Left,

or Right Arrow key

Tab key

Character
key (a, b, c...)

$B-Down Arrow

#—Option—-Down Arrow

3—Up Arrow

#—Option-Up Arrow

Return or Enter

Selects the next item in the direction of the
arrow

Selects the next item alphabetically (except in a
directory dialog box and the Chooser)

Selects the first item whose name begins with
that character (or the character following
closest to it in the alphabet)

Opens the selected icon

Opens the selected icon and closes the current
folder

Opens the folder that contains the current folder

Opens the folder that contains the current
folder and closes the current folder

In the Finder: Selects the selected icon’s name
for editing or saves the edited name

In a dialog box: the same as clicking the button
with the bold outline around it



Troubleshooting

This section describes possible causes and solutions for some
common problems you may have with your Macintosh
PowerBook or associated equipment provided by Apple.

This section is not comprehensive. Check the appropriate
reference section for additional help on specific topics.

Also check the documentation that came with your other
equipment and with your programs for more information.

A Warning: If you have a problem with your Apple computer
equipment and nothing presented in the manuals that came
with the equipment solves the problem, call Apple Computer
directly at 800-SOS-APPL (800-767-2775), or take the computer
or accessory to your authorized Apple dealer or service
provider. Attempting to repair the equipment yourself may
void the Limited Warranty. Contact your authorized Apple
dealer or service provider for additional information about
this or any other warranty question. A

The PowerBook

The computer won't start.

» The computer may be on, but the screen brightness or
contrast may be turned down. Adjust the brightness and
contrast controls to see whether an image appears on the
screen.

» The battery may be drained. Plug in the power adapter, wait
15 minutes, and then try to turn on the computer.

» There may be a temporary problem with the computer’s
power system. Use a paper clip or similar object to press the
reset button on the computer’s back panel, and then try to
turn the computer on again.
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The computer just stopped.

The computer may have gone to sleep. Press any key on the
keyboard (except Caps Lock) to wake it again.

The battery may have drained so far that the computer has
put itself to sleep to protect the contents of RAM. Plug in the
power adapter, wait 15 minutes, and then turn the computer
on again.

The computer may have “crashed” due to temporary software
problems. Click the Restart button on the screen (if you see
one), or use a paper clip or similar object to press the reset
button on the computer’s back panel. If you use these
methods, you will lose any work you have not saved.
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The computer is very hot.

It is normal for the computer to be warm to the touch while
you are using it, especially on the side beneath the keyboard.
If the computer seems unusually hot, try the following:

» plugin the power adapter
= turn down the screen brightness

= use the Maximum Conservation setting in the PowerBook
control panel

= make sure processor cycling is on in the PowerBook
control panel

= put the computer to sleep or shut it down

See Chapter 7 for more information on reducing your
computer’s power consumption.



The computer exhibits odd bebavior, such as many
unexplained system failures.

= A common cause of unexplained problems is multiple System
Folders on your computer’s startup disk. The System Folder
that the PowerBook is using to operate is marked with an
icon. Use the Find command in the Finder’s File menu to
locate any other System Folders, and throw them in the Trash.

» You may have a virus on your hard disk. Obtain a virus-
detection program, use it to check all your disks, and
eliminate any viruses the program finds.

= You may be using a program that’s not compatible with your
computer’s system software. Check the information that came
with the program or contact the manufacturer.

= You may have added a control panel or system extension that
is incompatible with other programs you use. Restart the
computer with the Shift key held down until you see the
message “Extensions off.” If the problem does not recur,
remove any such items you recently installed.

Power

The battery is draining too fast.

Turn down the screen brightness, turn off virtual memory,
move the Battery Conservation slider in the PowerBook
control panel to Maximum Conservation, or work with the
power adapter plugged in.

You may be using an input device (such as the mouse
intended for desktop Macintosh systems) not designed for
PowerBook computers. Make sure to use only low-power
input devices.

Your computer supplies power to the modem whenever a
communications program is open. Quit your communications
program if you aren’t using it.

If you aren’t using network services, you can also save power
by turning off AppleTalk in the Chooser.

Your battery may need to be discharged and recharged
completely. See Chapter 7.

Older PowerBook batteries do not hold a charge as well as
new ones. You may need to replace the battery.
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The battery can’t be recharged.

» There may be a loose connection. Make sure all plugs are
securely attached.

m The battery may be damaged or dead. Obtain a replacement
battery from your authorized Apple dealer.

» The outlet may have no power.

» If the adapter or recharger is plugged into a power strip, the
strip may not be turned on.

» The recharger may be damaged. Try recharging the battery in
the PowerBook.

The computer goes to sleep too often.

»  Open the PowerBook control panel and move the Battery
Conservation slider toward Maximum Performance.
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The computer doesn’t go to sleep automatically.

= You may have selected “Don’t sleep when plugged in” in the
Options section of the PowerBook control panel. Click the
box to remove the X.

= You may be connected to a shared disk on the network. If you
are not using the information on the shared disk, disconnect
from it.

m The printer or modem port may be in use. Quit your
telecommunications program or turn off background printing
in the Chooser (if the documents you're printing can wait
until later).

= One or more applications may be doing work in the
background. You can choose Sleep from the Special menu to
override them.

See Chapter 7 for more information about batteries and power
consumption.



The screen There are ghost images or black dots on the screen.

»  When the computer is left on for many hours, temporary
The screen looks blurred or out of focus. defects may appear on the screen. Put the computer to sleep.
The longer the computer was left on, the longer it will take for

» The viewing angle may not be optimal. Tilt the display on its the images to fade, but they will eventually disappear

hinge until the screen looks better.

The pointer moves too fast/too slowly.
The screen is too dark. b f ).

= You need to adjust the pointer’s tracking speed. Open the

- W ot S AL O oL COMPLIE, ity L v Mouse control panel and choose a more comfortable setting.

minutes for the screen brightness to “warm up,” especially if
you've chosen a high setting.

, , The pointer won't move at all.
m The screen brightness or contrast may not be optimal for the

surrounding lighting. Adjust the brightness or contrast setting. = Asoftware problem may have caused the computer to
“freeze.” Restart the computer by using a paper clip or similar
object to press the reset button on the computer’s back
panel. You will lose any work you have not saved.

m The screen dims automatically when the battery starts to run
low. You may need to recharge or replace the battery before
you can turn up the brightness.

The pointer bas disappeared.

m  Processor cycling may cause the pointer (expecially the I-
beam) to disappear temporarily. Roll the trackball or mouse
slowly until you locate the pointer.
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A window bas disappeared.

Another open window on the desktop may have covered the
window you're looking for. Move, resize, close, or hide
windows you aren’t using until you see the one you want.

Windows belonging to open but inactive programs may be
hidden. Choose Show All from the Application menu to show
hidden windows.

An icon is blinking in the menu bar.

One of your programs needs your attention. For example, you
may have set the Alarm Clock to go off at a particular time, or
PrintMonitor may be alerting you to a printing problem. Make
the program active and take the necessary action.

250 Quick Reference

Memory

A “not enough memory” message appears when you try to
open a program.

Quit any programs you aren’t using, then try again to open
the program you want. If that doesn't work, restart the
computer. Sometimes restarting makes additional memory
available.

If you are using a RAM disk or a disk cache, reduce its size and
then restart the computer.

Use extra space on your hard disk as virtual memory to
increase the amount of memory available for opening
programs. (Use virtual memory only when the power adapter
is plugged in.)

If you consistently want to open more programs than memory
allows, you can purchase a memory expansion card from your
authorized Apple dealer.

SCSI devices

You can’t turn on the computer after connecting a
SCSI device.

SCSI devices connected to your computer must be turned on
before the computer itself. Turn on the SCSI device(s) first,
and then turn on the computer.



The computer doesn’t recognize your SCSI devices.

» The devices may be off. Check to make sure that they are
plugged in and turned on.

n If the device is a disk drive, it may need to be initialized before
you can use it. See the instructions that came with the device.

» The software (driver) needed to communicate with the device
may not be installed in your System Folder. See the
instructions that came with the device.

» Two or more devices in the SCSI chain may have the same ID
number. Check the ID number of each device to make sure
each one has its own number between 1 and 6, and change
any numbers that are not unique.

m  When connecting SCSI equipment, it is important to use the
right cables and the correct number and placement of cable
terminators. Check the cables and terminators in the SCSI
chain and make sure that all cables are firmly attached.

See Chapter 13 for more information about working with SCSI
devices.

Disk drives and disks

The computer won't start up from its bard disk, or the
hard disk icon doesn’t appear on the desktop.

There may have been a temporary software problem. Shut
down the computer, wait at least 10 seconds, and then turn it
on again.

There may be a problem with the system software on the hard
disk. Start up the computer with the Disk Tools disk. If the
hard disk’s icon appears, reinstall system software as
described in Chapters 6 and 8. Disk repair programs can
sometimes fix problems of this kind.

The information on the disk drive may be damaged. Try using
a disk repair program to repair or recover the information. If
this doesn’t work, you'll need to reinitialize the hard disk. See
Chapter 8.

There may be a mechanical problem with the disk drive. If
none of the above suggestions works, take the computer to an
authorized Apple service provider.
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The bard disk keeps stopping and starting again.

» The hard disk may be going to sleep to conserve power. Open
the PowerBook control panel and move the Battery
Conservation slider toward Maximum Performance.

The bard disk is full.

= You can reclaim space on your hard disk by removing
unneeded files; turning off virtual memory; or purchasing a
disk optimization program to reorganize the information on
the hard disk.

The icon of a floppy disk doesn’t appear on the screen.

» There may be a problem with the disk or disk drive. Try
inserting a different disk. If its icon does appear, the original
disk is probably damaged. You may be able to repair the disk
or recover some of the information on it. See Chapter 8. If the
icon of the second disk does not appear either, take the
computer or disk drive to an authorized Apple service
provider for repair.
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A disk you use with your PowerBook computer is not
recognized by another Macintosh.

Some disk drives cannot recognize high-density disks. If the
disk is high-density (marked with the icon %), try inserting an
800K or 400K disk in the disk drive of the other Macintosh. If
that works, copy your files to an 800K disk or a 400K disk. If
you regularly plan to use floppy disk drives of different types,
use the lower-capacity disks in all drives.

The disk may be damaged. Try using Disk First Aid or another
disk repair program to fix it. If this problem occurs frequently,
one of the disk drives may need repair.

You can't eject a disk from a floppy disk drive.

There may be a temporary mechanical problem with the disk
drive. Restart the computer and hold down one of the
trackball buttons while the computer starts up. If that doesn’t
work, carefully insert the end of a straightened paper clip into
the small hole near the disk drive’s opening, and push gently
until the disk is ejected.



A message says that a disk is not initialized—but you
know that it is.

» The disk may not be seated properly in the disk drive. Eject it
and try inserting it again.

» The disk may be damaged. If you insert another disk in the
drive and the message does not appear, you can assume that
the original disk needs repair. See Chapter 8 for information
about recovering information from a damaged disk. If the
second disk is also not recognized, take the computer or disk
drive to an authorized Apple service provider.

You can'’t delete a file on a floppy disk.

» The disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.

» The file may be locked. You can unlock it in its Info window
(choose Get Info from the File menu). Or you can hold down
the Option key while you choose Empty Trash from the
Special menu.

» Anapplication program may be using the file. You'll need to
quit the program.

You can’t save or copy files onto a floppy disk.

» The disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.

» The disk may be full. Delete files you no longer need or use a
different disk.

See Chapter 8 for more information about working with disk
drives and disks.
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Modems

The external modem doesn’t work.

» The modem may be turned off or improperly connected.
Make sure that it is turned on and that all connections are
correct.

» The modem port may not be activated. Open the PowerBook

control panel and make sure that External Modem is selected.

The internal modem doesn’t work.

m  The modem port may not be activated. Open the PowerBook
control panel and make sure that Internal Modem is selected.

See the modem manual for more information about using and
solving problems with your modem.
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Printers

Your computer can’t find the printer.
» The printer may be turned off. Turn it on.

» Ifit's a network printer, there may be a problem with the
network. Check with your network administrator.

» The printer may not be selected in the Chooser. Open the
Chooser and select the printer you want to use.

Your printer does not appear in the Chooser window.

» The printer may not be connected properly. Check the
connections between your computer and the printer,
including relevant sections of the network if appropriate.

» The printer software may not be in your System Folder. Close
the Chooser and install the software you need.

»  AppleTalk must be active before you can use a network
printer. Make sure that AppleTalk is active in the Chooser.

» Ifyour network has zones, the printer you want may not be in
the currently selected zone. Make sure the correct zone is
selected.

m There may be a problem with the network. Check with your
network administrator.



The network printer keeps restarting.

Someone on the network may be using a different version of
the printer software. Everyone connected to a network should
use the same printer software version. Consult the network
administrator for more information.

Nothing bappens, or you see an error message, when you
try to print.

The printer may not be turned on. Make sure it is turned on
and warmed up.

The printer may be out of paper or have some other problem.
Check the printer status lights and any messages on your
screen.

If an error message states that the printer could not print your
document, turn the printer off for at least 10 seconds. Then
turn it on again, wait for it to warm up, and try to print again.

Your documents are printed with the wrong fonts.

» The printer may not have your fonts in its memory and is
substituting other fonts. You may be able to add the necessary
fonts to your printer (see Chapter 11), or print on a different
printer that has the fonts you want. If you have a LaserWriter,
you can turn off Font Substitution in the Page Setup dialog
box.

See Chapter 11 for general information about printing documents.
See the printer manual for more information about your printer’s
features or problems with the printed output.
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Networks

You can't find or can’t open icons needed to set up
file sharing.

One or more icons may be in the wrong place. Make sure that
the Sharing Setup icon is in the Control Panels folder, and that
the File Sharing Extension file, the Network Extension file, and
the AppleShare file are in the Extensions folder. (Both folders
are inside the System Folder.)

Some network software may not be installed correctly.
Reinstall system software from a backup copy or check with
your network administrator.
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The shared disk you want to connect to does not appear in
the Chooser windouw.

»  AppleTalk must be active before you can use a shared disk.

Make sure that AppleTalk is active in the Chooser.

If your network has zones, the shared disk you want may not
be in the currently selected zone. Make sure the correct zone
is selected.

The computer that the disk is on must be turned on before
the disk can be shared. Make sure that computer is on.

The shared disk may be temporarily unavailable. Wait a few
moments to see if its name appears in the Chooser.

There may be a problem with the network. Check with your
network administrator.



You can’t open a shared disk or folder.

= You may not have the access privileges needed to use the disk
or folder. Ask the network administrator or the owner of the
shared item to grant you access.

= You may have entered your name or password incorrectly
when you tried to open the shared disk or folder. Check with
the owner of the item to make sure you are entering your
name and password correctly, and try again.

You can’t connect to your own computer from
anotber Macintosh.

m  Make sure that your computer is turned on and connected to
the network. Make sure that file sharing is turned on, you
have the correct access privileges, and you entered your name
and password correctly.

See Chapter 12 for more information about using your computer
on a network.

Application programs

A program won’t open.

= Some programs can't be opened from a locked floppy disk.
Make sure the disk is unlocked.

m The program may be damaged. Recopy it from a known good
source (such as the original program disk).

m  There may not be enough memory available to open the
program. Quit other programs or change the program’s
memory size in its Info window.

A program runs very slowly.

= Some programs are slowed by processor cycling. You can turn
processor cycling off; see Chapter 7. Turning processor cycling
off will drain your battery faster and cause the computer to
become hotter.
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A program doesn’t work, or malfunctions consistently. You just did something you didn’t mean to do.

= You may have more than one copy of the program on your » Ifyou have not yet taken any other action, you can usually

hard disk. Remove extra copies by dragging them to the Trash. undo your most recent action (even if you aren’t sure what it
was). Most programs have an Undo command in the Edit
menu ($8-Z). Choose Undo to go back one step in your work.
You cannot undo more than one action.

»  The program may be damaged. Recopy it from a known good
source (such as the original program disk).

» Your version of the program may be incompatible with your
system software. Consult the software manufacturer to find
out which version of the program you should be using.

See the documentation that came with your programs for more
information about their operation and features.

» The program may be using less memory than it needs to work
with your documents. Choose Get Info from the File menu
and increase the memory size.

A message says that a program could not be found.

= You may be trying to open a document created with a
program you don’t have on your computer, or created with a
different version of the program. Obtain the correct program
and version. Or open the document with another program
that can read its format. (If another program can open a
document, the program icon becomes highlighted when you
drag the document icon to it.)
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Appendix A

Keyboard and Character Sets

Return key: Moves the
insertion point to the
beginning of the next
line. In a dialog box,

Tab key: Moves the insertion point Delete key: Deletes selected  pressing Return is the
to the next stopping place (such as material, or the character to  same as clicking the
a tab stop or data field). the left of the insertion point.,  outlined button.
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letters (or the upper character \LE
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Control key: In combination ” @’J @ _‘;ﬁ LW_J [ J M - @ @ U

with other keys, provides
shortcuts or modifies actions. L I

*

Option key: In combination with % (Command) key: Works in combination Arrow keys: Move the insertion
other keys, produces special with other keys as an alternative to choosing point, as an alternative to using the
characters or modifies actions. a menu command. trackball. In some programs, the

arrow keys have other functions.



Using Caps Lock

The Caps Lock key on PowerBook computers does not stay
depressed even when it’s locked. You can tell whether Caps Lock
is on or off by looking at the menu bar. An arrow appears to the
left of the Help menu icon when Caps Lock is on.

LN -

To turn Caps Lock on or off, press the Caps Lock key.
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Typing special characters and symbols

You can type a variety of special characters (with diacritical marks)
and symbols by pressing modifier keys in combination with
certain letter and number keys.

The Key Caps program, which is installed with the system
software, shows you the characters produced when you type
certain keys and key combinations in the fonts available on your
computer. Choose Key Caps from the Apple (#) menu, then
choose the font from the Key Caps menu.

Characters appear here when you press keys on
the keyboard or click them in the window.

Key Caps

Characters available in
the Chicago font




The highlighted key represents the
key held down on the keyboard—in
this case, the Option key.

Characters
available in
the Chicago
font when the
Option key is
pressed

To type a character with a diacritical mark (such as an acute accent
or an umlaut), you press the Option key along with a specific
letter key, and then type the character.

Diacritical mark

Key combination

Grave accent ()
Acute accent ()
Circumflex (™)
Tilde (~)
Umlaut ()

The letter “c” with a cedilla (¢)

Option—", then type the character
Option—e, then type the character
Option—i, then type the character
Option—n, then type the character
Option—u, then type the character

Option—c

If the character appears after the diacritical mark (rather than
with it), then the marked character is not available in the font

you’re using.
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Appendix B

EXChanging Disks and Files | Initializing a disk in MS-DOS format
. (You can also follow these instructions to initialize a disk in
With MS-DOS Computers | ronostoma

1. Locate the Apple File Exchange icon on your hard disk
Apple File Exchange is a file format conversion program supplied and open it.
on your hard disk. The program and translator files are stored in

When you open the program, the contents of the active
the Apple File Exchange Folder.

window are listed on the left side and an empty box appears

You can use the program to initialize a disk in MS-DOS (or on the right side.

Apple IT ProDOS) format and convert files to and from MS-DOS 2. Insert a blank disk into your floppy disk drive.

(or ProDOS). Apple File Exchange cannot open converted files; .

you need to open them with an application program that A message reports that the program can’t read the disk and

recognizes the converted files. asks if you want to initialize it. The message lists the formats
available in Apple File Exchange, including Macintosh,
MS-DOS, and ProDOS.

[% (You can initialize a disk that is not blank by inserting it,

clicking the Drive button until the disk’s name appears,

Apple File Exchange and then choosing Erase Disk from the File menu.)
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3. Click MS-DOS.
4. If necessary, click the capacity (in K) of the disk you

inserted.

If you want to initialize a high-density (%) disk in MS-DOS
format, 1440K is the only option and it is already selected. If
you inserted a double-sided disk, click 720K.

Apple File Exchange cannot initialize a high-density disk in
720K format, nor can it read a double-sided disk that has been
initialized in the high-density (1.4 MB) format.

(9 Apple File Exchange cannot
H read this disk. Do you wish to

initialize it?

® 1440K Macintosh

ProBns

(initiatize | Eject ]|

Disk capacity is the same
for Macintosh and MS-DOS
high-density disks.
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5. Click Initialize.

When initialization is finished, a message asks you to name
the disk.

. Type a name for the disk, and then click OK.

MS-DOS filenames can have up to eight characters, followed
by an optional period and up to three characters.

The name of the disk you initialized appears above an empty
window. The disk’s icon doesn’t appear on your Macintosh
screen because the Macintosh can't recognize a disk in
MS-DOS format.

7. Choose Quit from the File menu.



Converting files to and from
MS-DOS format

Apple File Exchange provides two methods of file conversion—
text and binary. Text translation is for text files, and binary
translation is for other file types.

Apple File Exchange can also use translator files designed to
convert files into formats that specific programs can use. One
such translator file is provided with Apple File Exchange:
DCA-RFT/MacWrite, which converts documents between MacWrite
format (for the Macintosh) and Document Content Architecture/
Revisable Form Text format (used by many MS-DOS word-
processing programs).

File selected
for translation

& | File Edit Mac to MS-DOS MS-DOS to Mac

L [E=E===========npple File Enchange

& 92 MSDOS. jjh
# 0 Budget 92 0 BUDGET.90
i | Disk Images T Tat O BUDGET.91
O Labels O BUDGET.OVW
27K
bytes
selected
I L
© Hummer MSDOS. jjh
;:: 5094K bytes available 1324K bytes availabl
- |(Corve
New Folder New Folder Eject

Menus of
translator files

Directory
title or disk
name

Disk name

Follow these steps to translate an MS-DOS (or ProDOS) file:

1. Locate the Apple File Exchange program and open it.

Apple File Exchange is supplied on one of your system

software disks.

When you open the program, the contents of the active
window are listed on the left side and an empty box appears

on the right side.

2. Insert the floppy disk containing the files you want

to translate.

3. Use the Open, Drive, and Eject buttons to display the
files you want to translate and the disk or folder where

you want to store the translated files.

4. Click the names of the files or folders you want to

translate.

The appropriate translation menus (for translating from or to
Macintosh format) appear in the menu bar when you select

MS-DOS files.

continues »
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5. Pull down the translation menu you want. 8. Click Translate.

6. Make sure that the translators for the types of files you If two or more active translators (other than Text or Default)

selected have checkmarks; if not, choose them so
checkmarks appear next to them.

An active translator has a checkmark. The default translator
has a diamond (indicating that it’s always active). Choosing an
active translator makes it inactive.

. Compare the size of the files or folders selected
for translation with the space available on the
destination disk.

Total space required appears between the lists; the space
available on the destination disk appears below its name.

If the size of the selected items is greater than the space
available on the destination disk, deselect some of the items,
remove some files on the destination disk (click Remove), or
use another destination disk (click Eject).
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are capable of translating a selected file, a message asks you to
select the translator you want.

If the names of files or folders on the destination disk are the
same as those of files or folders being translated, a message
asks you to rename the file being translated.

If you need to select options before a file is translated, a dialog
box appears in which you can select the options.

9. Respond to any messages by selecting a translator,
renaming a file, or selecting options.

When Macintosh files are translated into MS-DOS files,
filenames may be shortened to conform to MS-DOS naming
conventions.

10. Choose Quit from the File menu.

% Converting MS-DOS files on a file server: Some file servers
can store information created by both Macintosh and MS-DOS
computers. For example, the AppleShare PC program allows
MS-DOS computers to store and translate files on an
AppleShare file server. Consult your authorized Apple dealer
or representative for more information about using a file
server and MS-DOS files. «



Other file-conversion options

Apple File Exchange’s File menu provides several other options to
assist you with file conversions.

The program keeps a
log of all files translated,
showing the date, time,

and type of conversion.
The active translators P
and options for each
translator can be saved |
in a file by choosing Show User Log

“Save settings as.” You Liose

can use these options Save Yser Lag fs..,
again later by choosing Ll bew Loy
“Restore settings from” {

and opening the file. Restore sgttlngs from...
Save settings as...

Page Setup...

Choose to rename Print #sey Loy,

destination
(translated) files. ___|

—Reasme Bestination Files..
Names of files that can't —{vShow Only Eligible Files $E

be converted by the Erase Disk...
active translators are :
dimmed when this Quit %0

item is checked.

Choose to reinitialize
adisk in any
available format.

To see explanations of the translators Apple File Exchange uses,
choose About Apple File Exchange from the Apple menu. Select a
translator from the list, and then click the About button for more
information. (Click Done to return to the program’s window.)
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Appendix C

Map

The Map control panel lets you set your computer’s location and
find out the distance and the time difference between your
location and cities around the world. If you travel with your
computer and use Map to reset your location accordingly, the
time (in the Date & Time control panel) is automatically reset to
the local time.

e

Map

Certain programs (in networking and telecommunications, for
example) can use your computer’s location to account for time
zones and distances when making calculations.

Setting your location

1. Choose Control Panels from the Apple (&) menu and
open the Map control panel.

Remove City v

Latitude  [37 |°[21 | N
Longitude (121 [57 | CJE
Time Zone h m|:|+

mi 0 14:03

To magnify the map in the control panel (showing less of the
world at a larger scale), hold down the Option key while you
open Map.

continues »
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2. Type the city nearest your current location and then Comparing locations
click the Find button (or press the Return key).
After you set your computer’s location, you can use Map to find

If you aren’t sure how the city is spelled, type the first few out:

letters and press the Return key. If the city isn’t found, you can
add it to the list of cities stored in Map (instructions are given w  the distance from your location to another location
elsewhere in this appendix).

3. Click the Set button.

m the time at another location

» the time difference between your location and another
Your current location is indicated by a blinking cross. location

Open the Map control panel and find or add the other location
(instructions are given elsewhere in this appendix). You can also
choose a location by clicking anywhere on the map (the unnamed
location’s coordinates appear in the boxes for latitude and

longitude).
(ag# £ity) (Remove City
|r'lanila
Latitude 14 |36 | =N
Longitude 120 ° |59 || XIE
Click here to ——{ Time zone [8 |h|0 |mX+
display time mi 7000 09:28
difference.
Distance to Local time in

location shown location shown
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The distance to and the time at the other location are shown at
the bottom of the window. The distance is based on the shortest
possible route (called the great circle).

To find out the time difference between your location and the
other location, click the words “Time Zone.” Click again to see the
other location’s time zone.

Finding a location

The Map has a list of locations, with information on the latitude,
longitude, and time zone of each location.

1. Choose Control Panels from the Apple (&) menu.
2. Open the Map control panel.

To magnify the map in the control panel (showing less of the
world at a larger scale), hold down the Option key while you
open the Map control panel.

3. Type the city you are looking for and then click the
Find button (or press the Return key).

If you aren’t sure how the city is spelled, type the first few
letters and press the Return key.

If you don’t know the name of a city but know where it is, you
can find it by clicking its location on the map. Each blinking
point is a location in the list. If you click in the map and then
drag to a blinking point, that location’s name, latitude,
longitude, and time zone appear.

(If you hold down the Option key while clicking the Find
button, Map displays, one at a time, all the locations in its list.)
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Adding or removing a location

Adding a location

1.

If the map does not show the location you want to add,
scroll by dragging beyond the map in the direction of
the location.

Click the location.

A blinking star appears at the location, and its coordinates and
approximate time zone are displayed.

3. Type the name of the new location.

If you know the coordinates, type them in the latitude
and longitude boxes.

When the N and E boxes are checked, the boxes next to them
display North latitude and East longitude, respectively.
Otherwise, they display South latitude and West longitude.
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5. If the time zone is not correct, click the Time Zone
boxes and type in the correct number.

When the box at the end of the Time Zone line is checked,
the boxes show how much time the location is ahead (east) of
Greenwich Mean Time. Otherwise, they display how much

time the location is behind (west of ) Greenwich Mean Time.

The map estimates the time difference based solely on
longitude. Since the boundaries and time of time zones are
determined politically, you may need to consult a time zone
chart, map, atlas, or globe for the correct time.

6. Click the Add City button.

The new location is added to the list. If your computer beeps,
the location is already part of the list.

To change details about a location, you need to remove it and
then add it again.

Changing or removing a location
1. Find a location.
2. Click the Remove City button.

If you want to keep the location but change the coordinates
or time zone, type the new coordinates or time zone, then
click the Add City button.






A

About This Macintosh command 161, 164,
231
accent marks, typing 260-261
access privileges. See also file sharing; guests;
network; passwords
checking 217
icons and 217
restricting 201, 207-208
set by others 217
setting 214-215
strategies for using 215-216
turning off 209-210
types of 213-214
active programs 58-62
identifying 95
active window 42—46
printing contents of 179
ADB. See Apple Desktop Bus (ADB)
air travel tips 233-234
Alarm Clock 149-150
setting date and time with 149

aliases
connecting to shared disks with 196
creating 134
locating original of 135
locking 118
searching for 139
troubleshooting 134-135
uses for 134
amplifiers 230
APDA (Apple Programmers and Developers
Association) 238
AppleCare Service Agreement 236
Apple Communications Library 237
Apple Desktop Bus (ADB) 7, 229
Apple Developer Programs 238
Apple File Exchange
converting files with 265-267
initializing disks with 263—264
Apple HDI-30 SCSI System Cable 224,
227,266
Apple HD SC Setup program 113—114,
127,130

Apple menu. See also control panels; desk
accessories (DAs)
adding items to 92, 135, 146
aliases and 134
pulling down 38
removing items from 135, 146
troubleshooting 135
Apple Menu Items folder 146
AppleShare extension 161
AppleShare icon 193-194
AppleShare PC program 266
AppleTalk
choosing printers and 174, 175
installing 192
memory management and 161
sleep and 192
turning on/off 191-192
AppleTalk Remote Access 161
AppleTalk zones 175
Apple Technical Library 236
Apple I ProDOS file format 263, 265
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Application menu
hiding and showing windows 96
making open program active 59—60
programs listed in 96
switching programs 96
application programs. See also programs
installing 92
locating 139
making active 59-60
overview 61
PowerBook 145B Backup program 6, 8,
10-12, 119-122
PowerBook 145B Restore program 8, 119,
123-125
switching 96
troubleshooting 92, 257258
arrow keys 53, 244, 259
arrow pointer 306, 249. See also arrow keys;
[-beam pointer
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B

background pattern, changing 168—170
background printing 175, 180, 181, 248
backing up
floppy disks 119
hard disk 6,8-12, 119-122
individual files 119
travel and 233
updating a backup copy 121-122
backup programs 6,8, 10-12, 119—122
Balloon Help 87-88, 176
battery. See also power management
disposing of 107
low power messages 102—103, 108
maximizing life of 108
maximizing work time with 109
monitoring charge level of 86, 101-103
power adapter and 2
power conservation 87, 109—112, 248, 254
processor cycling and 112
processor speed and 111
recharging 102—106, 108, 235, 248
removing or replacing 106—107
safety tips for 26, 28, 107
sleep and 14, 110, 111
storing 234, 235
transporting 26, 233
troubleshooting 247248
using computer without 106

Battery Conservation settings 87, 109-112,
248,252
Battery desk accessory 86, 101-103
battery recharger 105-106
beep sound
choosing 165
installing 166
recording 167-168
removing 147, 166
Berkeley Macintosh User's Group
(BMUG) 237
binary translation 265
bitmap fonts 182—183
blinking icons 91, 117, 181, 250
blinking line (insertion point) 57, 62, 157
blinking rate 157
Boston Computer Society 237
brightness control 5, 7, 32, 109, 245, 249
bulletin boards 94, 216
By Label option 142



C

cables

network 191

safety instructions 26

for SCSI connections 224, 226227
cache, disk 162,250
capitalization. See case sensitivity
Caps Lock key 259, 260

passwords and 195

waking computer and 13, 14, 19, 110
care instructions

computer 26-28

floppy disks 79

hard disks 127
carpal tunnel syndrome 30
carriage returns 57
case, computer 27
case sensitivity

passwords and 204

registered user names and 194, 203
CD-ROM disc

access privileges for 215

ejecting 126

selecting for sharing 201202
character repeat rate, adjusting 155
character sets 259-261
Chooser 173—175, 191-192
cities. See Map control panel
cleaning the computer 28, 32

Clean Up command 40, 131
Clear command 98
clicking 37, 39. See also double-clicking;
shift-clicking
Clipboard 64
clock, setting 148
close box 48, 49
CloseView control panel 170-172
control panels 170-172
Close Window command 50, 79
cold, computer use and 28
colon (:), in icon names 70
color documents, printing 179
comfort tips 31-33
Command key 53, 67, 244, 259
ejecting disks with 126
startup scan and 117
undoing last action with 258
commands
choosing 40
keyboard shortcuts for 66, 244
computer viruses 94-95, 247
connectors, safety tips for 27
contrast control 5, 7,32, 245, 249
Control key 53, 259
control panels
appearance of Finder windows 158
background pattern 168—170
battery conservation 8687, 109-112,
248,252
beep sound 165

blinking rate 157

CloseView control panel 170-172

currency formats 153

Date & Time control panel 148—149,
151-152, 269

disk cache 162

Easy Access control panel 156

file sharing 200-201, 203—205, 207,
208, 211-212

guest access 200-201

Keyboard control panel 155

Labels control panel 148

magnifying screen images 170-172

Map control panel 269-272

Memory control panel 99-100, 109,
162-164

modem selection 228

monitoring file sharing 210-211

Mouse control panel 154

network identity 192, 200, 209-210,
212-213

Numbers control panel 153

passwords 192, 204, 212-213

processor cycling 112

program linking 220, 221-222

Sharing Setup control panel 192, 200,
209-210, 212213, 220

sleep 110-111

Sound control panel 165-167

Startup Disk control panel 116
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32-bit addressing 164

time 148—149, 269

trackball speed 154

troubleshooting and 247

Users & Groups control panel 200-201,

203-205, 207-208, 211-212, 221

Views control panel 142, 158

virtual memory 163-164
Copy command 98
copying. See also backing up

disks 7879, 82-83, 119, 125

documents 69-70, 253

files without a floppy disk drive 92

icons 240

items to and from Scrapbook 98
copyright law, file sharing and 202
crashes 17—18, 246
creating

aliases 134

documents 57

folders 132

folders on shared disks 197

RAM disk 99-100

stationery 140—141

virtual memory 163164, 231
currency formats, changing 153
CULSOL. See arrow pointer; insertion point
Cut command 64, 166
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D

damage to computer 235, 247
DAs. See desk accessories (DAs)
Date & Time control panel
changing date format 151
changing time format 152
Map control panel and 269
setting date and time 148149
DCA-RFT/MacWrite translator file 265
dealer support 235-236
Delete key 57,259
deleting
files 71-72, 253
Scrapbook items 98
text 63—04
typing errors 57
deselecting an item 39
desk accessories (DAs)
Battery 86, 101103
Chooser 173175, 191-192
Key Caps 186, 260261
switching between 96
desktop
changing background pattern 168-170
Clean Up Desktop command 40
contents of 16, 50-52
dragging an object on 39

hiding and showing windows on 96
moving an item to 135
pointing to an object on 36
printing contents of 179
selecting an object on 37
startup and 5, 16
straightening up 131
VM Storage file 164
development tools 238
device drivers 224, 249
diacritical marks, typing 260-261
dimmed icons 96
directory dialog box 133, 244
disk cache 162,250
diskettes. See floppy disks
Disk First Aid 18, 127, 128-129
disk repair programs 18, 125, 129
disks. See CD-ROM disc; floppy disks; hard
disk; RAM disk; shared disks;
startup disk
Disk Tools disk
Apple HD SC Setup program 113—114,
127,130
Disk First Aid 127, 128—130
initializing hard disk with 113
PowerBook 145B Restore program 123
restarting with 18
display. See screen
Document Content Architecture (DCA)
format 265



documents. See also files

aliases for 134135

automatic updating of 190

changing name of 70-71

changing text in 62—65, 66—68

closing 60, 69

converting to and from MS-DOS
format 265-267

converting to and from stationery
140-141

copying 6970, 253

creating 57

deleting 71-72, 253

labels for 142

making document window active 59, 69

naming 57-58, 133

opening 61-62, 69

opening automatically 146

organizing 131

overview 52

printing 178-179, 181

saving 57,133, 253

saving as templates 140-141

saving changes in 65

transferring 143

“Don't sleep when plugged in”

option 111, 248

DOS, exchanging files with 263—267

double-clicking 239. See also clicking;
shift-clicking
adjusting speed of 154
icons 62,96
selecting text by 68
double-sided floppy disks 74, 75.

See also floppy disks
downloading printer fonts 184—185
Download PostScript File command 188
dragging

objects 39
size box 44—45, 47
title bar 49
drivers 224, 251
drop boxes 216
Duplicate command 70
duplicating. See copying

E

Easy Access control panel 156
Easy Install dialog box 93
editing documents 62—65
Edit menu

Clear command 98

Copy command 98

Cut command 64

Paste command 64, 98

Quit command 68

Undo command 258

ejecting a floppy disk 80, 126
electrical safety tips 26
electronic bulletin boards 94, 216
elevation feet 7,32
Empty Trash command 72, 100

turning off warning 160
Enter key. See Return key
Erase Disk command 100, 116
erasing

floppy disks 116

RAM disk 100

typing errors 57
ergonomics. See comfort tips
error messages

printing 180

“system error” 17
Ethernet cables 191
Extensions folder

AppleShare file 194

File Sharing icon 192

Network icon 192

troubleshooting and 247
external battery recharger 105-106
external hard disk 117
external microphone 7, 167, 230
external modems 228, 254
external monitors 104
Extras folder 182
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F

fax/data modem 228
file exchange 263-267
File menu
Close Window command 50, 79
Download Fonts command 185
Download PostScript File command 188
Duplicate command 70
Find Again command 136
Find command 136-139
Get Info command 97, 118, 141
Initialize Printer’s Disk command 186
Make Alias command 134, 196
New Folder command 132
New Group command 204
New User command 203
Open command 41
Page Setup command 176-178
Preferences command 181
Print command 178-179
Print Desktop command 179
Print Window command 179
Put Away command 80, 126, 195
Save command 57-58, 65—66
Sharing command 199, 201-202, 206, 209,
214-215
files. See also documents; file sharing; System
Folder; system software
adding to System Folder 146-147
aliases for 134—135
backing up 8-12, 119-122
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closing 60, 69

converting to and from MS-DOS
format 265-267

copying 69-70, 253

deleting 71-72, 253

getting information about 141

labels for 142

locating 134-135, 136139

locking and unlocking 118, 253

naming 133

opening 61-62, 69

opening automatically 146

organizing 131

overview 51-52

program versus document 51-52

RAM disk and 99

removing from System Folder 147

restoring from backup copies 123—125

saving 57, 133, 253

straightening up 131

transferring 143

file servers 193, 194, 266
file sharing 190, 199-212. See also access

privileges; guests; network

access privileges for 201, 213-215

ceasing to share a folder 202

changing ownership of a folder 197, 199,
209, 213

changing your password 197-198,
212-213

checking access privileges 217
copyright laws and 202
creating a shared folder 197
disconnecting someone from your
computer 211
giving away ownership of folders or
disks 209
memory management and 161
monitoring 210
naming users and groups for 203—205
passwords for registered users 204
preventing access to your disk 207208
reconnecting to shared disks 209
removing users or groups 208
selecting folders or disks to
share 201-202
selecting users or groups for
sharing 206-208
sharing your own files 199-202
taking back shared folders or disks 202
turning off 207-208, 209-210
turning on 200
turning on guest access 200—-201
viewing names of group members 205
File Sharing icon 192
File Sharing Monitor 210-211
file translators 263, 265
Find Again command 136
Find command 136-139
Find dialog box 136—139



Finder
changing appearance of windows in 158
checking memory use in 161, 231
keyboard shortcuts in 244
making active 58—60
overview 61
printing and 178
fixed-size (bitmap) fonts 183
floppy disk drive
illustration 7
inserting disks into 24, 74
removing disk from 80, 126
restarting with 18
starting up with 117
troubleshooting 125, 126, 252, 253
floppy disks
backing up contents of 119
for backing up the hard disk 9, 10, 113,
119-122
capacities of 74, 75
caring for 79
copying contents of 78-79, 82-83, 119
double-sided 74, 75
ejecting 80, 126, 252
erasing 116
file sharing on 201
high-density 9, 74, 75, 81, 252
initializing 76-77, 115, 253
initializing in MS-DOS format 263264
inserting 11,24, 74

installing system software from 93-94
labeling 12
locking and unlocking 81, 117, 122
obtaining 73
repairing 18, 119
restarting from 18
for restoring the hard disk 123-125
starting Macintosh Basics tour
from 20, 24
transferring files with 143
troubleshooting 125, 126, 128—129,
252-253
types of 74,75
viruses and 94-95
folders. See also file sharing; System Folder
access privileges to 214-215
aliases for 134-135
Apple Menu Items folder 146
ceasing to share 202
changing ownership of 197, 199, 209, 213
creating and naming 132
locking 118
opening 79
opening higher-level folder windows 241
organizing files in 51, 132
sharing 201-202, 257
Startup Items folder 92, 146
viewing contents of 242
Font menu 186

fonts

bitmap (fixed-size) 182-183

displaying available fonts 186

downloading to a printer 180, 184185

font families in suitcases 183, 184

installing 183

Key Caps program and 186, 260—261

LaserWriter Font Utility program 184,
186-188

outline (scalable or variable-size) 182

PostScript 184-—185

removing 147, 184, 187

troubleshooting 180, 255

Truelype 182

types of 182183

in views 158

Fonts folder 182, 186
formats

date 151

file exchange 263—265
number and currency 153
time 152

formatting. See initializing
fragmented memory 161
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G

General Controls control panel 157, 168170
General Controls panel
adjusting blinking rate 157
changing background pattern 168—170
setting time and date 149
Get Info command 97, 118, 141
graphics tablets 154
gray-scale documents, printing 179
groups, network. See registered group
guests. See also file sharing; network;
passwords
access privileges of 193, 194,
200-201, 215
connecting to a shared disk as 194, 196
denying access to 207-209
folder ownership of 197
program linking and 219, 220, 221
registered groups and 205
removing from a group 208
turning on 200-201, 202

H

hard disk. See also shared disks
access privileges for 214-215
backing up 6, 8-12, 119-122
battery consumption and 101, 104
capacity of 75
caring for 127
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connecting to a printer 186

damage symptoms 113

deleting items from 71-72

designating as startup disk 116

external 117

finding items on 136—139

hard disk sleep 111

initializing (formatting) 76, 113—114

initializing printer 186

installing programs on 78-79, 8283,
92,94

overview 51,75

reinstalling system software on 91, 93-94

restoring from a backup copy 8, 12,
123-125

safety tips for 27,127

scanning order at startup 117

starting Macintosh Basics tour
from 20-23

as startup disk 16, 116117

testing and repairing 127-130

transferring files from 143

troubleshooting 18, 114, 127-130,
251-252

virtual memory and 163—164

hard disk icon 41, 51,75

failure to appear 127-128
opening 41
removing from desktop 126

hardware development support 238

HDI-30 SCSI System Cable 224, 226—227
headphones, connecting 230
health concerns 29-33
heat
batteries and 28, 103
troubleshooting 246
Help 87-88, 176
Help menu
Hide Balloons command 88
Page Setup options and 176
Show Balloons command 87, 176
hidden windows, viewing 96
Hide Balloons command 88
Hide Others command 96
high-density floppy disks 9, 74, 75, 81, 252.
See also floppy disks
highlighting text 63—64
by double-clicking 68
with Shift key 67
horizontal scroll bar 4748

|

I-beam pointer 62—063, 249. See also
arrow pointer

icons
access privileges and 217
alias 134
arrangement of 131, 158
blinking 91, 117, 181, 250
changing appearance of 159-160
changing names of 70-71



copying 240

of currently active program 60
dimmed 96
double-clicking 62
dragging 39

ejecting disks with 126
highlighting 37

labels for 142

moving 135, 240
opening 41, 63, 240
organizing 131, 132
overview 50-52

pointing to 36

pressing 38

question mark 91,117
Quick Reference 239-240
renaming 240

selecting 37, 239

of shared folders you own 197
size of in views 158

types of 50-52, 75

ID numbers. See SCSI ID numbers
ImageWriter

Page Setup options for 176
troubleshooting 180

Info window

adjusting program memory 97
changing an icon 159-160
creating stationery 140—141

getting information about a file 141
locating original of an alias 135
locking a file 118

Initialize Printer's Disk command 186

initializing
disk repair and 129
floppy disks 7677, 115, 253
floppy disks in MS-DOS file

format 263—264

hard disk 76, 113-114

injuries 30

inserting text 57, 62—63

insertion point 57, 62
adjusting blinking of 157
positioning 63

Inside Macintosh 237

Install disk 93

Installer program, printer software update

with 177-178

installing
Apple menu items 135, 146
AppleTalk software 192
application programs 92
CloseView control panel 170-172
device drivers 224
fonts 183
printer software 174, 175
programs 78-79, 82-83, 92
sounds 166

System Folder items 146—147

system software 91, 93-94

without a floppy disk drive 92
internal modems 228-254
interrupt button 7, 17

JK

keyboard. See also mouse; trackball

adjusting response of 155

arrow keys 53, 244

comfort tips 31-32

layout and key functions 259-261

modifier keys 53, 66, 156

Slow Keys feature 156
Keyboard control panel 155
keyboard files 147
keyboard shortcuts

CloseView 171

ejecting disks 126

outline view 242

overview 66

Quick Reference 244

Quit command 68

Save command 66

selecting text 67

Sticky Keys feature 156

turning on and off 172
Key Caps desk accessory 186, 260261
kilobyte (K) 75
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L

labeling floppy disks 12
Label menu 139, 142, 148
labels, file 142
Labels control panel 148
LaserWriter. See also fonts; printers
background printing with 181
choosing 174
connecting 229
downloading fonts to 184—185
fonts available for 186
Page Setup options for 176
printing on 178-179
restarting 187
selecting in Chooser 174
transferring PostScript file to 188
turning start page on or off 187
LaserWriter Font Utility program 184,
186-188
licensing agreements
file sharing and 202
software installation and 92
lightning bolt icon 104
linking programs 218-222
list views 142, 158, 242
LocalTalk cables 191
locked files, searching for 139
locking
aliases 118
files 118, 253
floppy disks 81, 117, 253
folders 118

284 Index

log files, printer 188

long-term storage 103, 235
low-power input devices 229, 247
low-power messages 102—103

M

Macintosh Basics tour
finding 20
starting from floppy disk 20, 24-25
starting from hard disk 20-23
versus book’s tutorial 19
Macintosh desktop computer, connecting
to 199
Macintosh HD icon, opening 41, 78
Macintosh user groups 237
MacWrite format, converting to and from 265
magnifying screen image 170-172
maintenance instructions 26—28
Make Alias command 134, 196
malfunctions, computer 235
Map control panel 269—272
megabyte (MB) 75
member of a group. See registered group
memory. See also RAM disk; random-access
memory (RAM); virtual memory
adding 231
AppleTalk and 161
checking use of 97,161, 231

disk cache and 162, 250
fragmentation of 161
management tips 161-162
programs’ use of 97, 161-162
system sleep and 111
32-bit addressing 164
troubleshooting 245-258, 250
using hard disk space as
memory 163164
Memory control panel
disk cache size 162
RAM disk 99-100
32-bit addressing 164
virtual memory 109, 163—164
menu bar 16
menus
adjusting blinking of items in 157
choosing items from 243
commands in 40
keyboard shortcuts 66
overview 52
pop-up 243
pull-down 38, 242
Quick Reference 242-244
submenus 243-244
titles (names) of 16
viewing 38
microphone 7, 167,230
modem port 7, 174, 228, 248



modems
connecting internal and external 228
power consumption of 109, 247
selecting internal/external 228
transferring files with 143
troubleshooting 254
viruses and 95
modifier keys
overview 53, 66. See also keyboard
shortcuts
Sticky Keys feature for 156
typing special characters with 260-261
monitors, external 104
mouse. See also trackball
adjusting response of 154
comfort tips for 32
connecting 229
Mouse control panel 154
moving
icons 135, 240
text 04
windows 49-50, 240
MS-DOS file format
converting to and from 265-267
initializing disks in 263—264
multiple programs 95-96

N

naming

documents 57-58, 70-71, 133

folders 132

icons 70-71, 240

registered groups 204-205

registered users 194, 203

your Macintosh 192

network. See also access privileges; file

sharing; guests; passwords;
shared disks

accessing your own computer
on 211-212, 257

advantages of 189-190

AppleTalk and 191-192, 194

assigning access privileges 213-215

assigning passwords to users/groups 204

ceasing to share a folder or disk 202

changing your own password 197-198,
212-213

checking your access privileges 217

connecting to 191

connecting to a shared disk 193-197

converting MS-DOS files on 266

creating bulletin boards on 216

disconnecting from a shared disk 126, 195

disconnecting users from your
computer 211

installing programs from 92
linking programs 218222
monitoring file-sharing activity 210
naming registered groups 204205
naming registered users 203—204
naming your computer and its owner 192
ownership of folders/disks 197, 199,
209, 213
preventing access to your
computer 207-208
removing items from System Folder
on 147
removing users/groups from list of
registered users 208
selecting a folder or disk to
share 201-202
selecting a user/group for sharing 206
setting up your computer 190-192
shared disk icons 51
sharing your own files 199-202
sleep and 110, 192, 248
technical information on 237
transferring files over 143
troubleshooting 212, 254, 255, 256-257
turning file sharing off 207-208, 209210
turning file sharing on 200
updating printer software on 177-178
viewing group members 205
viruses and 95
working with files and folders 197-199
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network administrator 190, 193, 197, 198
Network icon 192
network printers. See also printers
choosing 174-175
troubleshooting 254, 255
updating software for 177-178
network software, removing from System
Folder 147
network zones 175, 193, 194, 254, 256
new folder, creating 132, 197
New Group command 204
New User command 203
nickel-cadmium (NiCad) batteries. See battery
number formats 153
Numbers control panel 153

0

Open command 41
opening
the computer display screen 3
documents 61-62, 69, 146
folders 79, 241
icons 41, 63, 78, 240
programs 56, 69, 146
operating system. See system software
Option key 53, 259
Clean Up command and 131
Empty Trash warning override 160
typing accent marks with 261
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organizing files 131-135

outline form in list views 242

outline (scalable or variable-size) fonts 182
out-of-paper signal 181

owner icon 197,205

owner password 192

P

Page Setup options 176—178, 180
passwords
assigning to others 204
case sensitivity of 204
changing your own 197-198, 212-213
troubleshooting 195
typing 192
Paste command 64, 98, 166
pattern, background 168170
peripheral devices. See also printers
Apple Desktop Bus (ADB) devices 229
external hard disks 117
external monitors 104
headphones 230
microphone 7, 167, 230
modems 95, 109, 143, 228, 254
mouse 32, 154, 229
SCSI devices 223-227
speakers 230
Personal LaserWriter SC. See LaserWriter
plug adapters 234

pointer. See arrow pointer; I-beam pointer
pointing to an object 306
ports, safety tips for 27. See also modem
port; printer port
PostScript files, transferring to
LaserWriter 188
PostScript fonts, downloading 184185
PostScript log, creating 188
power adapter
conserving power with 109
“Don't sleep when plugged in” option
111,248
for external recharger 105
long-term storage and 235
plugging in 2
preventing automatic sleep while
using 110, 248
recharging battery with 102, 103—104
safety tips 2, 27-28, 229
short-term storage and 234
for StyleWriter printer 229
travel tips 234
power adapter port 2,7
PowerBook 1458 Backup program 6, 8,
10-12, 113, 119-122
PowerBook 145B Restore program 8, 119,
123-125
PowerBook control panel
battery conservation 8687, 110-112,
248, 252
“Don't sleep when plugged in” option
111,248



hard disk sleep adjustment 110, 111,
248, 252

modem options 228

processor cycling 112

processor speed 111

system sleep adjustment 110, 111,
248, 252

power button 7, 15

RAM disk and 18

restarting computer with 18

“Shut Down” warning 13

turning computer on with 4, 15, 19

power management. See also battery

Apple Desktop Bus devices and 229

battery conservation settings 86—87,
109-112, 247, 248, 252

low-power messages 102—103, 108

maximizing battery life 108

monitoring battery charge level 86,
101-103

processor cycling 112

RAM disks and 99, 109

recharging the battery with power adapter
103-104

recharging the battery with recharger
105-106

removing or replacing battery 106—107

troubleshooting 247

power problems
low battery 102-103
troubleshooting 5, 245, 247248
power states 13—15
Preferences command 181
pressing with the trackball 38
Print command 178-179
Print Desktop command 179
printer port 7, 191,229, 248
printers. See also ImageWriter; LaserWriter;
network printers; StyleWriter
choosing 173-175
connecting 173, 229
downloading fonts to 184-185
initializing hard disk connected to 186
LaserWriter Font Utility and 186188
out-of-paper signal 181
Page Setup options for 176
PrintMonitor and 181
restarting 187
troubleshooting 174, 175, 180, 254-255
turning start page on or off 187
updating printer software on
networks 177-178
printer software
installing 174, 175
removing from System Folder 147
updating on networks 177-178

Printer Update document 177
printing. See also fonts
background 175, 180, 181
choosing printer 173—175
color documents 179
desktop contents 179
documents 178-179, 181
error messages 180
gray-scale documents 179
LaserWriter start page 187
on networks 174-175, 177178
Page Setup options 176—178
troubleshooting 180, 254—255
window contents 179
PrintMonitor program 181
Print Window command 179
problems. See troubleshooting
processor cycling 109, 112, 246, 249, 257
processor speed 111
ProDOS file format 263, 265
program linking
allowing guests to link to your
programs 221
allowing users to link to your
programs 219
disconnecting 219
linking to a program on another
computer 218-219
registered users and groups and 221-222
selecting a program for 220
turning on 220

Index 287




programs. See also application programs;

system software
adding to Apple menu 135, 146
aliases for 134
application versus system 61
for backing up hard disks 8, 12, 119
copying from floppy disk 78-79, 82-83
copyright laws and 202
disk repair 18, 125, 128-129
Info window and 97
installing 78-79, 82—83
installing without a floppy disk drive 92
linking 218-222
making active 58—60, 96
memory use of 97, 161-162
multiple 95-96
opening 506, 69
opening automatically at startup 146
performance of 92, 112
quitting 60, 68, 69
RAM disks and 99, 100
switching active 58-60, 96
troubleshooting 92, 257-258
types of 51, 61

protecting disk contents 81, 117-118
publish-and-subscribe feature 190
Put Away command 80, 126, 195
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Q

question mark on Help menu 87-88
question mark startup icon 91, 117
Quick Reference

icons 239-240

keyboard shortcuts 244

menus 242-244

windows 240242
Quit command 68

R

RAM. See random-access memory (RAM)
RAM disk
creating 99—100
erasing 100
insufficient memory and 250
low-power messages and 103
memory recommendations for 99
power button and 18
power conservation and 109
reset button and 17
resizing or removing 100
Restart command and 17
Shut Down and 99

random-access memory (RAM).
See also memory
adding 231
checking use of 97, 161, 231
disk cache and 162, 250
low-power conditions and 103
management tips 161-162
programs’ use of 97, 161-162
RAM disk requirements for 99
sleep and 110
32-bit addressing and 164
virtual memory and 163—164, 250
recharger, external 105-106
recharging the battery 26, 28, 234-235, 248
recharging times 106
recording sound 167-168
registered group
access privileges of 213-215, 216
denying access 207-208
giving folder or disk ownership to 209
naming 204-205
program linking and 221-222
removing 208
removing a user from 208
sharing folders and disks with 206
viewing members of 205



registered user

access privileges of 213-215,216
changing password of 197-198
connecting to a shared disk as 197
creating a folder as 197

denying access to 207208
disconnecting 211

folder ownership and 197, 209
naming 203-204

passwords for 204

program linking and 221-222
removing 208

sharing your files with 206

typing name and password 193, 194, 213

repairing computer 27, 245
repetitive stress injuries (RSIs) 30
reset button 7, 17, 245
Restart command 17
restarting the computer 17-18
RAM disk and 100
Restart Printer command 187
restoring
hard disk 8, 12, 123—124
System Folder 125
Return key 57, 71, 244, 259
Revisable Form Text (RFT) format 265

Save command 57-58, 66, 140
saving
in a directory 133
changes 65
documents 57-58, 133, 253
documents as templates 140—141
and quitting 68
scalable fonts 182
scanning order for startup disks 117
Scrapbook 98
screen

background pattern, changing 168—170
battery and 101, 104, 109, 249
brightness control 5, 7, 32, 109, 245, 249

reinstalling system software S cleaning 28, 32

from a shared disk 92
from floppy disks 91, 93-94

removing

battery 106—107

extra System Folders 83
floppy disk 80, 126

fonts 147, 184

guests 208

RAM disk 100

registered users or groups 208
sounds 147, 166

System Folder items 147

safety instructions
battery 26, 28, 107
floppy disk 79
hard disk 27, 127
malfunction or damage 235
power adapter 2, 27, 28, 104, 229
RAM disk 99
SCSI devices 227
traveling 233—234
viruses 12, 94-95

Save As command 133, 140

comfort tips 32

contrast control 5,7, 32, 245, 249

external monitors 104

magnifying image on 170-172

opening 3

position of 3,249

power consumption of 109

safety tips for 28

troubleshooting 5, 19, 245, 249

waking from sleep 13, 14, 19, 110
scroll bars 47—48
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SCSI cables 224, 226, 227
SCSI chains 128, 226227
SCSI devices
connecting 227,229
ID numbers for 114, 128, 224-225
installing software for 224
overview 223224
terminators for 128, 226, 227
troubleshooting 250-251
SCSIicon 223,227
SCSIID numbers 114, 128, 224-225
SCSI port 7, 223, 227

changing your password 197-198,
212-213

connecting to 193-197

creating new folders on 197

disconnecting from 126, 195

folder ownership on 197, 199, 209, 213

preventing access to your
computer 207-208

reconnecting to 209

selecting a disk to share 201-202

sleep and 110, 248

troubleshooting 194, 256—257

shortcuts. See keyboard shortcuts
short-term storage 234
Show All command 96
Show Balloons command 87
Shut Down command 13
RAM disk and 99, 100
size box 44-45, 46-47
size of window, changing 44—45, 58, 240
sleep
AppleTalk and 192
automatic 14, 103, 110, 111
battery conservation settings

SCSI terminators 128, 226, 227
searches 136—139
selecting an icon 37, 40—41
selecting text 63—064, 67—68
service locations 235-236, 245
setting up computer 1-6. See also peripheral
devices
on a network 190-192
shared disk icons 51, 196
shared disks. See also access privileges; file
sharing; network
accessing files on 197-202
access privileges for 213-215
aliases for 134, 196
belonging to you 199-202
ceasing to share 202
changing ownership of 209
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shared files. See file sharing
Sharing command 199, 201-202, 206, 209,
214-215
Sharing Setup control panel
changing your password 212-213
identifying your computer on a
network 192
turning file sharing off 209-210
turning file sharing on 200
turning program linking on 220
shift-clicking 67, 239. See also clicking;
double-clicking
Shift key, system extensions and 247
short-circuiting battery 26

and 110-111, 252
hard disk sleep 111
low-power messages and 103
networks and 110, 192, 248
power states and 15
preventing 110, 192, 248
putting the PowerBook to sleep 14
startup process and 16
system sleep 111
travel and 233
troubleshooting and 246, 248

waking the computer from 13, 14, 15, 19

when to use 14, 109

Sleep button 102



Sleep command 14, 99
Slow Keys feature 156
Small Computer System Interface.
See SCSl entries
software. See application programs;
programs; system software

software development support 238
software drivers 224, 251
software licensing agreements 92, 202
Sound control panel 165-167
sound input port 7, 167, 230
sound output devices 230
sound output port 7, 230
sounds. See also microphone

alarm clock 149-150

choosing 165

installing 166

recording 167-168

removing 147, 166

setting volume of 165

Slow Keys alert 156
speakers 7, 230
special characters, typing 260-261

Special menu

Clean Up command 40, 131
Eject Disk command 126
Empty Trash command 72, 100
Erase Disk command 100, 116
Restart command 17

Shut Down command 13
Sleep command 14

start page, LaserWriter 187
startup

from floppy disks 18

opening items automatically at 146
scanning order for 117
troubleshooting 5, 17-18, 245

startup disk

conserving power with 164
designating 116

installing system software on 91
overview 16,75

scanning order for 117

System Folder on 83,91, 164
troubleshooting 91, 127128, 245, 247
virtual memory and 164

Startup Items folder 92, 146
stationery, creating 140—141
Sticky Keys feature 156
storing items in Scrapbook 98
storing the computer 103, 234-235
StyleWriter
background printing with 181
power adapter caution 229
submenus 243-244
suitcases, font 183, 184
support services 235-236
symbols, typing 260-261
System 7 software, networks and 199
system crashes 17, 246
system error, restarting after 17-18
system extensions 161, 247

Startup Disk control panel 116
startup disk icon 16
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system failures 247System Folder. See also

folders
backing up 8, 10-12, 120-122
Extensions folder 192, 194, 247
Find command and 136
Fonts folder 182, 186
installing files in 146147
installing fonts in 182, 183
installing sounds in 166
listing fonts in 186
on program disks 83
on startup disk 83,91, 164
removing extra System Folders 83, 92, 247
removing files from 147, 166
removing fonts from 184
removing sounds from 166
restoring 8, 125
viruses and 12, 95
VM Storage file in 164

system sleep 111
system software

installing from floppy disks 93-94
overview 8,61
publish-and-subscribe feature 190
reinstalling 91, 93—94

technical guide to 237
troubleshooting 247

viruses and 12,95
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T

Tab key 244,259
TeachText program 56
technical information 237
technical support 235-236
telephone lines, transferring files over 143
telephone numbers, service 236, 245
temperature
batteries and 28, 103, 108
computer use and 28
storing computer and 103, 234, 235
templates, creating 140141
terminators, checking SCSI 128, 226, 227
text
changing 6268
deleting 63—64
inserting 57, 62—63
moving 64
replacing 67-68
selecting 63—64, 67—68
typing 57
text translation 265
32-bit addressing 164
3.5-inch disks. See floppy disks

time
automatic reset during travel 269
changing format of 152
setting Alarm Clock 149—150
setting system clock 148—149
tracking time zones 269—271
title bar 44, 49
TokenRing cables 191
trackball. See also mouse
adjusting 154
buttons 36
choosing a command with 40
clicking with 37,39
comfort tips 31
double-clicking with 62, 68
dragging with 39
pointing with 36
pressing with 38
using 36—40
tracking speed 154
transferring. See also copying
files 143
PostScript files 188
translator files 263, 265



Trash

deleting files with 71-72
ejecting a disk with 126
emptying 72, 100

location of 16

purpose of 52

retrieving items from 72
turning off warning for 160

travel tips 233—234. See also Map

control panel

troubleshooting

aliases 134-135

Apple menu 135

application programs 92, 257-258
battery 247-248

blinking icons 91, 250

Chooser 174,175

computer is hot 246

computer stops working 246

damage to computer 235, 247
ejection problems 126

floppy disk drive 125, 126, 252, 253
floppy disks 125, 126, 128-129, 252-253
fonts 180, 255

hard disks 18, 114, 127-130, 251-252

malfunctioning computer 247
memory 250
modems 254
networks 212, 254, 255, 256—257
passwords 195
power problems 5, 245, 247-248
printers 174, 175, 254-255
printing 180, 254-255
restart problems 17-18
screen 5, 19, 245, 249
SCSI devices 250-251
shared disks 194, 256-257
sleep 248
startup 17-18, 245
startup disk 91, 127128, 245, 247
system crash 17, 246
system failures 247
system software 247
32-bit addressing 164
viruses 12, 94-95, 247
windows 250
TrueType fonts 182
turning computer off 13, 15, 18
turning computer on 4, 15, 19, 227,250
and automatically connecting to a shared
disk 196197
and automatically opening a program 146

§]

Undo command 258
unlocking
files 118
floppy disks 81, 117, 122
untitled window 56, 57
upgrades, memory 231
user, network. See registered user
user groups, Macintosh 237
Users & Groups control panel
accessing your own computer over a
network 211-212
assigning a password 204
denying file sharing access 207-208
naming a registered group 204—205
naming a registered user 203
naming users for program
linking 221-222
removing a registered group 208
removing a registered user from a
group 208
turning on guest access 200—201
Utilities menu
Restart Printer command 187
Start Page Options 187
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\Y

variable-size fonts 182

vertical scroll bar 4748

viewing
contents of folders 242
contents of windows 42—44
hidden contents of windows 4648
hidden windows 96
list views 142, 158, 242
members of registered group 205
menus 38

View menu 142, 242

Views control panel 142, 158

virtual memory. See also memory
creating 163—164, 231
insufficient memory and 250
power conservation and 109

viruses 12, 94-95, 247

VM Storage file 164

294 Index

W

waking the computer 13, 14, 19, 110
warranty service 27, 236, 245
windows. See also Info window
active 42—44, 56-58, 69, 240
changing display of Finder 158
closing 48, 49-50
finding lost 250
hiding and showing program 96
moving 49-50, 240
opening higher-level folder 241
opening icons into 41
overview 52
printing contents of 179
Quick Reference 240-242
resizing 44—45, 58, 240
scrolling through 241
straightening items in 131
title bar of 44, 49
troubleshooting 250
untitled 56-57
viewing contents of 42, 142, 241-242
viewing hidden contents of 46—48
word wrap 57

X
X-ray machines 233

Y, Z

zones, network 175, 193, 194, 254, 256
zoom box 44—45



The Apple Publishing System

This Apple manual was written and edited on a desktop publishing system using Apple
Macintosh computers and QuarkXPress. Proof pages were created on Apple LaserWriter
printers and on the QMS Colorscript 100 color printer. Final pages were produced in
QuarkXPress and output directly to separated film on PostScript driven imagesetters.
Line art and part openers were created with Adobe Illustrator. Cover art was produced
with Adobe Photoshop. Screen shots were created and modified with system software,
Exposure, SuperPaint, and MacPaint.

Text type is Apple’s corporate font, a condensed version of Garamond. Ornaments are
custom symbols designed for Apple Computer. Some elements, such as computer voice,
are set in Apple Courier, a fixed-width font.

PostScript®, the LaserWriter page-description language, was developed by Adobe
Systems Incorporated.




